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Name Category Description Values Default Value

accessory_window_display Without category Docked - Displays the accessory window embedded in 

the active window. Undocked - Displays the accessory 

window as a standalone window. 

undocked, docked docked

accuracy_lower_bound Environment Enter an accuracy value to override the default lower 

limit.The minimum value for relative accuracy is 1E-06. 

 0.0001

acis_export_params Data Exchange For ACIS interface allows to export object, feature and 

entity level parameters. 

yes, no no

acis_export_units Data Exchange Allows selection of model units for ACIS export. in, ft, m, mm, cm, 

micron, default

default

acis_out_version Without category Allows the user to choose ACIS export version. 4, 5 5

acrobat_reader Printing & Plotting Sets the Adobe Acrobat Reader command path. This 

value will be used to launch the reader after exporting a 

PDF document. 

  

add_java_class_path Application 

Programming 

Interfaces

Prepends the option value on the java environment 

variable, CLASSPATH, used to find classes in J-Link 

programs. To specify multiple search paths in the same 

line, delimit them using ':' on UNIX, and ';' on Windows 

NT. 

  

add_lower_level_comps_to_lay

er

Layers Setting this option to yes will check off the Favor Current 

Layer option, which allows lower level components to be 

added to top level layers. 

yes, no no

add_weld_mp Weld Yes - System includes welds when calculating mass 

properties and approximates light weight weld mass 

properties. No - System excludes welds when 

calculating mass properties. 

yes, no no

advanced_intersection Assembly Control the appearance of the intersection tool and 

scope of available functionalities. 

yes, no no

advanced_style_surface_edit Without category Use advanced options by default for Surface Edit in 

Style. 

yes, no no

ae_propagate_detail_depende

ncy

User Interface Sets the AE detail dependency for AE's that are locally 

propagated. If set to independent, the AE's parameter 

call outs will update to other propagated AEs 

parameters. 

dependent, 

independent

dependent
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Name Category Description Values Default Value

aec_dwg_anno_attrpar_spec_fi

le

Piping Specifies the aec drawing annotation 

attribute/parameter specification file name. 

 aec_dwg_anno_attrpar

am_spec.ptd

aec_object_type_file Piping Specifies the aec object type file name.  aec_object_type.ptd

aec_parameter_file Without category Specifies the file name of the user defined piping 

parameter codes. 

  

af_copy_references_flag User Interface Toggle display of Copy References column in 

Annotation Feature definition dialog 

no, yes no

align_cable_bundles Electromechanical Align NEWLY CREATED bundles where they meet or 

branch out 

yes, no yes

allow_anatomic_features Features Allow the creation of pre-Pro/E 2000i geometry features 

including ear, neck, lip, slot, flange, shaft, local push, 

radius dome and section dome. 

yes, no no

allow_confirm_window User Interface Display a confirmation window when exiting 

Pro/ENGINEER. This enables you to use the mouse to 

confirm/cancel exiting Pro/ENGINEER. 

yes, no yes

allow_delete_many_in_drawing

s

Without category Make the Delete Many command available in drawing 

mode. The Delete Many command is not supported by 

undo but can improve performance when deleting a 

significant number of items. 

yes, no no

allow_float_opt_checkout System Yes - Allows checkout failure for floating modules. no, yes no

allow_fully_dependent_copy Features Enables the usage of advanced copy/paste functionality 

tocontrol degree of dependency on the pasted object. 

yes, no yes

allow_harn_mfg_assy_retrieval Electromechanical Allow to retrieve a harness mfg assembly directly. yes, no no

allow_import_file_extension Data Management Allow additonal files with extensions to be shown in the 

import dialog 

  

allow_move_attach_in_dtl_mov

e

Drawing Yes - Move and Move Attach commands in drawing 

mode act together. No - Move and Move Attach 

commands in drawing mode do not act together. 

yes, no yes

allow_move_view_with_move Drawing Disallow the movement of drawing views with the 

mouse. 

yes, no no

allow_package_children Assembly Sets what type of children packaged components can 

have. ALL - Features and components can be a children 

of packaged component. FEAT - Only features can be 

children of packaged components. NONE - Packaged 

components cannot have children. 

all, feat, none all
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Name Category Description Values Default Value

allow_ply_cross_section Miscellaneous Yes - Enables Pro/COMPOSITE to create a cross-

section of composite plys. 

yes, no yes

allow_redo_intersections Assembly Yes - Displays the ReIntersect command in the ASSY 

FEAT menu. 

yes, no no

allow_ref_scope_change Without category No - Displays the message "Reference scope changes 

are prohibited by the configuration file settings" when 

the Ref Scope user interface is changed. 

yes, no yes

allow_refs_to_geom_reps_in_d

rws

Drawing Yes - Allows you to create drawing references to 

geometry representations (includes dimensions, notes, 

and leaders). These references may become invalid if 

the referenced geometry changes resulting in geometry 

representations not updating in drawings. 

yes, no no

allow_rfs_default_gtols_always Dimensions & 

Tolerances

Yes - Enables RFS/Default gtols to be created even 

when not permitted by ANSI standard. 

no, yes no

allow_save_as_instance Assembly Allows the option to save a copy of the active model as 

a family table instance. 

yes, no no

allow_save_failed_model Assembly Yes - Failed models can be saved. No - Failed models 

cannot be saved. Prompt - Let the user decide whether 

failed models can be saved. 

yes, no, prompt prompt

allow_shrink_dim_before Casting & Mold 

Design

Allow calculation before relations. yes, no no

allow_solid_perspective_hlr Model Display Yes - Allows a solid to be displayed with hidden lines 

while in perspective. 

no, yes yes

allow_udf_style_cosm_threads Features Defines the Cosmetic Thread user interface. Yes - 

Creates a Cosmetic Thread as a UDF. No - Creates a 

Cosmetic Thread as a Cosmetic Thread feature. 

yes, no no

allow_update_part_simp_rep_d

ata

Assembly Allow updating part Simplified Rep data in session 

automatically when switching from one Simp Rep to 

another.Yes - Allow updating part simplified rep data. No 

- Do not update part simplified rep data. Prompt - 

Prompt the user if the current simplified rep should be 

updated. 

yes, no, prompt yes

allow_workpiece_silhouette Without category Determines if the workpiece is allowed for Silhouette 

Mach Window creation. NO - only reference part is 

allowed; YES - both workpiece and reference part are 

allowed; AUTO - only workpiece is allowed. 

yes, no, auto no
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Name Category Description Values Default Value

analysis_crt_tmp_file_on_rege

n

File Storage & 

Retrieval

Determines whether regeneration of analysis features 

creates/updates tmp files 

yes, no yes

ang_dim_in_screen Dimensions & 

Tolerances

Yes - If the display is in the default pan/zoom setting 

(View>Pan/Zoom>Reset), the system checks whether 

an angular dimension is visible on the screen. If it is not 

visible, then the system moves the dimension to a 

visible location. 

yes, no no

ang_units Environment Sets the display of angular dimensions to decimal 

degrees (ang_deg), degrees and decimal minutes 

(ang_min) or degrees, minutes and decimal seconds 

(ang_sec). 

ang_deg, ang_min, 

ang_sec

ang_deg

angle_grid_interval Features Modify grid space in angular units for handle movement.  1

angular_tol Dimensions & 

Tolerances

An alternative format for setting default angular 

tolerance dimensions. The value sets the number of 

decimal places, and the tolerance is the actual tolerance 

value. For integer dimensions, the value is zero, and the 

tolerance is an integer. 

 0

angular_tol_0.0 Dimensions & 

Tolerances

Sets the default tolerance for angular dimensions. Each 

option sets a tolerance for a specific decimal place. The 

value is the place of the last decimal. 

 5

angular_tol_0.00 Dimensions & 

Tolerances

Sets the default tolerance for angular dimensions. Each 

option sets a tolerance for a specific decimal place. The 

value is the place of the last decimal. 

 50

angular_tol_0.000 Dimensions & 

Tolerances

Sets the default tolerance for angular dimensions. Each 

option sets a tolerance for a specific decimal place. The 

value is the place of the last decimal. 

 500

angular_tol_0.0000 Dimensions & 

Tolerances

Sets the default tolerance for angular dimensions. Each 

option sets a tolerance for a specific decimal place. The 

value is the place of the last decimal. 

 5000

angular_tol_0.00000 Dimensions & 

Tolerances

Sets the default tolerance for angular dimensions. Each 

option sets a tolerance for a specific decimal place. The 

value is the place of the last decimal. 

 50000

angular_tol_0.000000 Dimensions & 

Tolerances

Sets the default tolerance for angular dimensions. Each 

option sets a tolerance for a specific decimal place. The 

value is the place of the last decimal. 

 500000

animate_explode_states Model Display Animate the transition between explode states and mold 

opening steps. 

yes, no yes

Parametric Technology Corporation 4 Pro/ENGINEER Wildfire 5.0 Configuration Options



Name Category Description Values Default Value

arc_radius_limit Without category Sets the upper limit for a radius in a CIRCLE statement 

of NCL file. The value must be positive. If not, 

10*part_size is used. 

 -1

ask_designate_owners Without category Show the both required and optional owners to be 

designated. 

yes, no yes

assemble_parent_connector Electromechanical Assemble parent connectors on locations referencing a 

subconnector. 

yes, no yes

assy_mfg_open_mode Manufacturing No Default Application set for opening Assembly NC 

Models. 

mfg, process, 

feature

 

atb_auto_check_on_activate Data Exchange Sets state of ATB 'Auto Check Status On Activate' 

toggle. 

on, off off

atb_auto_check_on_retrieve Data Exchange Sets state of ATB 'Auto Check Status On Retrieve' 

toggle. 

on, off on

atb_auto_check_on_update Data Exchange Sets state of ATB 'Auto Check Status On Update' 

toggle. 

on, off off

atb_ident_cadds_files Data Exchange Allows to identify CADDS files in the file open browser. yes, no no

atb_prod_asm_upd_by_comp_

ids

Data Exchange Allows to update a Pro/DESKTOP assembly based on 

assembly component ids, if set to YES. Otherwise, the 

update will be based on component names. 

yes, no yes

atb_search_path Without category Extends search path for ATB Update and ATB Check 

Status commands. 

  

atb_show_log Data Exchange Sets state of ATB 'Show Log' toggle. on, off on

attach_menumanager Without category Setup menu manager attachment to the main Pro/E 

window. 

yes, no no

auto_ae_param_file User Interface Define path and file name of external file used to define 

parameters that are automatically created in all 

Annotation Elements. 

  

auto_assembly_with_layouts Assembly Yes - Enables automatic assembly. No - Disables 

automatic assembly. 

yes, no yes

auto_associate_dimensions Data Exchange Yes - The drawing setup option 

associative_dimensioning is also set to Yes. The system 

tries to associate imported IGES dimensions (not yet 

associative) with corresponding imported geometry. 

no, yes no

auto_backup_new_placemnt_r

efs

Assembly Yes - Create Component Reference Backup, No - Do 

not Create Component Reference Backup. 

yes, no no
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Name Category Description Values Default Value

auto_constr_always_use_offse

t

Assembly Control whether auto constraint should create offsets. 

Yes - Auto constraint alw ays creates offsets. No - Auto 

constraint snaps align or mate if surfaces are wi thin 

tolerance. Never - Auto constraint never create offsets. 

yes, no, never no

auto_constr_offset_tolerance Drawing Sets the auto constraint tolerance for creating offset 

dimensions. If distance is less than this tolerance 

multiplied by component size, offset is set as coincident. 

Default value is 0.5 . 

 0.5

auto_convert_cables Electromechanical Yes - When regenerating a pre-Release 11.0 cabling 

assembly, the system automatically creates a separate 

spool feature for every individual wire or cable in the 

assembly. No - An interface for the cable conversion 

appears. 

yes, no yes

auto_evaluate_simprep_rules Assembly If the option is "yes" newly created rep would be 

updated each time on retrieve/regeneration. 

no, yes no

auto_include_annot_plane User Interface Control the default setting of the check box in the 

Propagate annotation dialog box which controls whether 

to pass all annotations plane references. 

no, yes yes

auto_place_max_number Assembly Set the default value for the maximum number of 

matches allowed. 

 5

auto_propagate_ae User Interface Yes - causes the automatic, local propagation of AE's 

after a supported feature has been created. 

no, yes no

auto_regen_views Drawing Yes - Automatically repaints the drawing display when 

changing from one window to another. No - Update to 

drawing views will only occur when manual updates are 

made via Repaint or View> Update. 

yes, no yes

auto_show_3d_detail_items Without category When set to yes, AEs parallel to the view will be 

displayed while creating a new view. 

yes, no yes

auto_traceback System When set to yes, traceback.log file will be generated 

when fatal error occurs. 

yes, no no

auto_update_intersected_mod

els

Assembly Control the appearance of the intersection tool and 

scope of available functionalities. 

yes, no yes

auto_xml_on_retrieve Electromechanical Automatically load Cabling Logical Reference from an 

XML file when retrieving the cabling assembly 

yes, no no

auto_xml_on_save Electromechanical Automatically create an XML Logical Reference when 

saving a cabling assembly 

yes, no no

autobuildz_enabled Drawing Loads AutobuildZ application. yes, no no
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Name Category Description Values Default Value

autodrill_udf_dir Manufacturing Storage directory for holemaking MUDF's that are used 

by Pro/NC Auto-drilling functionality 

  

autodrilling_config_filename Manufacturing Retrieve automatically and load the configuration file for 

the auto-drilling table. 

 autodrilling

autodrilling_holestyle_param Manufacturing Parameter name included in hole features of a 

manufacturing reference model.The parameter value 

identifies the MUDF for holemaking that is automatically 

applied in Pro/NC to drill these holes. 

  

autohide_copied_group_af Features If set to yes, copying a feature group containing an 

Annotation feature will automatically hide the Annotation 

Features in the new group. 

yes, no no

autohide_external_sketch Features If set to yes, a Sketch feature is automatically hidden 

after being used as external sketch for a sketch based 

feature. 

yes, no yes

autoplace_single_comp Assembly Assembling components with an interface will 

automatically place the component at the first position 

satisfying the interface definitions. 

no, yes yes

autoround_max_n_chains_per

_feat

Features Determines the maximum number of edge chains that 

the Auto-Round algorithm will attempt to round in each 

Auto-Round member 

 20

autoroute_path_param_name Electromechanical Set the wire parameter to use to select a path during 

autorouting. 

 use_path

auxapp_popup_menu_info User Interface Enable display of popup menu info in the trail file. yes, no no

bell Environment Yes - Turns on the keyboard bell that rings after each 

prompt. No - Turns off the keyboard bell. To override 

this setting use the Environment dialog box on the Tools 

menu. 

yes, no no

bitmap_size Data Management Works in conjunction with save_bitmap. Determines the 

size (squared) of the bitmap image that is stored. 

 200

blank_layer Layers Blanks specified layers when you begin a 

Pro/ENGINEER session. The value is the layer ID. 

  

blended_transparency Model Display Yes - Transparent colors will appear using alpha 

blending (if supported) when the model is shaded. 

no, yes yes

bm_graph_tool User Interface BMX graph tool default, 

excel_linked, excel 

embedded

default

bmgr_pref_file User Interface Specifies the location of the Graph Tool preference file.   
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Name Category Description Values Default Value

bmx_param_restrictions Without category  yes, no yes

boeing_extract_bundle Without category Yes - Uses the extract bundle algorithm. No - Does not 

use the extract bundle algorithm. 

yes, no no

bom_format Drawing Sets the BOM format file to be used for a customized 

BOM.Specify name and path. 

  

browser_favorite File Storage & 

Retrieval

Specifies the directories visible in the file browser for 

quick navigation.Use the full path to avoid problems. 

  

bump_revnum_on_retr_regen Assembly Determines whether or not revision number is increased 

for generic models that regenerate and change during 

assembly retrieval.Only applies if 

new_asm_regen_revnums is yes (otherwise, there will 

be no revision number bumping). 

yes, no yes

button_name_in_help User Interface Yes - The name and menu of any selected menu option 

displays, in English, in the help text associated with that 

button. 

yes, no no

cable_int_portions_for_clr Electromechanical No - Global clearance checking for internal cable 

portions is excluded. Yes - Global clearance checking 

for internal cable portions is included. 

no, yes no

cables_with_hlr Electromechanical Cables are not hidden behind objects. no, yes yes

cadds_import_layer Data Exchange Allows import of CADDS5 layering. yes, no yes

campost_dir Manufacturing Specifies the CAM-Post load point directory to enable 

you to directly set-up the post-processors and generate 

MCD files. 

  

can_snap_to_missing_ref Assembly Controls whether to enable snapping to missing 

references while dragging components for placement. 

Yes - Snapping is enabled while dragging. No - 

Snapping is disabled while dragging. 

yes, no yes

capped_clip Model Display Yes - Displays the model as a solid when shaded and 

clipped. No - Displays the model as surfaces when 

shaded and clipped. 

no, yes yes

catia_out_to_existing_model Data Exchange Append - If the selected CATIA model already exists, 

the new data is appended to the existing CATIA file. 

Overwrite - If the selected CATIA model already exists, 

the newly exported file overwrites the existing one. 

append, overwrite append

centimeter_grid_interval Features Modify grid space in centimeter units for handle 

movement. 

 0.1
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Name Category Description Values Default Value

cgm_use_pentable Data Exchange No - Do not use a defined pen table for formatting of 

CGM export. 

no, yes no

chamfer_45deg_dim_text Drawing Controls the display of chamfer dimension text without 

affecting the leader. This only affects the text of newly 

created dimensions. ASME/ANSI is the default. 

asme/ansi, iso/din, 

jis

asme/ansi

check_interface_criteria Assembly Check for interfaces when placing a component. yes, no no

check_same_assy_parts Assembly Determines whether to permit different names for 

different part occurrences, or not in mirror subassembly 

UI. 

yes, no yes

check_udf_int_key Without category Yes - updates UDF internal keys upon group's retrieval. 

No - skips keys update. 

yes, no yes

chk_part_surfs_profpock Manufacturing Yes - Includes all reference part surfaces as check 

surfaces for profiling and pocketing NC sequences. 

yes, no no

cl_arrow_scale Manufacturing Enables you to control the size of the tool path arrow for 

contouring NC sequences. 0 - The arrow does not 

display. Any other value - The arrow scales accordingly. 

 1

cl_rotate_sign_convention Manufacturing TOOL or TABLE - defines ROTATE sign direction 

convention based with respect to either rotation table or 

cutting tool. 

table, tool table

clearance_triangulation Environment Specifies the quality of surface triangulation used to 

obtain initial guess points for clearance and interference 

calculations. 

none, low, medium, 

high

none

clip_always Model Display Yes - Display clipping after Visibilities dialog box is 

closed. 

no, yes yes

clock Environment Yes - Displays the clock while Pro/ENGINEER is 

working. 

yes, no no

clr_print_plus_minus Environment Sets the display of the system accuracy when 

calculating clearances between two parts or surfaces. 

The default is to not display the accuracy. 

yes, no no

cmm_custom_tool_param_file Manufacturing Defines the file that contains the user-defined tool 

parameters' list. 

  

collect_dims_in_active_layer Without category This config options allows dimensions to be collected on 

the active layer. 

yes, no yes

color Colors Turns the colors on or off. Turning colors off displays 

the model wireframe in white. 

no, yes yes
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Name Category Description Values Default Value

color_ramp_size Colors Specifies the number of shades in a color ramp. 

Applicable to multi-color, shaded model displays of 

simulation / analysis results. System graphics must 

support 256 colors and color maps that compress. 

 -1

color_resolution Colors Specifies minimum allowable deviation between user-

defined colors. Colors having RGB values within 

tolerance of existing colors cannot be created. 

Decreasing this setting allows more colors that are very 

similar in RGB value to be defined. 

 0.1

color_windows Colors All_windows - Wireframe colors display in the main 

window and all auxiliary windows. One_window - Colors 

display only in the main window. Auxiliary windows 

display wireframe in the default color. 

all_windows, 

one_window

all_windows

combined_views_customizatio

n

Without category Enable / Disable combined views customization. yes, no yes

comp_angle_offset_eps Assembly Specifies the angle epsilon such that if the desired 

surfaces are equal or greater than the epsilon (in 

degrees), than an angle offset constraint will be created. 

 10

comp_assemble_start Assembly Sets the initial assembly placement behavior when 

assembling a new component. Default - Default initial 

position.Package - Define initial position using the Move 

option.Constraint_in_Window - Use secondary window. 

Move_then_Place - Define initial position using the 

Move option and thendefine placement constraints. 

default, package, 

constrain_in_window

, move_then_place

 

comp_assemble_with_interfac

e

Without category Settings for assembling component with interface(s). default_multi, 

default_single, 

from_list, none

default_multi

comp_interface_placement Without category Sets the default interface placement type. Interface to 

geometry - place the component using component 

interfaces and assembly geometry. Interface to Interface 

- place the component using assembly and component 

interfaces. 

interface_to_interfac

e, 

interface_to_geom

interface_to_interface

comp_placement_assumptions Assembly Use placement assumptions when placing components. yes, no yes

comp_rollback_on_redef Assembly No - Assembly is not rolled back when the user 

redefines a component. 

yes, no yes
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Name Category Description Values Default Value

comp_snap_angle_tolerance Without category Specify the angle tolerance for snapping while freeform 

dragging components. Default value is 30.0 degrees. 

 30

comp_snap_dist_tolerance Without category Specify the distance tolerance for snapping while 

freeform dragging components.Default value is 0.1 

(relative to size of component being assembled). 

 0.1

compact_cables_packing Electromechanical Setup whether the new packing of cables should be 

applied. 

yes, no no

company_name Environment Used with the export option iges_out_mil_d_28000. To 

support MIL-D-28000, your company name is required 

input and the system prompts you every time you export 

through IGES unless you set the company name in your 

configuration file. 

  

compress_output_files File Storage & 

Retrieval

Yes - Stores object files in a compressed format.Note: 

Compressed files are usually smaller, buy may be 

larger,than uncompressed files. Compressed files are 

slower to read and to write to. 

yes, no no

conf_mouse_anim Miscellaneous Display the presenter's mouse motions when observing 

a shared Pro/ENGINEER session. 

no, yes yes

contact_surfaces_gap Without category Sets the maximum allowable gap between weld contact 

surfaces. 

 0

convert_to_wf3_replace Without category Convert to Wildfire3 replace functionality. yes, no no

copy_dxf_dim_pict Data Exchange YES - Imports each component of AutoCAD dimension 

separately. NO - Imports AutoCAD dimensions as 

dimensions in Pro/ENGINEER. AS_SYMBOL - Imports 

AutoCAD dimensions as symbols in Pro/ENGINEER. 

yes, no, as_symbol no

copy_geom_update_pre_2000i

_dep

Assembly Yes - Flags independent copy geom features in a pre-

2000i model as modified when retrieved into 

Pro/ENGINEER. Save the model immediately to update 

the model's copy geom dependency information. 

no, yes  

copy_geometry_method Assembly Sets the default copy geometry reference(s) type publish_geometry, 

references

publish_geometry

copy_set_datum_attr Features If set to yes, allow to copy set datum associated with 

datum features.. 

yes, no yes

cpus_to_use System Set up the number of threads including main thread  2
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Name Category Description Values Default Value

create_drawing_dims_only Drawing Yes - Saves all new driven dimensions created in the 

drawing inside the drawing as associative draft 

dimensions. No - Saves driven dimensions created in 

Drawing mode on solid geometry in the solid. 

yes, no no

create_fraction_dim Dimensions & 

Tolerances

Yes - All dimensions created will be displayed as 

fractions. 

yes, no no

create_numbered_layers Layers Yes - Creates default layers named 1 through 32. yes, no no

create_temp_interfaces Assembly Allow the automatic creation of interfaces based on 

previous assembly instructions. 

yes, no no

cri_grafting_enable Data Exchange Activates "Graft features" button under File menu. This 

allows user to graft features created in CRI model to 

active model. 

yes, no no

cti_class_color_file Electromechanical Sets the CTI class color file for CTI class color 

displayduring electrical clearance and creepage 

analysis.Use the full pathname to avoid problems. 

  

curr_proc_comp_def_color Assembly Process Specifies the default color used to display the current 

component in a process assembly. 

 0

curr_proc_comp_def_font Assembly Process Specifies the default font used on the current 

component in a process assembly. 

  

custom_rainbow Mechanica Used to specify fringe colors in Pro/FEM-POST results. 

Specify blue, black, cyan, magenta, green, yellow, red, 

and white. Enter colors as a dash-delimited string 

(lowest to highest value). The default is blue-cyan-green-

yellow-red-magenta-white. 

  

datum_point_symbol Model Display Specifies the shape of datum point symbols displayed in 

Part or Assembly mode. 

dot, cross, circle, 

triangle, square

cross

dazix_default_placement_unit Data Exchange Specifies the units to be used for data imported in Dazix 

files. 

micron, mm, thou  

dazix_export_mounthole Data Exchange Yes - Causes the MOUNTHOLE section of a Dazix file 

to be processed as a mount hole.No - Causes the 

MOUNTHOLE section to be processed as a cut. 

yes, no no

dazix_z_translation Data Exchange Yes - Passes the objects in the .edn files through z 

translation. 

yes, no yes
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def_layer Layers Specifies default layer names for different types of 

items. The first value string is the layer type. The 

second value string is the layer name. 

layer_3d_items, 

layer_ae_driving_di

m, 

layer_all_detail_item

s, 

layer_annotation_ele

ment, 

layer_assem_memb

er, 

layer_assy_cut_feat, 

layer_axis, 

layer_axis_ent, 

layer_chamfer_feat, 

layer_comp_design_

model, 

layer_comp_fixture, 

layer_comp_workpie

ce, 

layer_copy_geom_fe

at, 

layer_corn_chamf_f

eat, 

layer_cosm_round_f

eat
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def_layer Layers layer_cosm_sketch, 

layer_csys, 

layer_csys_ent, 

layer_curve, 

layer_curve_ent, 

layer_cut_feat, 

layer_datum, 

layer_datum_plane, 

layer_datum_point, 

layer_detail_item, 

layer_dgm_conn_co

mp, 

layer_dgm_highway, 

layer_dgm_rail, 

layer_dgm_wire, 

layer_dim, 

layer_draft_constr, 

layer_draft_dim, 

layer_draft_dtm, 

layer_draft_entity, 

layer_draft_feat, 

layer_draft_geom, 

layer_draft_grp, 

layer_draft_hidden
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def_layer Layers layer_draft_others, 

layer_draft_refdim, 

layer_draft_xsec, 

layer_driven_dim, 

layer_dwg_table, 

layer_ext_copy_geo

m_feat, 

layer_feature, 

layer_geom_feat, 

layer_gtol, 

layer_hole_feat, 

layer_hole_thread, 

layer_intchg_funct, 

layer_intchg_simp, 

layer_nogeom_feat, 

layer_note, 

layer_parameter_di

m, 

layer_part_refdim, 

layer_point

default_abs_accuracy Environment Defines the default absolute part accuracy.  0

default_ang_dec_places Drawing Sets the default number of decimal places (0-13) to 

which to round newly created angular dimensions. 

Unrounded angular dimensions automatically determine 

the number of decimal places required to display their 

stored value. 

 1

default_ang_units Dimensions & 

Tolerances

Sets the display of newly created angular dimensions 

both in the model and in the drawing. There is no impact 

on dimensions previously created. ang_deg - Decimal 

degrees.ang_min - Degrees and decimal minutes 

ang_sec - Degrees, minutes, and decimal seconds 

ang_deg, ang_min, 

ang_sec

ang_deg

default_comp_geom_scope Without category Set thespecified Shared Geometry reference control 

conditions to newly added components. 

all, pg, none all

default_comp_invalid_refs Without category Set the specified handling method of out-of-scope 

Accessible references to newly added components. 

copy, prohibit copy
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default_comp_scope_setting Without category Set the specified Accessible reference control 

conditions to newly added components. 

all, none, 

subassemblies, 

skeleton_model

all

default_comp_skel_geom_sco

pe

Without category Set the specified Shared Geometry reference control 

conditions to newly added Skeleton components. 

all, pg, none all

default_comp_skel_scope_sett

ing

Without category Set the specified Accessible reference control 

conditions to newly added Skeleton components. 

all, none, 

subassemblies, 

skeleton_model

all

default_dec_places Dimensions & 

Tolerances

Sets the default number of decimal places (0-13) to 

which to round newly created dimensions. Unrounded 

dimensions automatically determine the number of 

decimal places required to display their stored value. 

 2

default_dep_copy_option Features Sets Full Dependent Copy as a default copy option. full_dep, dep_dim dep_dim

default_dim_num_digits_chang

es

Dimensions & 

Tolerances

Sets the default number of digits displayed in a 

dimension to the last entered value. No - The system 

defaults to the value specified for the configuration file 

option default_dec_places. 

yes, no yes

default_draw_scale Drawing Sets the default drawing scale for views added with the 

No Scale command. The value must be greater than 0. 

No - The system does not set a default drawing scale. 

 -1

default_ext_ref_scope Without category Set default scope for externally referenced models. All - 

Any model. None - Only current model and children. 

Skeletons - Any component in model's assembly and 

higher skeletons on branch. Subassembly - Only 

components and children in model's assembly. 

all, none, 

subassemblies, 

skeleton_model

all

default_font User Interface Sets font for text other than menu bar, menus and their 

children, and pop-up menus and help. Add comma-

delimited variables in any order (italic bold, 24, times or 

24, times, italic bold have the same effect). Any omitted 

variable uses standard setting. 

  

default_font_kerning_in_drawin

g

Drawing Determines initial setting of Font kerning when 2D 

drawing annotations are created. Yes - Font kerning is 

on for new 2D annotations. 

yes, no no

default_geom_analysis_type Without category Default save type for geometry analysis. quick, saved, feature quick
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default_geom_scope Without category Default value for Geometry Scope allowed for 

referencing. 

all, pg_if_exists, 

pg_only

all

default_layer_model Layers Name of the model which is used to drive rule-based 

layer placement of new items in all models of the same 

type in session. 

  

default_mold_base_vendor Casting & Mold 

Design

Default Value for Mold Base vendor. futaba_mm, dme, 

hasco, dme_mm, 

hasco_mm

 

default_obj_constraints_scope Without category Set the specified Shared Placement reference control 

conditions to newly created models if template models 

were not used. 

all, interfaces, none all

default_object_geom_scope Without category Set the specified Shared Geometry reference control 

conditions to newly created models if template models 

were not used. 

all, pg, none all

default_object_invalid_refs Without category Sets default condition for reference handling. Prohibit - 

System will abort all attempts to create ext. reference 

that violates scope. Copy - System will issue warning 

upon all attempts to create ext. reference that violates 

scope. 

copy, prohibit copy

default_object_scope_setting Without category Set default condition for reference control. All - Any 

model. None - Only current model and children. 

Skeletons - Any component in model's assembly ang 

higher skeletons on branch. Subassembly - Only 

components and children in model's assembly. 

all, none, 

subassemblies, 

skeleton_model

all

default_placement_scope Without category Default value for Component Placement Reference 

filter. 

all, intrf_if_exists, 

intrf_only

all

default_placement_surfacefinis

h

Dimensions & 

Tolerances

Sets the default placement type for surface finishes 

within the surface finish UI. 

with_leaders, 

on_entity, 

normal_to_entity, 

free

normal_to_entity

default_ramp_size Model Display Specifies a number of shades of gray to show shading 

of non-colored objects. 

  

default_scene_filename Photorender Complete path to the scene file to be used as default 

scene file. 

 <proe_WF_5.0_loadpo

int>/graphic-

library/scenes//default-

enhanced-realism.scn
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default_shrink_formula Casting & Mold 

Design

Default option of shrinkage formula: 1/(1-S) - ASME 

standard or 1+S (simple). 

asme, simple simple

delete_after_plotting Printing & Plotting Yes - A plot file is automatically deleted from the 

directory in which it resides when it has been 

successfully plotted. 

yes, no  

depthcue_always Model Display Depth cue aids in visualizing a wireframe model. With 

depth cue enabled, wireframe lines become darker as 

they extend into the screen and lighter as they extend 

towards the screen. Depth cue is supported only by the 

appropriate graphics hardware. 

no, yes yes

depthcue_value Model Display Aids in visualizing a wireframe model. With depth cue 

enabled, this option specifies the default percentage of 

depthcue used. Depth cue is supported only by the 

appropriate graphics hardware. 

  

diagram_export_allow Electromechanical YES: Allow user to save a copy of loaded diagrams as 

DGE file for loading into Routed Systems Designer, NO: 

Do not provide option to save a diagram as DGE. 

no, yes no

diagram_pin_edit_multi_line Electromechanical (Diagram)Determines the Pro/TABLE format used when 

you are modifying pin parameters. "yes" - You can add 

user-defined pin parameters by including them between 

the DEFINE and ENDDEF statements for each pin. "no" 

- The system uses columnar format and 

yes, no no

dialog_translation User Interface Specifies the language in which the dialog display when 

running non-English version of Pro/ENGINEER. 

yes, no yes

dim_fraction_denominator Dimensions & 

Tolerances

Sets the largest denominator to be used for fractional 

dimensions. If the fraction can be reduced, then it 

converts to the lowest possible denominator (for 

example, 4/32 converts to 1/8). 

 32

dim_fraction_format Dimensions & 

Tolerances

Std - Displays fractional dimensions in the standard 

Pro/ENGINEER format. Aisc - Displays fractional 

dimensions in the American Institute of Steel 

Construction (AISC) format and displays architectural 

units in AISC format for feet-inches. 

std, aisc std
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dim_inactive_components Assembly Display inactive assembly components with stippled 

transparency and default color (grey). Default value is 

shade_only. 

always, never, 

shaded_only

shaded_only

dim_offscreen_limit Dimensions & 

Tolerances

If more than zero, sets the margin beyond which 

dimensions are automatically snapped back onto the 

screen.For example, a value of .2 lets a dimension be 

20% of the window size outside the window.If set to 

zero, disables snapping of offscreen dimensions. 

 0.2

din_std_line_priority Printing & Plotting If set to YES line priority in plotting or export is 

determined according to DIN standard 

yes, no no

dir_cache_max File Storage & 

Retrieval

Specify the maximum number of directories to 

cache.Larger values can speed up file access, but use 

more memory. 

 256

direct_vrml Data Exchange Yes - Enables direct VRML conversion. yes, no no

disable_search_path_check File Storage & 

Retrieval

Controls whether the search path is checked for name 

conflicts when creating, renaming, or copying models. 

Name conflicts should be avoided because different 

models with the same name cannot be together in 

session. 

yes, no no

disp_in_open_rep_create Without category Simplified Rep to display initially in Open Rep Create: 

"No" for none, "Yes" for graphics rep, or "Default Rep" to 

display the rep indicated by option 

"open_simplified_rep_by_default". 

yes, default rep, no no

disp_trimetric_dwg_mode_view Drawing Displays the model in default orientation when placing a 

general view on the drawing. No - Model does not 

appear until Default is chosen from the Orientation 

dialog box. 

yes, no yes

display Model Display Wireframe - All solid edges in white. Hiddenvis - Hidden 

lines in grey. Hiddeninvis - Hidden lines removed. 

Shade - Display shaded surfaces. Settings are reflected 

in printing and some export modes. 

wireframe, 

hiddenvis, 

hiddeninvis, shade

shade

display_annotations Environment Determines whether or not annotations are displayed in 

3D models. 

yes, no yes

display_axes Model Display Displays or hides datum axes. yes, no yes

display_axis_tags Model Display Displays or hides datum axis name tags. yes, no yes
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display_comps_to_assemble Assembly Process Yes - The design model goes into memory and displays. 

Pick process components from the design model or the 

Model Tree. No - Only the Model Tree displays. As you 

pick process components from the Model Tree, they go 

into memory. 

yes, no yes

display_coord_sys Model Display Yes - Coordinate systems will be displayed. No - 

Coordinate systems will not be displayed. 

yes, no yes

display_coord_sys_tags Model Display Yes - Coordinate system name tags will be displayed. 

No - Coordinate system name tags will not be displayed. 

yes, no yes

display_dwg_sketch_constraint Drawing When set to yes, parametric sketching constraints, such 

as V for vertical, are displayed when a drawing object is 

selected 

yes, no no

display_dwg_tol_tags Drawing Sets the display of the tolerance tags that appear in 

drawings. This option does not affect the display of 

tolerances on dimensions. 

yes, no yes

display_florin Model Display Yes: display of the florin (international currency symbol) 

where possible. No: use the euro symbol exclusively. 

no, yes no

display_full_object_path Environment Controls the display of the object's full file name 

(including its object-type suffix and its version number) 

and file path in the window title and Model Info display. 

Yes - Displays full file name and file path. No - Displays 

object name only. 

no, yes no

display_ie8_warning_dialog Without category Show/Hide the warning dialog related to Internet 

Explorer 8 running in Compatibility Mode 

yes, no yes

display_in_adding_view Drawing Controls model display in a drawing when 

auto_regen_views is No. Wireframe - Adds new views in 

wireframe, displays datums. Minimal_wireframe - 

Displays in wireframe, no datums, axes, or silhouette 

edges. Default - Displays using the Environment setting. 

wireframe, 

minimal_wireframe, 

default

wireframe

display_internal_cable_portion Electromechanical Yes - Internal cable portions will be displayed for any 

wires that have been manually set to Yes in the Cable 

Paths Setup dialog box for each individual splice and 

custom component. This option can be overridden in the 

Environment dialog box. 

yes, no no
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display_layer Layers This causes the specified layers to display when you 

begin a Pro/ENGINEER session. The variable "value" is 

the layer Id. 

  

display_mfg_icon_for_mfg_ass

y

Manufacturing Yes- Display manufacturing icon for manufacturing 

assembly files in Open/Save dialogs.No- the 

manufacturing assembly files have assembly icons. 

yes, no no

display_pdm_server_quick_vie

w

Without category Yes - display summary view of PDM information for 

items in session. It applies to ProductPoint only. 

yes, no yes

display_plane_tags Model Display Yes - Datum plane name tags will be displayed. No - 

Datum plane name tags will not be displayed. 

yes, no yes

display_planes Model Display Yes - Datum planes will be displayed. No - Datum 

planes will not be displayed. 

yes, no yes

display_point_tags Model Display Yes - Datum point tags will be displayed. No - Datum 

point tags will not be displayed. 

yes, no yes

display_points Model Display Yes - Datum points and their names will be displayed. 

No - Datum points and their names will not be displayed. 

yes, no yes

display_popup_viewer Without category No- disable popup viewer, File_Open_Only: display 

popup viewer only in the file open dialog, Yes: display 

popup viewer in file open dialog, model tree and in 

Server Quick View dialog 

yes, no, 

file_open_only

file_open_only

display_route_cable_preview Electromechanical If no then Route Cables tool does not display preview of 

cables as they are routed.Otherwise Route Cables tool 

will show a preview of the path routed cables will follow. 

yes, no yes

display_silhouette_edges Model Display Sets the display of silhouette edges for wireframe 

display only. 

no, yes yes

display_thick_cables Electromechanical Yes - Display cables and wires with thickness. No - 

Display the centerline of cables and wires only. This 

option can be overridden in the Environment dialog box. 

yes, no no

display_thick_insulation Piping Yes - Display insulation in thick mode. No - Display 

insulation in centerline mode. This option can be 

overridden by the Thick insulation option in the Model 

Display dialog box. 

yes, no yes

display_thick_pipes Piping Yes - Display pipes in thick mode. No - Display pipes in 

centerline mode. This option can be overridden by the 

Thick pipes option in the Model Display dialog box. 

yes, no no
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display_tol_by_1000 Dimensions & 

Tolerances

If set to Yes, tolerances for non-angular dimensions will 

be displayed multiplied by 1000. 

yes, no no

display_z_extension_lines Model Display Controls the display of dimension z-extension lines. Yes - 

z-extension lines will be displayed; No - z-extension 

lines will not be displayed. 

yes, no yes

dm_auto_open_zip Data Management YES - Windchill CAD packages or zip files will open 

automatically. NO - User selects which file in contents to 

open. 

yes, no yes

dm_cache_limit Data Management Enter amount of disk space (in megabytes) to allocate 

for local file storage. The change to the existing setting 

will take effect after Pro/ENGINEER is restarted 

  

dm_cache_mode Data Management Indicate which objects will be written to local cache 

when objects in Pro/E memory are saved. 

none, modified, all all

dm_checkout_on_the_fly Data Management Controls the default action presented to the user when 

Check Out on the fly dialog comes up 

checkout, continue checkout

dm_enable_simple_import_exp

ort

Without category  yes, no yes

dm_fallback_server_location Data Management Specifies the server location where objects will be saved 

when Pro/ENGINEER does not provide an ability to 

specify the target save location. This option is applicable 

for Windchill ProductPoint only. 

  

dm_http_compression_level Data Management Set the data compression factor (0-9, 0= no 

compression) for data exchange with a Windchill server. 

  

dm_nc_references Without category Sets whether reference relationships will be created in 

Windchill between the manufacturing model and its 

deliverables(CL file, tape file and DMIS file). 

yes, no yes

dm_offline_after_event Data Management Allow the user to choose to work offline when there is a 

loss of server connection. Staying online will continue to 

retry server operations. 

yes, no yes

dm_offline_options_activated Data Management Yes - Synchronize, Download and Upload boxes are 

checked when going online. No - Only Synchronize box 

is checked when going online. 

yes, no yes

dm_overwrite_contents_on_up

date

Data Management Yes: Windchill Workspace Update will overwrite 

locally/modified out of date objects with the ones in the 

server. No (Default): Windchill Workspace Update will 

update metadata only. 

yes, no no
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dm_remember_server Data Management Primary server/workspace must be set by user for each 

Pro/E session. 

no, yes yes

dm_save_as_attachment Data Management Controls the default option for Save A Copy when 

models are saved as in non-Pro/E format. Yes - It will by 

default save it as secondary content attachment to the 

original CAD Document. No- It will by default save it as 

Primary CAD Document 

yes, no  

dm_search_primary_server Data Management Search the primary server for dependencies not found in 

the workspace. 

yes, no yes

dm_secondary_upload Data Management Indicate when modified Pro/E objects on a secondary 

server will be moved from the local cache to the user's 

workspace on the server. 

automatic, explicit automatic

dm_synchronize_in_backgroun

d

Data Management Yes: Enables workspace synchronization in the 

background. No (Default): Workspace synchronization 

will happen in the foreground. 

yes, no no

dm_upload_objects Data Management Indicate when modified Pro/E objects will be moved 

from the local cache to the user workspace on the 

server. 

automatic, explicit explicit

dm_user_presence Data Management Enable user presence indicator and actions.This 

capability requires a connection with a PDM server and 

requires an installed and running Microsoft 

communicator client. 

yes, no yes

dont_show_symbol_nodes Design Manager Do not show references derived from relations in 

Parent/Child viewer. 

yes, no no

draw_models_read_only Drawing Yes - Drawing model files are read-only.No model 

changes can be made.Cosmetic_only - Only cosmetic 

changes can be made to the model.Design changes are 

not allowed.Cosmetic changes include adding driven 

dimensions, cross sections, and explode states. 

yes, no, 

cosmetic_only

no

draw_points_in_model_units Drawing Defines the current draft view's coordinate values as 

model units rather than drawing units. The GET POINT 

menu uses the scale of the draft view and the draft 

view's model units for relative and absolute coordinate 

entry and display in the Message Window. 

yes, no no

drawing_ole_image_dpi Drawing Resolution of OLE object images. The range of valid 

values is 0 to 600 dots per inch. 

 150
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drawing_setup_file Drawing Sets the default drawing setup file option values for your 

Pro/ENGINEER session, otherwise, the system uses 

the default drawing setup file option values. Certain 

parameters in the file are valid only if you have a license 

for Pro/DETAIL. 

 <proe_WF_5.0_loadpo

int>/text/prodetail.dtl

drawing_shaded_view_dpi Drawing Resolution of exported shaded drawing views.The range 

of valid values is 0 to 600 dots per inch. 

 150

drawing_view_origin_csys Drawing The named coordinate system will be used as the origin 

of a newly created view or of a modified view.None - 

The system will not use a previously specified 

coordinate system. 

none  

drm_policy_server User Interface Allows a user to preset the server policy that is to be 

used when Apply Policy command is utilized. 

  

dwg_export_format Data Exchange Provides the ability to choose DWG file version when 

exporting from Pro/E drawing. 

14, 2000, 2004, 

2007

2007

dwg_unicode_conversion_lang

uage

Drawing Defines the language used during Unicode conversion 

of pre-Wildfire 4.0 drawings. This option does not affect 

the conversion of models. File - Uses the language 

stored in the drawing header file; Session - Uses the 

language of the current Pro/ENGINEER session. 

file, session, usascii, 

english, japanese, 

french, german, 

russian, italian, 

spanish, korean, 

chinese_tw, 

chinese_cn, hebrew, 

greek, turkish, 

czech, polish, 

hungarian, 

slovenian, 

portuguese, slovak

file

dxf_block_to_pro_symbol Data Exchange Specifies whether or not DXF BLOCKS to be imported 

as Pro/E symbols. Yes - Imports BLOCKS as symbol 

definitions, No - Imports BLOCKS as separate entities. 

yes, no no

dxf_export_format Data Exchange Provides the ability to choose DXF file version when 

exporting from Pro/E drawing. 

12, 13, 14, 2000, 

2004, 2007

2007

dxf_in_faceted_brep Data Exchange Default, faceted boundary representation is allowed in 

import. 

yes, no yes

dxf_in_proxy_entity Data Exchange Controls the input support for ACAD_PROXY_ENTITY. no, yes yes
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dxf_out_comments Data Exchange YES - comments (999 group codes) will be created in 

DXF file exported from Pro/ENGINEER. NO - DXF file 

will be created without comment lines. 

yes, no yes

dxf_out_drawing_scale Data Exchange Specify whether or not to export drawing scale to the 

DXF or DWG file. Yes - Includes a scale factor 

DIMLFAC in the exported DXF/DWG. No - Exports 

without using a scale for the drawing. Set to Yes when 

exporting to read into AutoCAD. 

yes, no no

dxf_out_scale_views Data Exchange Specify whether or not to scale drawing views when 

exporting to theDXF or DWG file.Yes - rescales the 

entire drawing in such a way that the main viewscale 

becomes 1:1. No - exports without rescaling. 

yes, no no

dxf_out_sep_dim_w_breaks Data Exchange YES - Breaks dimensions with breaks on witness lines 

to separate entities and preserves the original picture. 

No - Exports such dimensions as DXF DIMENSION 

entities and removes the breaks on witness lines. 

yes, no no

dxfio_in_sjis Data Exchange Determines if the SJIS is supported when 

importing/exporting DXF files in Japanese 

yes, no yes

dynamic_edit_show_dims Without category Controls the display of dimensions during dynamic edit. yes, no yes

dynamic_edit_show_sketch_di

ms

Without category Controls the display of sketch dimensions during 

dynamic edit. 

yes, no yes

ecad_area_default_import Data Exchange Defines how imported ECAD areas are treated. 

Cosm_area - Treats imported ECAD areas as cosmetic 

area features. 3d_volume - Imports ECAD areas with Z-

heights as a 3D enclosed quilt. 

3d_volume, 

cosm_area

cosm_area

ecad_board_csys_def_name Data Exchange Specifies the default coordinate system name added to 

an ECAD board being imported. If you do not set this 

variable, the system prompts you for a name. 

  

ecad_comp_csys_def_name Data Exchange Specifies the default coordinate system name added to 

an ECAD component being imported. If you do not set 

this variable, the system prompts you for a name. 

  

ecad_comp_layer_map Data Exchange Allow layer mapping for ECAD component's import into 

Assembly. 

yes, no yes
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ecad_comp_xsec_def_name Data Exchange Will allow pre-setting default X-section to be used for 

component outline output to *.eda format. 

  

ecad_create_hint_add Data Exchange Assists in creation of an ecad_hint.map file. Yes - 

Automatically renames components, if necessary, each 

time library of component outlines is imported to 

Pro/ENGINEER. This does not create an ecad_hint.map 

file. It controls if ecad_hint.add is created. 

no, yes yes

ecad_default_comp_height Data Exchange Sets default value and units for an ECAD component 

being imported. Units can be: inch, mil (1E-3 inches), 

thou (1E-6 inches), cm, mm, micron (1E-6 meters), dsu 

(1E-8 meters). If not set, the system uses the current 

component's units. 

 -1

ecad_default_comp_place_stat

us

Data Exchange Sets default component placement status for export 

(parameter setting will override the default). 

unplaced, fixed, 

placed, mcad, ecad

placed

ecad_exp_both_two_areas Data Exchange Supports the export of ECAD areas with different 

"Above Board" and "Below Board" conditions."yes" - 

Enables you to export both sided keep-in/keep-out 

ECAD areas as two individual areas (top and bottom). 

yes, no no

ecad_export_cuts_as_holes Data Exchange Exports Pro/ENGINEER cuts as holes to ECAD 

systems. 

yes, no yes

ecad_export_holes_as_cuts Data Exchange Exports Pro/ENGINEER holes as cuts to ECAD 

systems. 

yes, no no

ecad_import_holes_as_feature

s

Data Exchange Import sections specified as DRILLED_HOLE as 

through-all holes. Boards created with Pro/ENGINEER 

drilled holes export with default value of NPTH for the 

ECAD_HOLE_TYPE parameter. Create this feature 

parameter if a value of PTH is needed (IDF 2.0/3.0). 

yes, no yes

ecad_import_relative_accuracy Data Exchange Defines the relative accuracy used in ECAD import.  0.0012

ecad_load_filtered_holes_to_ui Without category Controls whether "ECAD import holes configs" 

(ecad_pin_hole_import & ecad_via_hole_import) will 

remove holes completely from the import (default) or 

just pre-set the holes filter UI condition. 

yes, no no

ecad_mapping_file Data Exchange Specify the ecad_hint.map file that will be used for 

ECAD operations. 
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ecad_missing_component_stat

us

Data Exchange Setup default status for missing components in 

"Investigate Placement" Dialog. 

keep_missing, 

delete_missing

keep_missing

ecad_mtg_hole_import Data Exchange Setup the default for the import of ECAD Holes type 

MTG (IDF 3.0 or IDX ONLY) 

yes, no, as 

lightweight

yes

ecad_other_outl_csys_def_na

me

Data Exchange Specifies the default coordinate system name for the 

.OTHER_OUTLINE section of an IDF 2.0 ECAD 

component being imported. If you do not set this 

variable, the system uses ECAD DEFAULT as 

coordinate system name. 

  

ecad_outline_holes_exp_meth

od

Without category Select how holes that are placed on the board outline be 

exported. 

default, arcs default

ecad_panel_csys_def_name Data Exchange Specifies the default coordinate system name added to 

an ECAD panel being imported. If you do not set this 

variable, the system prompts you for a name. 

  

ecad_pin_hole_import Data Exchange Set up the default for the import of ECAD Holes from 

type PIN (IDF 3.0 or IDX ONLY) 

yes, no, as 

lightweight

no

ecad_tool_hole_import Data Exchange Setup the default for the import of ECAD Holes type 

TOOL (IDF 3.0 or IDX ONLY) 

yes, no, as 

lightweight

yes

ecad_via_hole_import Data Exchange Set up the default for the import of ECAD Holes from 

type VIA (IDF 3.0 or IDX ONLY) 

yes, no, as 

lightweight

yes

edge_display_quality Model Display Controls display quality of an edge for wireframe and 

hidden-line removal. Normal - Normal quality of edge 

display. High - Increases tessellation by 2. Very_high - 

Increases tessellation by 3. Low - Decreases 

tessellation from normal, speeds up display. 

normal, high, 

very_high, low

normal

efx_enabled Data Exchange Loads EFX application. yes, no no

enable_3dmodelspace_browse

r_tab

Without category Yes - Display 3D ModelSpace tab in the browser when 

Pro/ENGINEER starts.No - Display 3D ModelSpace tab 

only when you click a 3D ModelSpace link in the 

navigator. 

yes, no yes

enable_absolute_accuracy Environment Controls display of the ACCURACY menu. Yes - 

ACCURACY menu always appears when you choose 

Accuracy from the PART SETUP menu. No - The menu 

appears only if the part is currently defined with absolute 

accuracy. 

yes, no no

enable_acis_export_extension Data Exchange Enable ACIS export extension. yes, no no
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enable_advance_collision Assembly Enables advance collision settings usage. yes, no no

enable_assembly_accuracy Assembly No - Disables accuracy modification for assembly 

objects. 

yes, no yes

enable_cadra_export Data Exchange Enables the CADRA command in the EXPORT menu. 

This enables the creation of a CADRA specific IGES 

file. 

no, yes no

enable_face_preselection Without category Controls the ability to "pre-select" faces/datums as an 

entry to Sketch based features such as Extrude, 

Revolve (input to the internal sketch). 

yes, no yes

enable_hlr_hashing Model Display Enables hlr hashing no, yes no

enable_implied_joints Assembly Allow underconstrained components as mechanism 

connections. 

yes, no yes

enable_offset_fan_curve Without category Enables fan curve option for offset tool. yes, no no

enable_popup_help User Interface Controls pop-up help in dialog boxes. Yes - Help 

enabled. No - Help disabled. 

yes, no yes

enable_protk_xml_schema Application 

Programming 

Interfaces

Enables XML-Schema validation for Pro/TK feature 

XMLs 

yes, no no

enable_shaded_view_in_drawi

ngs

Drawing Yes - shading display is allowed in drawing views. No - 

shading display will be shown in wireframe. 

yes, no yes

enable_tree_indep System Setup whether tree customization will allow separating 

the tree window from Pro/E window. 

yes, no no

erv_show_external_only Assembly Yes - Global Reference Viewer will show objects with 

external references only;No - all the objects will be 

visible 

yes, no no

excel_analysis_directory File Storage & 

Retrieval

Sets the default directory for the MS Excel files to be 

used for Excel analysis calculations. Use the full 

pathname to avoid problems. 

  

excel_family_table_keep_file File Storage & 

Retrieval

Yes - in case of editing family table with excel, if saved 

excel file exist , will always update it. 

yes, no no

exec_prog_on_assem_retr File Storage & 

Retrieval

Execute pro/program for models during assembly 

retrieval. 

yes, no no

expand_all_with_nested_layers Without category Yes - expand all including nested sub layers. yes, no yes

explode_animation_max_time Model Display Sets the maximum amount of time for an animation 

between explode states. 

 1
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explode_iges_dimension_note Data Exchange Controls how dimensions are treated when importing an 

IGES drawing file. Yes - Each IGES dimension explodes 

into an independent note with the dimension text and a 

dimension with an empty note. No - Dimensions are 

treated as before. 

yes, no no

export_3d_force_default_nami

ng

Data Exchange Specify whether the Pro/ENGINEER model names 

should be used for STEP export. Yes - Use default 

naming. No - Add suffixes to model file names. 

yes, no no

export_report_format System Controls the format of the exported reports displayed in 

the embedded browser. Rich Text - Exports the report in 

Rich Text format, Comma Delimited - Exports the report 

in Comma Delimited format. 

comma_delimited, 

rich_text

comma_delimited

export_to_shipit Data Exchange Enable Ship-it interface export. yes, no no

extend_cvpath Data Exchange Extends CVPATH search path for CADDS5 data 

exchanging. 

  

extended_esr_capabilities Assembly Extends external simplified representation capabilities. yes, no yes

external_analysis_directory File Storage & 

Retrieval

Sets the default directory for the files to be used by 

External Analysis calculations.Use the full pathname to 

avoid problems. 

  

fail_ref_copy_when_missing_o

rig

Assembly Yes - When using a copied geom feature or a backed-

up external reference with the Design Manager, and the 

reference is missing in the original, then the copied 

geom feature fails. No - The feature freezes and does 

not update. 

yes, no yes

fail_unattached_feature Features Handles unattached protrusion and cuts, when retrieving 

pre-Release 15 models. Yes - When a part is retrieved, 

the system fails an unattached protrusion or cut. No - 

When a part is retrieved, the system does not fail an 

unattached protrusion or cut. 

yes, no no

fan_significant_locations_only Electromechanical Setup whether only significant locations should be 

flattened on flattening a harness. 

yes, no yes

fan_with_network Electromechanical Setup whether the network should be included on 

flattening a harness. 

yes, no yes

fast_highlight Model Display Yes - Use simplified highlighting which redisplays more 

quickly at the expense of certain details.This option may 

increase memory usage slightly. 

no, yes yes
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fasthlr Model Display Specifies whether fast hidden line removal is on/off by 

default. 

no, yes no

feature_create_auto_begin Features In feature creation, determines whether or not the 

Define button is automatically activated when you open 

the dialog box. Yes - Button is activated automatically. 

No - You select the button. 

yes, no no

feature_create_auto_ok Features In feature creation, determines whether or not the 

system activates the dialog box OK button automatically 

when the last required element is defined. Yes - Button 

is activated automatically. No - You select the button. 

yes, no no

fem_allow_named_mesh_files Mechanica Yes - The user will be prompted to select a file to 

retrieve the mesh from, or enter a file name to save the 

mesh to. No - The user will not be prompted to select or 

enter a mesh file name. 

yes, no no

fem_ansys_annotations Mechanica Toggles transfer of loadcase names to ANSYS. yes, no no

fem_ansys_grouping Mechanica Toggles transfer of groups/layers to ANSYS. yes, no no

fem_asp_ratio Mechanica The value that FEM created elements of aspect ratio are 

compared against. 

 7

fem_default_solver Mechanica Specifies default solver. ansys, nastran  

fem_dist_index Mechanica The value that FEM created elements of distortion 

indices are compared against. 

 0.4

fem_edge_angle Mechanica Sets the minimum acceptable default angle between 

adjacent element edges. Enter value between 0 and 90. 

 30

fem_keep_solver_files Mechanica Yes - All Solver files will be retained after running the 

analysis. No - All Solver files will be deleted after 

running the analysis. 

yes, no no

fem_mesh_operations Mechanica Yes - The menu item Operations appears in the FEM 

MESH menu, providing access to functionalities to 

manipulate the finite element mesh. No - the menu FEM 

MESH will not have the item Operations. 

yes, no no

fem_mesh_preserve Mechanica Yes - The finite element mesh will be automatically 

stored in the mesh file upon creation, and retrieved on 

entering the Structure/Thermal. No - The mesh will not 

be stored or retrieved automatically. 

yes, no no

fem_mid_ratio Mechanica The value that FEM created elements of mid ratios are 

compared against. 

 0.1
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fem_neutral_version Mechanica Specifies version number of neutral file.  3

fem_shell_elem_type Mechanica Sets the default shell element type in FEM mode. tri, quad quad

fem_skew_angle Mechanica Sets the maximum acceptable default skew angle value, 

measured in degrees. Enter a value between 0 and 90. 

 45

fem_solver_time_limit Mechanica For NASTRAN solution, uses this option to interrupt the 

solver after the specified time limit. The default value is 

60 minutes. 

 60

fem_taper Mechanica Sets the minimum acceptable default taper value. Enter 

a value between 0 and 1. 

 0.5

fem_warp_angle Mechanica Sets the maximum acceptable default warp angle value, 

measured in degrees. Enter a value between 0 and 90. 

 10

fem_which_ansys_solver Mechanica Specifies the ANSYS equation solver type to be used. 

Supported solver types: FRONTAL, ITERATIVE (JCG), 

POWERSOLVER (PCG), ICCG, AUTO, and SPARSE. 

frontal, iterative, 

powersolver, iccg, 

auto, sparse

 

fem_y_dir_compress Mechanica Specifies the Y-direction based on compressed and 

uncompressed geometry. The default value is 

uncompressed. 

yes, no no

file_dialog_units_class Without category Sets the units for manikin attributes displayed in the File 

Open dialog. 

ips, mks mks

file_open_default_folder File Storage & 

Retrieval

Sets default dir for File>Open. Working_directory - 

Search working directory. In_session - Search objects 

insession. Pro_library - Use only if Pro/LIBRARY is 

installed. Workspace - Use only with 

Pro/INTRALINK.Commonspace - Use only with 

Pro/INTRALINK. 

default, 

working_directory, 

in_session, 

pro_library

 

file_open_default_view File Storage & 

Retrieval

Specify the initial Views setting as List or Details in the 

File dialog boxes. 

list, details list

file_open_preview_default File Storage & 

Retrieval

Controls whether the preview area is expanded by 

default when the file open dialog or local file browser is 

displayed. 

expanded, collapsed collapsed

file_timestamp_format Without category Controls the format of time stamps in file dialogs and 

the folder browser. The format for the setting is a string 

consisting of up to seven portions: the year, the month, 

and the date, the hours, minutes, seconds and am/pm 

designator. You can enter the portions in any order. 

 %dd-%mmm-%yy
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fix_autocad_iges_text_scale Data Exchange Fixes scaling problems with AutoCAD releases earlier 

than Release 10. Yes - Repairs AutoCAD files 

appropriately. 

yes, no no

fix_catia_iges_sym_note Data Exchange Corrects a problem caused by multiple rotations of a 

note in a CATIA IGES file. Yes - Rectifies any 

discrepancies. 

yes, no no

fix_imported_set_view_orient Data Exchange Sets viewing characteristics for imported CATIA SET 

files. Yes - Files can have translated views. No - Files 

cannot have translated views. 

yes, no no

fix_refs_to_intersections Assembly Sets remnant removal ability for the ReIntersect 

command in the ASSY FEAT menu. Yes - You can 

remove remnants. No - You cannot remove remnants. 

yes, no no

flange_shape_sketches_direct

ory

Sheetmetal Sets path to directory that contains the Flange shapes.   

flat_shape_sketches_directory Sheetmetal Sets path to directory that contains the Flat shapes.   

flip_arrow_scale Environment Sets a scale factor for enlarging the size of the flip arrow 

that appears for feature creation direction (default = 1). 

 1

floating_layer_tree Layers Set to yes if user wants to see a layer tree dialog 

separated from navigator. 

yes, no no

fonts_size User Interface Determines the relative size of the text in menus and 

dialog boxes. You must restart Pro/ENGINEER for the 

change to take effect. 

small, medium, large  

foot_grid_interval Features Modify grid space in foot units for handle movement.  0.083333

force_new_file_options_dialog File Storage & 

Retrieval

Force the use of the New File Options dialog. yes, no no

force_upd_assem_mp_in_sim

p_rep

Assembly Update mass properties parameters even when some of 

the components of the assembly are not in master rep. 

yes, no no

force_wireframe_in_drawings Drawing Yes - Displays all views of drawings in wireframe. No - 

Displays views according to the display set for the 

session (wireframe, hidden, and so on). 

yes, no no

format_setup_file Drawing Assigns a specified setup file to each drawing format. 

To assign the drawing's parameter values to the format, 

you must retrieve the drawing's setup file into the 

format. 

 dwgform.dtl
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frames_per_sec Model Display Determines whether view is animated. no, yes no

frames_per_sec_value Model Display Used to set the smoothness of view animation changes. 

Higher numbers provide more frames/sec, and giving 

you a smoother animation. Lower numbers cause the 

view to change more quickly. 

 3

freeze_failed_assy_comp Assembly No - Requires an action to fix the assembly or freeze the 

component that fails retrieval. Yes - Freezes any 

component failing retrieval at its last known assembly 

location. Missing refs using offsets or internal datums do 

not cause components to freeze. 

yes, no no

freeze_failed_cable_locations Electromechanical Suspends the cable location at its last known assembly 

location. 

yes, no no

frt_enabled Data Exchange Loads feature recognition application. yes, no no

full_hlr_for_cables Electromechanical Full - Removes hidden lines from view when cables hide 

other geometry (use when Hidden Line active). Partial - 

Cables hide other non-interfering cables except when 

cables route together between same locations. None - 

Display hidden lines (faster). 

none, full, partial full

general_undo_stack_limit System Setup the default number of entries in the top level 

Undo/Redo (default = 50). 

 50

generate_viewable_on_save File Storage & 

Retrieval

Controls whether updated ProductView .edz files are 

automatically exported every time a model is saved. 

yes, no no

geometry_analysis_color_sche

me

File Storage & 

Retrieval

Specifies the location of the geometry analysis color 

scheme file. 

  

gerber_360_interpolation Printing & Plotting Yes - Arcs and circles included in outputted Gerber plot 

files will take this format. 

no, yes no

global_appearance_file Colors Material Global Appearance file path.   

gpostpp_dir Manufacturing Specifies the directory containing the post processor 

files to be used by Pro/NCPOST (GPOST). 

  

graphics System Sets the optional graphics environment used by certain 

platforms for running Pro/ENGINEER. Refer to the 

Installation Guide for a list of defaults and optional 

graphics. 

opengl, x_windows, 

win32_gdi, d3d

opengl

grid_snap Sketcher Yes - Makes pick points snap to a grid. No - Turns the 

grid snap off so that any location can be picked. 

yes, no no
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group_repl_with_recycle Without category Yes - enables new UDF replacement with family table 

instances that prevents children failures. No - UDF 

replacement will work in the same manner as Wildfire 

3.0 and earlier releases. 

yes, no yes

group_replace_rename Without category Yes - updates replaced group name with replacement 

group name. No - preserves existing name of the group 

being replaced if it is a user-given name. 

yes, no yes

gtol_dim_placement Dimensions & 

Tolerances

Controls display of geometric tolerances in Part. Use 

like drawing set-up option of the same name. 

On_bottom - Gtols display at bottom (below additional 

lines of text). Under_value - Gtols display under 

dimension value (above additional lines of text). 

on_bottom, 

under_value

on_bottom

harn_start_model_dir Electromechanical Provides the complete path to the directory containing 

harness start parts and assemblies 

  

harn_tang_line_display Electromechanical Display the tangency lines between cable segments in 

thick cable display mode. 

yes, no yes

help_center_path User Interface URL of an active Pro/ENGINEER Help Center, if the 

Help Center is not installed at the default path (along 

with Pro/E product), of nature 

http://localhost:/index.jspx. Or, URL of the 

Pro/ENGINEER Help Center, that is deployed on a web 

server. 

  

help_translation User Interface Specifies the language in which the short help 

messages display when running non-English versions of 

Pro/ENGINEER. Yes - Display in native language. No - 

Display in English. 

yes, no yes

highlight_erased_dwg_views Drawing Controls the display of erased view outlines 

(environment option Highlight Erased Views). Yes - 

Highlights erased views. No - Turns off highlighting for 

erased views. 

yes, no yes

highlight_geometry Environment Yes - Items selected in the model tree are highlighted in 

the geometry area. 

yes, no yes

highlight_layer_items Layers Yes - Items selected in the layer tree are highlighted in 

the geometry area. 

yes, no yes

highlight_new_dims Drawing In drawing mode, highlights new dimensions in red until 

you repaint the screen. 

yes, no no
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hlr_for_quilts Drawing In Drawing, controls quilt display in hidden line removal. 

Yes - Includes quilts in the hidden line removal process 

(preselects Qlt HLR in the VIEW DISP menu). Default in 

the VIEW DISP menu, uses the value you have set. 

yes, no no

hlr_for_xhatches Electromechanical Controls whether HLR to be enabled for crosshatches in 

drawing mode. 

no, yes yes

hole_diameter_override Features No- Uses hole-table-driven standard hole diameter 

value. Yes - Allows specifying the drilled hole value 

instead of the standard value. 

yes, no no

hole_file_resolution Features Specify Hole tool to use external hole parameter (.hol) 

files. 

replace_with_extern

al, use_internal

replace_with_external

hole_parameter_file_path Features Specifies the directory path for a standard screw-size 

parameters (.hol) file to be loaded from disk. Use the full 

path name to avoid problems. 

  

iconify_entire_pro User Interface Determines how many other Pro/ENGINEER 

windows/menus are iconified when one window is 

iconified. Yes - All the windows and menus are iconified. 

No - Only the selected window is iconified. 

no, yes yes

idd_repair_tangency Without category Sets the default state of the "Repair Tangency" 

checkbox in the Repair and Match tools 

yes, no no

iges_clip_view_ent Data Exchange Determines whether IGES entities are clipped with 

regards to IGES views. YES - Entities outside the view 

outline are clipped. NO - No clipping. 

yes, no yes

iges_clip_view_note Data Exchange Determines how IGES notes are clipped with regards to 

IGES views. No_clip - No clipping. Full_clip - Notes that 

are partially outside the view outline are clipped. 

Partial_clip - Notes completely outside the view outline 

are clipped. 

no_clip, full_clip, 

partial_clip

no_clip

iges_export_dwg_views Data Exchange Yes - Exports drawing view information. No - Does not 

export drawing view information. 

yes, no no

iges_in_assoc_dim_geom_21 Data Exchange Controls if imported IGES associative dimensions 

remain associative. Yes - If the drawing setup option 

associative_dimensioning is Yes, then the Associativity 

Instance entity is processed during import. No - 

Dimensions do not retain associativity. 

yes, no no
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iges_in_dwg_color Data Exchange Yes - Import RGB information to IGES files. The color 

definition entities in the IGES file are imported to the 

drawings as user-defined colors. No - The color-

definition entities in the IGES files are ignored when 

importing to the drawing. 

yes, no no

iges_in_dwg_line_font Data Exchange Controls the import of user-defined line fonts. Yes - Give 

default names to user-defined line styles without names 

in order ("IGES_1," "IGES_2" etc.). No - Imports the 

user-defined line fonts as Solid line font. 

yes, no no

iges_in_group_to_dwg_layer Data Exchange Yes - Converts an IGES group to drawing layers. No - 

The IGES group is not converted. 

no, yes no

iges_note_disp Data Exchange Determines what to do when IGES note entities do not 

point to any views or the drawing entity. See the 

configuration option iges_zero_view_disp. 

as_geometry, 

all_views, no_views, 

as_is

all_views

iges_out_all_srfs_as Data Exchange Default - Outputs all surfaces as appropriate IGES 

surfaces. 114 - This option applies only to 

representations of surface shape. Trimmed surface 

entities (type 144) are exported regardless of setting. 

128 - Outputs all surfaces as IGES B-spline surfaces. 

128, 114, default default

iges_out_assembly_default_m

ode

Data Exchange Set default for assembly export via IGES. Flat - Single 

level model. One_level - Assy structure with pointers to 

components. All_levels - Assy structure with all comps 

to IGES files. All_parts - Assy to IGES files with 

geominfo of comps and assy feats. 

flat, one_level, 

all_levels, all_parts

flat

iges_out_catia_gdt_width Data Exchange Yes - Enables the desired width of a gtol symbol to be 

exported to CATIA. 

yes, no no

iges_out_catia_notes Data Exchange Yes - Breaks a large note (greater than 70 strings) down 

into smaller notes, each producing an IGES entity. 

yes, no no

iges_out_dwg_color Data Exchange Yes - Enables the export of RGB information to IGES 

files. The user-defined colors in the drawing are 

exported to an IGES file as color definition entities. No - 

Ignores the user-defined colors in the drawing when 

exporting IGES file. 

yes, no no

iges_out_dwg_line_font Data Exchange Controls the export of user-defined line font through 

IGES. No - Exports all geometry as solid font. 

yes, no no
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iges_out_ent_as_bspline Data Exchange True - Exports all geometry entities, other than lines or 

arcs, as third-degree B-splines. False - Does not export 

entities as third-degree B-splines. 

true, false FALSE

iges_out_jamais_compliant Data Exchange Yes - Specifies IGES output with special JAMA-IS 

subset specification, compliant with the version 1.02 of 

JAMA-IS (Japan Automobile Manufacturers Association 

IGES Subset Specification). No - Specifies normal 

IGES. 

yes, no no

iges_out_mil_d_28000 Data Exchange Yes - Specifies IGES output that uses the MIL-D-28000 

entity subset. 

yes, no no

iges_out_spl_crvs_as_126 Data Exchange Converts all part geometry spline curves to IGES entity 

126 (B-spline) when creating an IGES file. 

no, yes yes

iges_out_spl_srfs_as_128 Data Exchange Converts all part geometry spline surfaces to IGES 

entity 128 (B-spline) when creating an IGES file. 

no, yes yes

iges_out_start_note Data Exchange Yes - Exports the text specified by 

system_iges_header_file and user_iges_header_file as 

a note on the drawing. To control note placement, use 

the configuration file option put_iges_drawing_entity. 

yes, no no

iges_out_symbol_entity Data Exchange Exports a drawing symbol as an IGES general symbol 

entity, IGES type number 228 (yes), or as its component 

entities: notes and lines. 

yes, no yes

iges_out_trim_curve_deviation Data Exchange Sets the maximum value for the distance between an 

XYZ trimming curve (boundary) and the underlying 

surface of a trimmed surface 

 -1

iges_out_trim_xyz Data Exchange Controls whether or not XYZ data is output in addition to 

UV data for trimmed surfaces. 

yes, no yes

iges_out_trm_srfs_as_143 Data Exchange Yes - Exports all surfaces to IGES entities 141 and 143. 

This overrides option iges_out_trm_xyz. 

no, yes no

iges_zero_view_disp Data Exchange When IGES geometry does not point to any views or the 

drawing entity. All_views - Creates a copy of the entity 

for each view. No_views - Does not create the entity at 

all. As_is - Creates the entity once, using only its own 

transformation information. 

all_views, no_views, 

as_is

all_views

ignore_all_ref_scope_settings Without category Controls whether object-specific reference scope 

settings are ignored or not. Environment scope settings 

will still be enforced. See also allow_ref_scope_change 

and default_ext_ref_scope 

yes, no no
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ignore_export_geom_declarati

on

Without category Ignore Export Geometry settings. yes, no no

inch_grid_interval Features Modify grid space in inch units for handle movement.  0.125

info_output_format Environment Setup the default format type for information 

presentation. Text - information will be output as simple 

text. HTML - information will be output as html data. 

text, html html

info_output_mode Environment Sets default method for presenting information. Both - 

View information on screen and write information to file. 

Screen - View information on screen only. File - Write 

information to file only. Choose - Select method from the 

INFO OUTPUT menu. 

choose, screen, file, 

both

both

initial_bend_y_factor Sheetmetal Specifies a constant used to determine the neutral bend 

line for a sheet metal part. This value is always used for 

non-cylindrical bends. It is used for regular bends only 

when no bend table is specified. 

 0.5

initial_drm_warning User Interface Warns the user that they are initiating a DRM 

session.When set to "no", this warning dialog will be 

skipped. 

yes, no yes

instance_search_exhaustive File Storage & 

Retrieval

Specifies extent of instance search. Yes - Include file 

type when entering instance name in File>Open: type 

ininput panel (e.g. inst_name.prt) or select in drop-down 

list. If no .idx files are found, only working dir 

issearched; each generic is not. 

no, yes no

interface_criteria_mismatch Without category FAIL_PLACEMENT - Fail regeneration upon component 

interface criteria mismatch. WARNING_ONLY - A 

warning message is given during regeneration for the 

criteria mismatch only without failure. IGNORE - 

Interface criteria mismatch ignored during regeneration. 

warning_only, 

fail_placement, 

ignore

warning_only

interface_quality Data Exchange Sets amount of checking for overlapping lines and 

collecting lines of same pen color before exporting plot 

or 2-D file. 0 - No check or collection. 1 - No check, but 

collection. 2 - Partial check and collection. 3 - Complete 

check and collection. 

 3

intf_cadds_import_make_solid Data Exchange Allows the user to solidify all closed quilts during import 

CADDS5 model. 

yes, no no
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intf_cadds_version Data Exchange Allows the user to switch between the default and 

alternate converter version for interface with CADDS5 

14, 15 14

intf_generate_log_file Data Exchange Specifies not to generate or generate short or long log 

files for data exchange import operations. 

no, short, long short

intf_in_dwg_pnt_ent Data Exchange Yes - Converts an IGES or DXF point entity to a drawing 

point. 

yes, no no

intf_in_dwg_view Data Exchange Controls if associativity in an imported IGES view is 

preserved. 3D_VIEWS - tries to create 3D views if 3D 

model exists in the file. 2D_VIEWS - Imported IGES 

views work as 2D. No - Imported IGES views are 

exploded and become unrelated. 

no, 2d_views, 

3d_views

2d_views

intf_in_extract_profiles Data Exchange Default, no profiles in a data exchange file will be 

extracted for use. 

none, comp, all none

intf_in_granite_direct_enable Data Exchange Allows the user to switch back to the old 'Import Feature' 

method of reading Desktop .des files and Granite .g files 

into Pro/E. By default, Pro/E directly opens these 

models. 

yes, no yes

intf_in_layer_asm_dialog Data Exchange Yes - Presents a dialog box to control the import of both 

layers and assemblies. You can choose from the list of 

layers and/or solids available in the file to select one or 

more for import. 

yes, no no

intf_in_profile_default Data Exchange Specifies the name of the existing import profile to use 

by default. 

  

intf_out_as_bezier Data Exchange Exports all B-splines as Bezier surfaces. yes, no no

intf_out_asm_mapped_item Data Exchange Export assembly components and instances using 

MAPPED ITEM entity. 

yes, no no

intf_out_assign_names Data Exchange Controls how entity names are handled when an object 

is exported to STEP format from part or assembly 

mode. You can give unique names to Pro/ENGINEER 

datum points, datum axes, datum curves, surfaces, 

edges, and quilts. 

no_name, 

user_name, 

id_name

no_name

intf_out_auto_layer_ids Data Exchange Yes - Automatically assigns interface IDs for layers that 

were not assigned IDs during export. No - Does not 

assign interface IDs for layers that were not assigned 

IDs during export. 

yes, no no

intf_out_blanked_entities Data Exchange Filters export of entities based on their blank status yes, no yes

intf_out_cat_start_model Data Exchange Specifies Catia start model to be used for CATIA II 

.model export. 
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intf_out_ed_recipe_file Data Exchange Sets the ProductView recipe file for export to .ed and 

.edz formats. For use with Windchill 8.0 and earlier 

servers 

  

intf_out_layer Data Exchange Layer mapping mechanism providing an ability to group 

entities to layers or blocks. 

none, part_layer, 

block_layer, 

block_nested_layer, 

block_view_based_l

ayer, 

block_nested_view_

based_layer

none

intf_out_layer_rename_table Data Exchange Enables you to assign interface ids to layers during 

export 

  

intf_out_max_bspl_degree Data Exchange Controls the maximum degree of exported B-spline 

surfaces when exporting through IGES 

 16

intf_out_pvs_recipe_file Data Exchange Sets the ProductView recipe file for export to .pvs and 

.pvz formats. For use with Windchill 9.0 and later 

servers 

  

intf_out_text_length Data Exchange Sets text length in exported 2-D. As_is - Width of each 

character is width of strokes. Full_size - Width of each 

character is width of character text box. Adjusted - 

Adjusts spacing so no extra space left and end/start 

character do not overlap. 

as_is, full_size, 

adjusted

full_size

intf_pdf_u3d_create_u3d_files Without category YES - When exporting a Pro/E model as PDF U3D file, 

create a U3D file of the same name as the PDF file. 

yes, no no

intf_profile_dir Data Exchange Specifies the directory where import and export profiles 

are stored. Use the full path to avoid problems. 

  

intf_pv_recipe_dir Data Exchange Sets the directory for user defined ProductView recipe 

files 

  

intf_ug_version Data Exchange Sets the version of Unigraphics interface. nx4, nx5  

intf_use_variable_size Data Exchange Yes - IGES,DXF,STEP files with variable sized sheet 

information are imported andput on the appropriate 

variable-size format. Without a sheet size, the system 

tries to apply the correct variable-size format.No - The 

IGES,DXF,STEP drawing isplaced on a standardsized 

format. 

no, yes yes
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intf2d_fit_incompatible_data Data Exchange YES - For import and export, fixes compatibility 

problems between 2-D external formats (such as IGES 

and DXF) and Pro/ENGINEER. 

yes, no no

intf2d_iges_out_hatch Data Exchange YES - Exports draft xhatching as IGES sectioned area 

entity. NO - exports draft xhatching as separate 

geometric entities. 

yes, no no

intf2d_in_acad_ignore_3d Data Exchange YES - Ignore the 3DSOLID entities, if they exist, in the 

DXF/DWG file being imported in Drawing mode. Only, 

the 2D entities are processed.NO - Create an assembly 

by processing the 3DSOLID entities in the DWG/DXF 

file being imported in Drawing mode. This is the default 

value for this option. 

yes, no no

intf2d_in_create_multiline_note Data Exchange Create a single multi-line note on importing multi-line 

text when is set to YES. 

yes, no yes

intf2d_in_dxf_mapping_file Data Exchange Specifies the mapping file for DXF and DWG import. 

Absolute or relative path to the file can be used. 

  

intf2d_in_iges_hatch_bnd_laye

r

Data Exchange Yes - Places all sectioned areas boundary imported 

from the IGES file in one layer named 

IGES_HATCH_BOUNDARY. NO - Does not place 

sectioned areas boundary in one layer. 

yes, no no

intf2d_in_iges_symbols Data Exchange Controls whether to import IGES symbols as symbols or 

as entities by default. Yes - Import IGES symbols as 

symbols by default. No - Import IGES symbols as 

entities by default. 

yes, no yes

intf2d_in_open_log_window Data Exchange Yes - Opens Import Log File in a separate window. No - 

The Log File does not appear in the window. 

yes, no no

intf2d_out_acad_mtext Data Exchange Create a single MTEXT entity for multi-line text notes 

when is set to YES. 

yes, no yes

intf2d_out_acad_ole_as_image Data Exchange Controls OLE export to DXF/DWG. Yes - exports OLE 

objects as DXF/DWG IMAGEs. No - exports OLE 

objects as separate entities. 

yes, no yes

intf2d_out_acad_text_align Data Exchange As_is - Exports notes to DXF/DWG with their original 

alignment values. Fit - Exports notes with FIT alignment. 

as_is, fit as_is

intf2d_out_acad_unicode Data Exchange Yes - Non-ASCII characters are written in UNICODE 

encoding. 

yes, no no
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intf2d_out_blanked_layers Without category Enables export of blanked layer entities. If an entity is 

placed on a layer that is blanked and this option is set to 

YES, the entity will be exported. 

yes, no no

intf2d_out_cgm_old_lfont_map Data Exchange Yes - Use the old line font mapping in CGM export: 

hidden lines to type 2, CTRLFONT to type 4, 

PHANTOMFONT to type 5. No - Use the new mapping: 

hidden lines to type 12, CTRLFONT to type 11, 

PHANTOMFONT to type 13. 

yes, no no

intf2d_out_cgm_ver Data Exchange Provides the ability to choose CGM metafile version 

when exporting from Pro/E drawing. 

1, 3 1

intf2d_out_dxf_mapping_file Data Exchange Specifies the mapping file for DXF and DWG export. 

Absolute or relative path to the file can be used. 

  

intf2d_out_enhanced_ents Data Exchange Controls whether the enhanced entities (SPLINE and 

HATCHING) are converted to the corresponding DXF 

entities or represented as separate lines and polylines. 

spline_and_hatch, 

spline_only, 

hatch_only, none

spline_and_hatch

intf2d_out_iges_layers_with_id Data Exchange Yes - Exports interface IDs of layers as IGES levels. yes, no no

intf2d_out_line_width Data Exchange YES - Exports line width information to DXF. NO - all 

entities are exported with the default width. 

yes, no yes

intf2d_out_open_log_window Data Exchange Yes - Opens Export Log File in special window. No - the 

Log File will not appear in the window. 

yes, no no

intf2d_out_pnt_ent Data Exchange Yes - Exports a drawing point to IGES, DXF or DWG as 

a point entity. No - Exports a drawing point as shape 

entities. 

yes, no no

intf2d_out_stroke_text Data Exchange Strokes == text is converted to lines and dots. "NONE"- 

Does not stroke out the text for export. "ALL" - Strokes 

out all the text. "SPECIAL" - Strokes out only special 

characters. 

none, special, all none

intf3d_ideas_import_filter Data Exchange Enables UI to selectively import I-DEAS part and 

assembly models from the I-DEAS .mf1 and .pkg 

container files. 

yes, no no

intf3d_ideas_install_dir Data Exchange Specifies the path for I-DEAS installation. Use the full 

pathname to avoid problems. 

  

intf3d_ideas_run_command Data Exchange Specifies the I-DEAS run command. Default command 

is "ideas". 

 ideas
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intf3d_in_enable_layer_join Data Exchange No - Join surfaces on import as geometry is loaded from 

file. Yes - Use new method to join surfaces by layer 

(surfaces contained on the same layer are joined 

together first) with a better chance of joining those 

surface elements to form closed geometry. 

yes, no yes

intf3d_in_import_as_facets Data Exchange Import faceted data for formats that support both facet 

and Brep representations. 

yes, no, default default

intf3d_out_annotations Data Exchange Export annotations with models. yes, no, default yes

intf3d_out_cat2_ident_crv Data Exchange Specifies model parameter IDENT_CRV while exporting 

to Catia. 

 -1

intf3d_out_cat2_ident_pt Data Exchange Specifies model parameter IDENT_PT while exporting 

to Catia. 

 -1

intf3d_out_cat2_infinity Data Exchange Specifies model parameter INFINITY while exporting to 

Catia. 

 -1

intf3d_out_cat2_model_sz Data Exchange Specifies model parameter MODEL_SZ while exporting 

to Catia. 

 -1

intf3d_out_cat2_sag Data Exchange Specifies model parameter SAG while exporting to 

Catia. 

 -1

intf3d_out_cat2_step Data Exchange Specifies model parameter STEP while exporting to 

Catia. 

 -1

intf3d_out_catia_v5_version Without category Allows the user to switch between the default and 

alternate converter version for export to CATIA V5 

16, 17, 18 16

intf3d_out_datums_by_default Data Exchange Determines whether datum curves are included when 

exporting IGES files in Batch mode. 

yes, no no

intf3d_out_default_option Data Exchange Controls the type of 3-D data output through Pro/BATCH 

to an IGES or STEP file. 

wireframe, surfaces, 

wireframe_surfaces, 

solid, shells, none

surfaces

intf3d_out_extend_surface Data Exchange Specifies how surfaces are handled for exporting files to 

other systems 

yes, no yes

intf3d_out_force_surf_normals Data Exchange IGES and PDGS export. Controls normals of non-

analytic surfaces. Yes - Forces the surface normals to 

point in a consistent direction. No - Does not force the 

surface normals to point in a consistent direction. 

yes, no no

intf3d_out_jt_auto_lods Data Exchange Generate three default ProE LODs. no, yes no

intf3d_out_jt_brep Data Exchange Export as faceted data for formats that support both 

facet and Brep representations. 

no, jt_brep, xt_brep no
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intf3d_out_jt_config_name Without category Name of JT configuration file.   

intf3d_out_jt_config_path Without category Path to JT configuration file.   

intf3d_out_jt_structure Data Exchange Specifies product structure to file structure mapping 

defined in JT Open Toolkit. 

per_part, 

fully_shattered, 

monolithic

per_part

intf3d_out_parameters Data Exchange Exports parameters with models. all, none, designated all

intf3d_out_prop_chord_heights Without category Use maximum chord heights proportional to component 

sizes. 

yes, no no

intf3d_out_prop_step_sizes Without category Use maximum step sizes proportional to component 

sizes. 

yes, no no

intf3d_out_surface_deviation Data Exchange Sets maximum allowable deviation between original and 

resulting surfaces in the process of converting 

Pro/ENGINEER surfaces to spline surfaces. By setting 

this you convert surfaces with a better approximation 

than by using the current model accuracy. 

 -1

intf3d_out_unicode_to_neutral Data Exchange YES - Unicode strings are exported to the Neutral file, 

NO - Unicode strings are converted to ascii characters 

for Neutral file export. 

yes, no yes

intf3d_out_use_num_names Data Exchange Use numeric layer names as layer export IDs. yes, no yes

intf3d_out_use_step_size Without category Use maximum step size(s). yes, no no

intf3d_parasolid_export_schem

a

Data Exchange Allows user to choose the schema to be used for 

parasolid export. Default is SCH_10004. Consult online 

documentation for other valid schema settings. 

 sch_10004

isogen_attribute_map_file Piping Specifies the mapping between isogen parameter and 

attribute name. 

 <proe_WF_5.0_loadpo

int>/text/piping_data/is

odata/isogen_attribute

_map.ptd

isogen_endtype_map_file Piping Specify name of file mapping Pro/Piping endtypes with 

ISOGEN endtypes 

 <proe_WF_5.0_loadpo

int>/text/piping_data/is

odata/isogen_endtype_

map.ptd

isogen_mandatory_attr_file Piping Specify file containing mandatory attribute filenames 

used by ISOGEN. 

 isogen.fls
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isogen_nominal_size_map_file Piping Specify name of file mapping Pro/Piping Size with 

Nominal Sizes in MM and Inches 

 <proe_WF_5.0_loadpo

int>/text/piping_data/is

odata/isogen_nominal_

size_map.ptd

isogen_output_files_dir Piping Specify directory to save the PCFs created by ISOGEN 

interface 

  

isogen_pcf_filename_format Piping Specify format to create filenames of PCF files being 

created 

 mnemonic,-

,specification,-,number

isogen_symbol_map_file Piping Specify name of file for mapping Pro/Piping selection 

names with ISOGEN symbol keys (SKEY)s 

 <proe_WF_5.0_loadpo

int>/text/piping_data/is

odata/isogen_symbol_

map.ptd

jlink_java_command Without category Specifies a command to start JRE for J-Link. May 

contain arguments and environment variables. 

Overrides the default, see also jlink_java2. 

  

jlink_java2 Application 

Programming 

Interfaces

Option to force use of Java-2 JRE command line ("java" 

instead of "jre") 

off, on on

kbd_cmd_abbreviation User Interface On - Enables use of abbreviations when entering menu 

commands from the keyboard. 

on, off off

kbd_selection User Interface Provides the ability to select locations in the graphics 

area via the keyboard.Yes - Selection in the graphics 

area may be performed via the keyboard.No - Selection 

in the graphics area requires a mouse. 

no, yes no

keep_info_datums Features Sets the initial state of how the system treats datums 

and features created at run time. 

yes, no yes

keep_model_in_open_window Without category Controls whether a model is displayed in its window 

whenthe accessory window is open. 

no, yes no

keep_style_items_hidden_on_

exit

Without category Keep style entities hidden after exiting of the Style 

feature definition. 

yes, no no

lang_propagate File Storage & 

Retrieval

Specifies language storage options. The option provides 

flexibility for objects that use a different language than 

the current 

yes, no yes

last_session_directory_path Without category Sets the directory that holds the temp files for the 

session recording mechanism. 

  /work_dir/.wf/.settings
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last_session_retrieval Without category Yes - Activates recording mechanism that enables the 

session to be retrieved during the next session. No - 

The recording mechanism is not available and the 

session can not be retrieved. 

yes, no yes

layer_item_highlight_limit Layers Set the upper limit of items in a layer for highlighting.If 

items in a layer exceeds this number, highlighting will 

not occur. 

 500

layer_rule_retrieve_objects Without category This option controls whether or not the system will 

retrieve additional objects needed to evaluate a layer 

rule. OK tells the system to retrieve the objects. Cancel 

stops evaluation of the rule. 

promt, ok, cancel promt

let_proe_rename_pdm_objects Data Management Determines whether an object fetched from a PDM 

database can be renamed in a Pro/Engineer session. 

no, yes no

linear_tol Dimensions & 

Tolerances

An alternate format for setting default linear tolerance 

dimensions. First value sets the number of decimal 

places. Second value is the actual tolerance. For 

example, 6 0.000025 sets tolerance to six decimal 

places. The default tolerance is 0.000025. 

 0

linear_tol_0.0 Dimensions & 

Tolerances

Specify a range for default tolerances of linear and 

angular dimensions. These values affect only models 

created after the tolerance options are specified in the 

configuration file. 

 1

linear_tol_0.00 Dimensions & 

Tolerances

Specify a range for default tolerances of linear and 

angular dimensions. These values affect only models 

created after the tolerance options are specified in the 

configuration file. 

 1

linear_tol_0.000 Dimensions & 

Tolerances

Specify a range for default tolerances of linear and 

angular dimensions. These values affect only models 

created after the tolerance options are specified in the 

configuration file. 

 1

linear_tol_0.0000 Dimensions & 

Tolerances

Specify a range for default tolerances of linear and 

angular dimensions. These values affect only models 

created after the tolerance options are specified in the 

configuration file. 

 1
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linear_tol_0.00000 Dimensions & 

Tolerances

Specify a range for default tolerances of linear and 

angular dimensions. These values affect only models 

created after the tolerance options are specified in the 

configuration file. 

 1

linear_tol_0.000000 Dimensions & 

Tolerances

Specify a range for default tolerances of linear and 

angular dimensions. These values affect only models 

created after the tolerance options are specified in the 

configuration file. 

 1

lods_enabled Model Display Determines whether or not the system uses Level of 

Detail in shaded models during dynamic orientation 

(panning, zooming and spinning). 

no, yes no

lods_value Model Display When lods_enabled is Yes, this value specifies the 

default value used to display LODs. The value is a 

percentage of the edge size vs the total size of the 

model. 

 50

maintain_limit_tol_nominal Dimensions & 

Tolerances

Maintains the nominal value of a dimension regardless 

of the changes that you make to the tolerance values. 

yes, no no

make_aux_view_notes Drawing Automatically adds view names to auxiliary views using 

AUX VIEW* viewname-viewname. You can modify the 

view name after adding the view to the drawing. 

yes, no no

make_parameters_from_fmt_t

ables

Drawing Determines the handling of values entered in a format 

table when you replace one drawing format with 

another. Yes - Stores entered values for format table 

and copies them with the table. No - Prompts you to re-

enter all the values for the format table. 

yes, no no

make_proj_view_notes Drawing Automatically adds view names to projection views in 

the format "VIEW viewname-viewname." You can 

modify the view name after adding the view to the 

drawing. 

yes, no no

manikin_drag_auto_locks Without category Manikin drag auto locks yes, no yes

manikin_flexibility Without category Sets the level of flexibility that is allowed when dragging 

a manikin. FULL - All Manikin segments are 

articulated.NONE - Manikin is calculated as a single 

body. DEFAULT - Manikin finger segments are locked 

to a single body. 

full, none, default default

manikin_replace_keep_posture Without category Controls whether a manikin's existing posture is applied 

to a replacement manikin. 

yes, no no
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mapkey Miscellaneous Stores a keyboard macro. Use Tools>Mapkeys to 

create, edit and delete mapkeys. 

  

mapkeys_execution Miscellaneous Mapkeys execution behavior. No Feedback - The 

mapkey is executed with no feedback, Execute with 

Feedback - A warning message is given upon failure 

during execution, Stop at failure - The execution stops 

at failure and a feedback message is provided. 

no_feedback, 

execute_with_feedb

ack, stop_at_failure

no_feedback

mark_approximate_dims Dimensions & 

Tolerances

Yes - Displays a tilde (~) in front of a dimension that is 

set to display as a fraction and has an actual value that 

is not rounded to equate exactly to the displayed 

fractional value (the fraction shows 7/32 but the actual 

value is .22, not 0.21875). 

yes, no no

mass_property_calculate Environment Calculate mass properties upon regeneration or by user 

request. 

by_request, 

automatic

by_request

mat_assign_appearance Colors Control whether default appearance in material 

definition is automatically assigned to a part. 

yes, no yes

material_upd_smt_bend_table Sheetmetal Defines whether assignment of material to the model via 

Pro/Toolkit will overwrite existing bend table data and y 

factor value. Always Replace - Overwrites existing data. 

Never Replace - Keeps existing data 

always_replace, 

never_replace

always_replace

mathcad_analysis_directory File Storage & 

Retrieval

Sets the default directory for the Mathcad files to be 

used for Mathcad analysis calculations. Use the full 

pathname to avoid problems. 

  

mathcad_automapping Environment Toggles Mathcad analysis automapping of variables yes, no no

max_animation_time Model Display When the orientation, or zoom state, of the 

Pro/ENGINEER window changes, an animation 

sequence of a predefined duration takes place. This 

option controls the maximum time the system spends 

animating. 

 1

max_image_dimension Model Display Set the upper bound dimension on images loaded into 

Pro/ENGINEER. Images larger than this limit will be 

rescaled to this upper bound during loading. 

4096, 1024, 2048, 

8192, 16384

4096

mdl_tree_cfg_file User Interface Specifies the Model Tree configuration file to be loaded 

when Pro/ENGINEER is started. 

  

mdo_cl_executable Mechanism Path for Custom Load executable.   

mdo_explicit_integration Mechanism Enable explicit integration for dynamic analyses. yes, no no
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mdo_spring_wire_radius Mechanism Spring wire radius for dynamics spring icons.  0.15

mdx_belt_icon_width Mechanism Width of belt transmission icons.  5

mdx_collision_num_triangles Environment The number of mesh triangles which are used to 

approximate model in collision detection. 

 1000

measure_dec_places Without category This configuration option controls the number of digits 

after the decimal point. If value = -1, this configuration is 

ignored and measure_sig_figures is used 

 -1

measure_sig_figures Environment Sets the number of significant figures displayed as 

results when using the Measure dialog box from the Info 

menu. 

 6

medusa_2d_config_file Data Exchange Specifies the Medusa 2D Interface config. file. Absolute 

or relative path to the file can be used. 

  

mentor_ver_2_0 Data Exchange Yes - Exports the file in IDF 2.0 format. No - Exports the 

file in IDF 1.0 format unless IDF 2.0 is selected from the 

ECAD FORMAT menu. 

yes, no yes

menu_font User Interface Specify font used in the Pro/ENGINEER menu bar, 

menus, and all their children. Specify the comma-

delimited variables in any order (italic bold, 24, times or 

24, times, italic bold have the same effect). Any omitted 

variable uses the standard setting. 

  

menu_manager_position User Interface Controls the position of the Menu Manager.outside - 

Top left corner of Menu Manager is aligned to top right 

corner of window, inside - Top right corner of Menu 

Manager is aligned to top right corner of graphics 

area,adaptive - Menu Manager is positioned outside if 

there is enough room, otherwise it is positioned inside. 

outside, inside, 

adaptive

adaptive

menu_mapper_location User Interface Specify your own URL for the Menu Mapper button in 

the help menu. 

  

menu_show_instances File Storage & 

Retrieval

Determines whether instance names listed in instance 

index files appear in file lists. 

yes, no yes

menu_translation User Interface Specifies the language in which the menus display when 

running non-English version of Pro/ENGINEER. 

yes, no, both yes
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merge_smt_srfs_without_sea

m

Sheetmetal Yes - no edge left at the merge if the sheetmetal 

surfaces being merged are same surfaces. No - edge is 

left even between same sheetmetal surfaces. 

yes, no yes

merge_type Features Sets the default merge type surface merge operations. join, intersect intersect

mesh_spline_surf Model Display Turns the blue mesh surface lines on or off. no, yes no

meter_grid_interval Features Modify grid space in meter units for handle movement.  0.001

mfg_auto_ref_mfg_template Without category Enable/Disable auto referencing for Manufacturing 

template 

yes, no no

mfg_auto_ref_prt_as_chk_srf Manufacturing Yes - In 3, 4, and 5 axis contour and conventional mill 

sequences, the entire reference part is selected as 

check surfaces by default when computing the NC 

sequence toolpath for those sequences. No - You select 

the check surfaces. 

yes, no yes

mfg_auto_retract_clear_dist Without category Specifies distance between automatically created retract 

plane and step coordinate system. Will be applied to the 

new steps created in process manager if operation 

retract cannot be used. 

 -0.001

mfg_custom_tool_param_file Manufacturing Defines the file that contains the user-defined tool 

parameters' list. 

  

mfg_customize_dialog Manufacturing Yes - Uses the new customize dialog box for 

customizing NC sequences. No - Uses the Release 19.0 

menus. 

yes, no yes

mfg_cutline_save_mesh Manufacturing Yes - Save / Retrieve Mesh for subsequent cutline 

recalculations, No - New Mesh will be computed for 

each cutline recalculations. 

yes, no yes

mfg_ijk_num_digits Manufacturing Sets the number of digits for i, j, k data points in a CL 

data file. 

 10

mfg_info_location Manufacturing top left /bottom right -Position of the mfg. Info dialog 

box. 

top_left, 

bottom_right

top_left

mfg_modal_command_file Manufacturing Enables you to make some of the APTn index topics 

modal, which means that you repeatedly get a list of 

major keywords corresponding to this topic upon 

completing a command line. 

  

mfg_param_auto_copy_from_t

ool

Manufacturing Do not copy any parameter of the tool to the sequence 

parameter tree. 

none, all, misc, 

cutting

none
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mfg_process_print_dir Without category Specifies the directory where Mfg Process html page 

get stored. Use the full pathname to avoid problems. 

  

mfg_process_table_setup_dir Without category Specifies the directory where Mfg Process Table 

settings get stored. Use the full pathname to avoid 

problems. 

  

mfg_process_template_dir Without category Specifies the directory where Mfg Process Templates 

get stored. Use the full pathname to avoid problems. 

  

mfg_setup_dir Without category Specifies the directory which contains all manufacturing 

related setup files for the current session. 

  

mfg_start_model_dir File Storage & 

Retrieval

Provides the complete path to the directory containing 

mfg start assemblies. 

  

mfg_tap_mat_rem_coef Without category The factor is used to consider the threading of tapping 

tool. The estimate removed material value of tapping 

sequence is presented as estimate removed material 

value multiplied by this factor. The factor should be 

greater than 0 and upto 1.0. 

 1

mfg_template_dir Manufacturing Specifies the storage directory for NC templates. 

Specify full path to avoid problems. NC templates are 

used in Expert Machinist. Templates store the recipe for 

a toolpath as the method of tool retrieval. 

  

mfg_tool_dialog_setup_file Without category Specifies the XML based file to setup Tool Dialog.   

mfg_udf_info_setup_file Without category Specify name and path of the file containing udf and mfg 

criteria values . 

  

mfg_workpiece_transparency Manufacturing Controls the workpiece transparency in shaded model 

display. You can change the value in the range between 

0.1 and 1. The bigger the value, the more transparent 

the workpiece. The default value is 0.5. 

 0.5

mfg_xyz_num_digits Manufacturing Sets the number of digits for x, y, z data points in a CL 

data file. 

 10

millimeter_grid_interval Features Modify grid space in millimeter units for handle 

movement. 

 1

Parametric Technology Corporation 51 Pro/ENGINEER Wildfire 5.0 Configuration Options



Name Category Description Values Default Value

min_animation_steps Model Display When the orientation, or zoom state, of the 

Pro/ENGINEER window changes, an animation 

sequence of predefined duration takes place. This 

option controls the minimum number of frames used in 

the animation sequence. 

 6

minimum_angle_dimension Dimensions & 

Tolerances

Controls the minimum angle value under which 

Pro/ENGINEER assumes colinearity of the selected 

items when creating a driven dimension. 

 1

model_allow_ref_scope_chang

e

Without category Yes - Users can change the scope setting of 

components. 

yes, no yes

model_grid_balloon_display Environment Controls the display of grid balloons. yes, no yes

model_grid_neg_prefix Environment Enables you to specify the prefix to use for negative 

numbers in the balloon capture of the grid. 

 -

model_grid_num_dig Environment Controls the number of decimal places displayed in the 

balloon capture. 0 - Only integers display. 

  

model_grid_spacing Environment Sets the default model grid spacing.  1.5

model_notes_as_labels Environment Gives the option to display notes as either full text or as 

label. Can also be toggled with environment option 

"Display Notes as Names." 

no, yes no

model_rename_template File Storage & 

Retrieval

Sets the default renaming convention for copied 

assemblies. The default new name is the old name 

appended with an underscore (_). Adding a template 

such as &#91;*a1*=*b1*] changes every occurrence of 

a1 to b1 (e.g. TOP_A1_BRACKET copies to 

TOP_B1_BRACKET). 

  

model_tree_font Without category Specify font used in the Pro/ENGINEER Model Tree. 

specify the comma-delimited variables in any order 

(italic bold, 24, times or 24, times, italic bold have the 

same effect). Any omitted variable uses the standard 

setting. 

  

model_tree_start Environment Toggles display of the Model Tree. Yes - Displays the 

Model Tree window along with its model. No - Does not 

display the Model Tree window. 

no, yes yes

modelcheck_dir Without category Specifies path to the ModelCHECK configuration files.   

modelcheck_enabled Environment Enable ModelCHECK yes, no yes

modeltree_show_gen_of_insta

nce

User Interface Determines whether the generic name is displayed as 

an extension of the instance name in the model tree and 

other model name lists. 

yes, no yes
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modified_objs_in_new_dir File Storage & 

Retrieval

Yes- During Save a Copy operations, any modified 

object that is not renamed will be saved in the new 

directory.No- Any modified object that is not renamed 

will be saved to the retrieval directory. 

yes, no no

mold_layout_origin_name Casting & Mold 

Design

Sets a specified coordinate system as the default for the 

cavity layout origin. 

  

mold_vol_surf_no_auto_rollbac

k

Casting & Mold 

Design

Do not perform automatic rollback while modifying mold 

volumes or parting surfaces. 

yes, no no

motion_envlp_alert Mechanism Displays the Motion Envelope alert the first time the 

quality level is increased. 

yes, no yes

move_mechanism_in_nongeo

m_reps

Mechanism Allow mechanism operations in non geometrical 

representations. 

no, yes yes

mp_calc_level Without category Specifies the level of mass properties calculation. assembly_only, 

all_models

assembly_only

mp_dens_ft_column_mtrl_assi

gned

Assembly Yes - Allows adding an MP_DENSITY column in FT 

when a material is assigned to a model. When set may 

cause the same material to have different values for the 

Density parameter in different instances. Does not affect 

legacy models. 

no, yes no

msg_translation User Interface Specifies language in which Messages are displayed 

when running non-English version of Pro/ENGINEER. 

yes, no yes

mtrl_convert_units Assembly If set to "Yes" Pro/E will automatically convert units in 

materials from a library to the model system of units. 

yes, no yes

multiple_skeletons_allowed Without category Allows/restricts multiple skeleton. yes, no no

native_kbd_macros User Interface Specifies support of keyboard macros written in native 

language (for example, German). 

no, yes no

nc_autodoc_param_dir Manufacturing Location of the setup file that describes which process 

parameters are included in the parameter table. 

  

nc_autodoc_report_dir Manufacturing Location for storing the report and images generated by 

the shop floor documentation tool. 

  

nc_autodoc_setup_dir Manufacturing Location for documentation setup files that describe 

which process parameters are included in the 

parameter table. 

  

nc_autodoc_template_dir Manufacturing Location of the style sheet and default images used for 

shop floor documentation. 
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nc_jobman_visible Without category Yes - make "Submit Path" and "Abort Path" visible. No - 

make "Submit Path" and "Abort Path"invisible. 

yes, no no

nccheck_type Manufacturing Vericut will be used for NC material removal simulation. vericut, nccheck vericut

ncl_file_extension Manufacturing Sets the default file extension for Pro/MFG CL data files. 

Enter the file extension only (without the preceding "."). 

For example, apt produces filename.apt. 

 ncl

ncmdl_bar_stock_part_path Manufacturing Sets path for storage and retrieval of stock instances for 

creating workpiece in NC Model. Specify full path, 

including part name, to avoid problems. 

 <proe_WF_5.0_loadpo

int>/text/ncmdl_data/nc

mdl_bar.prt

ncmdl_billet_stock_part_path Manufacturing Sets path for storage and retrieval of stock instances for 

creating workpiece in NC Model. Specify full path, 

including part name, to avoid problems. 

 <proe_WF_5.0_loadpo

int>/text/ncmdl_data/nc

mdl_billet.prt

ncpost_type Manufacturing Set to GPOST to access the default post processor 

supplied with Pro/NCPOST. 

gpost, ncpost  

ncseq_outbnd_curve Without category Yes - Create out bound curve. no no

ncseq_outbound_curve Manufacturing Yes - Create out bound curve. yes  

new_parameter_ui User Interface Enable the new parameter editor and user interface. yes, no yes

new_ref_part_name_disabled Without category  yes, no yes

new_relation_ui User Interface Enable the new relations editor and user interface. yes, no yes

new_turn_scan_type Manufacturing Allows to use New turn scan types for Turning NC 

sequences. 

yes, no yes

new_wf5_simp_rep_ui Without category Yes - Use Component Chooser base Simp Rep UI, No - 

Use old Simp Rep definition UI. 

yes, no yes

number_user_colors Colors Specifies the maximum number of different wireframe 

colors that can display in the graphics area(s) at any 

given moment. 

 -1

offset_line_def_color Assembly Process Specifies the color that offset lines are displayed in 

drawings. 

 0

offset_line_def_font Assembly Process Specifies the font in which offset lines are displayed in 

drawings. 

  

old_style_set_datum Without category Yes - datum properties dialog has button for old-style 

set datum. No - datum properties dialog does not have 

button for old-style set datum. 

yes, no yes
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online_resources_location User Interface Specify your own URL for the Online Resources button 

in the help menu. 

  

open_draw_simp_rep_by_defa

ult

File Storage & 

Retrieval

Set to "Yes" to always invoke the open rep dialog when 

opening a drawing. 

yes, no no

open_simplified_rep_by_defaul

t

File Storage & 

Retrieval

Retrieves a model in a specified representation. Yes - 

uses Open Rep dialog. No - retrieves the Master 

representation. Specified Name - retrieves the model in 

the specified representation name if it exists or the 

Default representation. 

 no

orientation Model Display Establishes the initial standard view orientation. 

User_default - System uses X-axis and Y-axis values 

defined by options x_axis and y_axis. 

isometric, trimetric, 

user_default

trimetric

orientation_style Without category Set spin orientation style to dynamic or anchored. anchored, dynamic dynamic

orthogonal_snap Electromechanical Controls non-90 degree routing in Pro/DIAGRAM. Yes - 

Turns the Ortho Snap function on. You can sketch wires 

only at the default horizontal and vertical orientation. No - 

Enables you to sketch wires in drawings at angles other 

than the default. 

yes, no yes

output_mfg_xml Without category Allows export/import mfg model to/from xml file. Yes- 

make Export/Import options visible. No - make them 

invisible. 

yes, no no

overlays_enabled System Yes - Enables Pro/ENGINEER screens and menus to 

be placed on different overlay layers of the hardware 

graphics card. This frees memory for Pro/ENGINEER 

use. 

yes, no no

override_store_back File Storage & 

Retrieval

Forces the storage of objects retrieved from other 

directories to the current working directory. 

yes, no no

package_constraints Assembly Action to take for packaged components in Assembly 

mode. Update - Updates components if assembly 

changes. Freeze - Does not move components if 

assembly changes. Disallow - Does not allow packaged 

components in assembly (must be fully constrained). 

disallow, freeze, 

update

update

package_ref_alert Assembly Control whether alert dialog is given when packaged 

component is referenced. Yes - Allow alert when a 

packaged component is referenced. No -No Alert is 

given when a packaged component is referenced. 

yes, no no

param_dec_places User Interface Sets the number of decimal places (0-14) to display in 

parameters. 

 6
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parameter_dialog_setup_file User Interface Setup for the parameter dialog configuration file.   

parenthesize_ref_dim Dimensions & 

Tolerances

Encloses reference dimensions in parentheses. No - 

Follows reference dimensions with the text "REF". 

yes, no no

pattern_exact_incremental_di

m

Without category When pattern incremental dimensions are calculated 

from expressions, round them to the decimal places set 

by config option default_dec_places. 

no, yes no

pattern_relations_copy User Interface Determines whether relations of pattern leader are 

inherited by pattern members. 

yes, no yes

pdf_linecap Data Exchange 0 - Butt cap: stroked lines are squared off at the 

endpoint of the path.There is no projection beyond the 

end of the path. 

butt, round, 

projecting square

butt

pdf_linejoin Data Exchange 0 - Miter join: outer edges of the strokes for the two 

segments are extended until they meet at an angle. 

miter, round, bevel miter

pdf_use_pentable Data Exchange No - PDF export does not use any defined pentable 

changes as would be applied to plotting the drawing. 

no, yes no

pdm_rev Data Management Specify how the system parameter, PDM_REV, should 

be formatted. Only useful for objects submitted to 

Pro/PDM or Pro/INTRALINK. 

pdmrev_fmt_rev_ver

, pdmrev_fmt_rev, 

pdmrev_fmt_branch

_rev_ver, 

pdmrev_fmt_branch

_rev

pdmrev_fmt_rev_ver

pdm_server_quickview_rows_n

um

Without category Sets the default number of rows for the pdm quick view 

list. 

 7

pen_slew Printing & Plotting Sets the pen speed for both x and y directions for 

plotters that are compatible with this option. Consult 

your plotter's user guide for more information. 

 -1

pen_slew_xy Printing & Plotting Sets the pen speed for the x and y directions individually 

for plotters that are compatible with this option.The first 

value is the x value and the second, the y value. They 

should be separated by a space. 

 -1

pen_table_file Printing & Plotting Specifies a default pen mapping table which supersedes 

other pen mapping information. 

 table.pnt

pen1_line_weight Printing & Plotting Sets the weight of entities plotted with pens using an 

electrostatic plotter. The weight is a range from 1 

(thinnest) to 16 (thickest). 

 4
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pen2_line_weight Printing & Plotting Sets the weight of entities plotted with pens using an 

electrostatic plotter. The weight is a range from 1 

(thinnest) to 16 (thickest). 

 1

pen3_line_weight Printing & Plotting Sets the weight of entities plotted with pens using an 

electrostatic plotter. The weight is a range from 1 

(thinnest) to 16 (thickest). 

 2

pen4_line_weight Printing & Plotting Sets the weight of entities plotted with pens using an 

electrostatic plotter. The weight is a range from 1 

(thinnest) to 16 (thickest). 

 3

pen5_line_weight Printing & Plotting Sets the weight of entities plotted with pens using an 

electrostatic plotter. The weight is a range from 1 

(thinnest) to 16 (thickest). 

 2

pen6_line_weight Printing & Plotting Sets the weight of entities plotted with pens using an 

electrostatic plotter. The weight is a range from 1 

(thinnest) to 16 (thickest). 

 3

pen7_line_weight Printing & Plotting Sets the weight of entities plotted with pens using an 

electrostatic plotter. The weight is a range from 1 

(thinnest) to 16 (thickest). 

 1

pen8_line_weight Printing & Plotting Sets the weight of entities plotted with pens using an 

electrostatic plotter. The weight is a range from 1 

(thinnest) to 16 (thickest). 

 4

photorender_capability_warnin

gs

Photorender Allows the user to disable warnings about PhotoLux only 

capabilities. 

yes, no yes

photorender_default_height Photorender Sets the default height (in pixels) for the custom size 

rendered output 

 450

photorender_default_width Photorender Sets the default width (in pixels) for the custom size 

rendered output 

 600

photorender_memory_usage Photorender Sets the memory limit that Pro/PHOTORENDER allows 

for model processing. Do not use commas in the 

memory value, as Pro/ENGINEER interprets these as 

decimals. 

 256

photorender_preview_scale Photorender Allows user defined size ratio at which 

Pro/PHOTORENDER will render, using the default 

Render To: Full Window Preview setting. Increasing the 

value creates higher quality rendering with slower 

performance. Reducing the value produces reverse 

results. 

 0.5
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pick_aperture_radius System Specifies the size of the area about the mouse when 

making selections. Units are 1/1000 of screen size. 

 7

pick_chain_tangent_only Drawing Specifies the extent of draft entity chains selected. Yes - 

Only entities in the chain that are tangent will be 

selected. No - All entities connected end to end will be 

selected. 

yes, no no

pipe_3d_bend_theor_int_pts Without category Yes - Displays theoretical intersections and bends in 

three-dimensional models. 

no, yes no

pipe_bend_locations_csys_unit

s

Piping Define which assembly units will be used for the piping 

bend locations calculations. Yes - to use coordinate 

system assembly units. No - to use pipeline assembly 

units. 

yes, no no

pipe_pre_22_bendinfo_conv Piping Convert bend report information generated prior to 

Pro/ENGINEER 2000i-2 to current saved analysis 

format. 

yes, no yes

pipe_solid_centerline Piping Yes - Display Pro/PIPING centerlines. No - Do not 

display Pro/PIPING centerlines. 

yes, no yes

pipe_solid_label_format Piping Specify the pipe solid label format that will be used to 

automatically generate pipeline labels. 

 size,-,specification,-

,mnemonic,-,number,-

,insulation

pipe_update_pre_20_int_pts Piping Yes - Pipelines created prior to Release 20.0 are 

updated with intersection point entities. The entities are 

created in session by Info>Regen Info or when you 

retrieve the model. 

yes, no no

pipeline_assembly_library_dir Piping Sets the default pipeline assembly library directory.  <proe_WF_5.0_loadpo

int>/text/piping_data/pi

pelinelib/

pipeline_assembly_name_form

at

Piping Sets the default pipeline assembly name format.  mnemonic,-,number

pipeline_label_format Piping Specify the pipeline label format that will be used to 

automatically generate pipeline labels. 

 size,-,specification,-

,mnemonic,-,number,-

,insulation

pipeline_solid_start_part_name Piping Sets the default pipeline solid start part name.  pipeline_solid_start.prt

pipeline_spool_label_format Piping Specify the pipeline spool label format that will be used 

to generate the spool labels during pipeline spool 

generation. 

 mnemonic-number-

prefix&#91;0]spoolnum

&#91;01]suffix&#91;]
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pipeline_start_assembly_name Piping Sets the default pipeline start assembly name.  pipeline_start.asm

piping_appearance_map_file Piping Sets the default piping appearance map filename.  <proe_WF_5.0_loadpo

int>/text/piping_data/m

aster_catalog/piping_a

ppearance.map

piping_bolt_nut_select_file Piping Piping bolts and nuts selection file.  <proe_WF_5.0_loadpo

int>/text/piping_data/m

aster_catalog/piping_b

olt_nut_select.ptd

piping_design_method Piping Sets the current Piping design method for pipeline 

modeling. 

non_spec_driven, 

spec_driven, 

user_driven

non_spec_driven

piping_enable_designate_repo

rt

Piping Enable designatable reports for spec-driven piping. yes, no yes

piping_end_compatibility_file Piping Sets the default piping end compatibility filename.  <proe_WF_5.0_loadpo

int>/text/piping_data/m

aster_catalog/piping_e

nd_compatibility.ptd

piping_extend_dim_scheme Piping Specify a dimension scheme for piping extend segment. cartesian, cylindrical, 

spherical

cartesian

piping_extend_show_csys Piping Control whether small preview CSYS is shown at end of 

pipe when defining extend features in cartesian / 

spherical / cylindrical schemes. 

yes, no no

piping_fitt_angle_tolerance Piping Sets the default piping fitting angle tolerance value.  1.5

piping_fitt_category_map_file Piping Sets the default piping fitting category map filename.  <proe_WF_5.0_loadpo

int>/text/piping_data/sa

mple_project/piping_fitt

_category_map.ptd

piping_fitt_library_dir Piping Sets the default piping fitting library directory.  <proe_WF_5.0_loadpo

int>/text/piping_data/fitt

inglib/

piping_fluid_parameter Piping Enables/disables the Parameters tab in Create Pipeline 

Dialog 

no, yes no
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piping_insulation_dir_file Piping Sets the default piping insulation directory filename.  <proe_WF_5.0_loadpo

int>/text/piping_data/sa

mple_project/piping_in

sulation_dir.ptd

piping_joint_fitting_clearance Piping Sets the piping joint minimum fitting clearance value.  1

piping_joint_fitting_offset Piping Sets the piping joint minimum fitting offset value.  1

piping_manufacture_dir_file Piping Sets the default piping manufacture directory filename.  <proe_WF_5.0_loadpo

int>/text/piping_data/m

aster_catalog/piping_m

anufacture_dir.ptd

piping_material_file Piping Sets the default piping material filename.  <proe_WF_5.0_loadpo

int>/text/piping_data/m

aster_catalog/piping_m

aterial.ptd

piping_mcat_dir Piping Sets the default piping master catalog directory.  <proe_WF_5.0_loadpo

int>/text/piping_data/m

aster_catalog/

piping_mcat_dir_file Piping Sets the default piping master catalog directory 

filename. 

 <proe_WF_5.0_loadpo

int>/text/piping_data/m

aster_catalog/piping_m

cat_dir.ptd

piping_min_bolting_clearance Piping Sets the default piping minimum bolting clearance 

value. 

 1

piping_project_data_dir Piping Sets the default Project data directory.  <proe_WF_5.0_loadpo

int>/text/piping_data/sa

mple_project/

piping_schematic_driven Piping Set the Schematic Driven Pipeline Modeling ON/OFF no, yes no

piping_schematic_xml_dir Piping Specify directory with full path containing schematic 

information XML file(s). 

  /work_dir/config_pro/

piping_spec_dir_file Piping Sets the default piping specification directory filename.  <proe_WF_5.0_loadpo

int>/text/piping_data/sa

mple_project/piping_sp

ec_dir.ptd

piping_system_tree_format Piping Sets the default piping model tree format.  mnemonic

piping_thumb_wheel_incremen

t

Piping Sets the default piping thumb wheel increment value.  1
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piping_thumb_wheel_ratio_inc Piping Sets the default piping thumb wheel ratio increment 

value. 

 0.01

piping_wildfire_convert Piping Always ask before converting old piping assemblies to 

update the network structure. 

manual, never, 

automatic

manual

placement_rep_by_default File Storage & 

Retrieval

Retrieves the assembled component in a specified 

representation. None - retrieves the representation 

specified in configuration option 

open_simplified_rep_by_default. 

 none

plot_file_dir Printing & Plotting Specifies the directory where plot files should be written. 

Use the full pathname to avoid problems. For example 

/home/users/plotfiles. 

  

plot_linestyle_scale Printing & Plotting Specifies the scaling factor for the DOTFONT line style 

in a plot. 

 1

plot_names Printing & Plotting Yes - Plot files are given descriptive extensions when 

created. No - All plot files are simply given the extension 

.plt. 

yes, no  

plot_names_with_sheet Without category Yes - Plot file names are appended with _(sheet 

number) before file extension. 

yes, no no

plot_proceed_dialog Printing & Plotting Yes - Enables the Plot Proceed dialog which provides a 

choice for delaying the printing of plot files. This is 

useful for large plots when using lp print commands. 

The lp command may not access the plot file before it is 

removed resulting in no output. 

yes, no no

plot_to_scale_full_window Printing & Plotting Provides the ability to exclude empty window space 

when plotting the model to scale. 

yes, no  

plotter Printing & Plotting Establishes the default plotter for making plot files.   

plotter_command Printing & Plotting Sets the command that you use to start a plot on your 

system; for Windows NT or Windows 95, 

windows_print_manager option configures 

Pro/ENGINEER to plot to a recognized device in the 

Windows NT or Windows 95 print manager. 

windows_print_man

ager

 

plotter_handshake Printing & Plotting Specifies the type of plotter handshake initialization 

sequence generated in the plotter files. 

hardware, software  

popup_refpairintch_window Without category Bring forward the window being used with the reference 

pairing table. 

yes, no no
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popuphelp_font User Interface Specify font used in the Pro/ENGINEER pop-up help. 

Add the comma-delimited variables in any order (italic 

bold, 24, times or 24, times, italic bold have the same 

effect). Any omitted variable uses the standard setting. 

  

postscript_compression Printing & Plotting Specifies whether or not to compress exported shaded 

PostScript files. Yes - A shaded postscript file created 

with File>Export will be compressed. This will increase 

processing time. 

yes, no no

preferred_publish_deliverable Drawing Set the default preferred deliverable for the Publish 

Context in Drawings. 

print, iges, set, dxf, 

step, cgm, pdf, dwg, 

tiff, medusa, stheno

print

preferred_save_as_type File Storage & 

Retrieval

Allows customizing the order of the Type selections 

found under File ->Save A Copy. 

  

prehighlight Environment Yes - Selectable items beneath the pointer are 

highlighted prior to being selected. No - Selectable items 

beneath the pointer are not highlighted prior to being 

selected. 

yes, no  

prehighlight_tree Environment Yes ? Selectable items in the model tree and layer tree 

are highlighted prior to being selected. 

yes, no no

preserve_comp_color_in_previ

ew

Assembly Yes - During component placement, component being 

assembled will retain its normal colors.No - During 

component placement, component being assembled is 

shown in preview color. 

no, yes no

prev_proc_comp_def_color Assembly Process Specify the default color for components added to a 

process assembly in a previous step. 

 0

prev_proc_comp_def_font Assembly Process Specify the default font for previously added 

components in a process assembly. 

  

prime_analysis_directory Without category Sets the default directory for the Prime files to be used 

for Prime analysis calculations. Use the full pathname to 

avoid problems. 

  

prime_automapping Without category Toggles Prime analysis automapping of variables yes, no no

pro_ansys_path Mechanica Specifies path to ANSYS executable.   
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pro_catalog_dir Casting & Mold 

Design

Sets the path to the catalog directory containing the 

catalog menu and the names of other catalog files, such 

as ejector pins. For example: pro_catalog_dir 

proe_loadpoint/apps_data/mold_data/catalog. Use full 

path name to avoid problems. 

  

pro_cav_lay_rule_dir Casting & Mold 

Design

Sets the default directory for cavity layout rules. Use the 

full path name to avoid problems. 

  

pro_cbltrm_dir Electromechanical Sets the directory from which terminators are retrieved. 

Use the full pathname to avoid problems. 

  

pro_colormap_path Colors Specifies the directory path for a color map (.map) file to 

be loaded from disk. Use the full path name to avoid 

problems. 

  

pro_crosshatch_dir File Storage & 

Retrieval

Specifies a default directory for your cross-hatch library 

in which you can save cross-hatching patterns for later 

retrieval. Its value is the full path name of the default 

directory. 

  

pro_dtl_setup_dir Drawing Sets the directory for the drawing setup files. If this 

option is not set, the system uses the default setup 

directory. 

  

pro_editor_command User Interface Enables use of an editor other than the system editor 

when the option editor has been specified as the value 

for the options part_table_editor or relation_file_editor. 

  

pro_font_dir File Storage & 

Retrieval

Sets the default font directory (Pro/ENGINEER will load 

all fonts in this directory into the drawing regardless of 

the contents of the system and working directories). 

 <proe_WF_5.0_loadpo

int>/text/fonts/

pro_format_dir Drawing Sets the default directory for the drawing format library. 

Use the full pathname to avoid problems. 

  

pro_gplug_dir Data Exchange Specifies the directory in which Granite application plug-

ins are located. Use the full pathname to avoid 

problems. 

 <proe_WF_5.0_loadpo

int>/sun_solaris_x64/g

plugs/

pro_group_dir Features Sets the default directory for the user-defined feature 

(UDF) library. If not specified, your current working 

directory is the default. Use the full pathname to avoid 

problems. 
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pro_insulation_dir Piping Specifies the directory to search for insulation files used 

in Pro/PIPING. Use full path name to avoid problems. 

  

pro_library_dir File Storage & 

Retrieval

Sets the default directory for the Pro/ENGINEER 

libraries (or any libraries you have built containing the 

proper index menu files). Use the full pathname to avoid 

problems. 

  

pro_material_dir File Storage & 

Retrieval

Sets the default directory for the part material library. 

Use the full pathname to avoid problems. 

  

pro_mdb_dir Manufacturing Sets the default directory for the Machinability Database 

(MDB) files. Use the full pathname to avoid problems. 

  

pro_mf_cl_dir Manufacturing Sets the default directory for the manufacturing CL data 

files.Use the full pathname to avoid problems. 

  

pro_mf_clamp_dir Manufacturing Specifies the directory where the manufacturing clamps 

can be found. 

  

pro_mf_param_dir Manufacturing Sets the default directory for the manufacturing 

parameter files. Use the full pathname to avoid 

problems. 

  

pro_mf_tape_dir Manufacturing Sets the default directory for the manufacturing TAPE 

data files.Use the full pathname to avoid problems. 

  

pro_mf_tprm_dir Manufacturing Sets the default directory for the manufacturing tool 

files. Use the full pathname to avoid problems. 

  

pro_mf_workcell_dir Manufacturing Sets the default directory for the manufacturing workcell 

files. Use the full pathname to avoid problems. 

  

pro_mfg_cmdsyn_dir Manufacturing Sets the default directory for the syntax menu files in 

Pro/MFG. Use the full pathname to avoid problems. 

  

pro_nastran_path Mechanica Specifies the path to the MSC/NASTRAN executable 

(nastran). 

  

pro_note_dir Drawing Specifies the directory from which to retrieve notes 

entered from a file. Use the full path name to avoid 

problems. 

  /work_dir/config_pro/

pro_palette_dir Drawing Sets the default directory for drawing symbol palette 

files. 

 <proe_WF_5.0_loadpo

int>/symbols/palette/
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pro_pip_fitt_dir Piping Specifies the directory to search for fittings used in 

Pro/PIPING. 

  

pro_pip_lnstk_dir Piping Specifies the directory to search for linestock files used 

in Pro/PIPING. Use full path name to avoid problems. 

  

pro_plot_config_dir Printing & Plotting Sets the directory of your user-defined plotter 

configuration file. Use the full pathname to avoid 

problems. 

  

pro_sheet_met_dir Sheetmetal Sets the default directory of your user-defined bend 

tables. If not set, the Pro/SHEETMETAL supplied bend 

tables are used. Use the full path name to avoid 

problems. 

  

pro_smt_params_dir Sheetmetal Specifies the directory to save/retrieve Sheet metal 

parameters files.Use full path name to avoid problems. 

  

pro_solver_name Mechanica Specifies the name of the user-defined solver to be 

included in the SOLVE menu. See also pro_solver_path. 

  

pro_solver_path Mechanica Specifies the path to the user-defined solver whose 

name is defined in the SOLVE menu. See also 

pro_solver_name 

  

pro_spool_dir Electromechanical Sets the directory from which spools are retrieved. Use 

the full pathname to avoid problems. 

  /work_dir/config_pro/

pro_stheno_command Data Exchange Specifies the command for Stheno launch.   

pro_surface_finish_dir File Storage & 

Retrieval

Sets the default directory for your user-defined surface 

finish symbols. Use the full pathname to avoid 

problems. 

 <proe_WF_5.0_loadpo

int>/symbols/surffins/

pro_symbol_dir Drawing Set and automatically create the default directory for 

saving and retrieving user-defined symbols. If you do 

not specify a directory, the system uses the current 

working directory. Use full path name to avoid problems. 

  /work_dir/config_pro/

pro_texture_library Photorender Allows the user to specify a different graphics library.   

pro_unit_length Environment Sets the default units for new objects. unit_inch, unit_foot, 

unit_mm, unit_cm, 

unit_m

unit_inch
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pro_unit_mass Environment Sets the default units for mass for new objects. unit_ounce, 

unit_pound, 

unit_ton, unit_gram, 

unit_kilogram, 

unit_tonne

unit_pound

pro_unit_sys Environment Specifies the default system of units for new models. mks, cgs, mmns, 

fps, ips, proe_def, 

mmks

 

pro_weld_params_dir Weld Specifies the directory to search when a weld parameter 

file is needed. 

  

prodevdat Application 

Programming 

Interfaces

Specify the name of the Pro/Develop registry file.   

proe_memory_buffer_size Environment Specify the size in megabytes of the memory buffer to 

be reserved by Pro/ENGINEER for system out of 

memory condition. You must restart Pro/ENGINEER for 

the change to take effect. 

 50

profile_output_utils Manufacturing Affects CL-Data output for profile milling sequences. 

Yes - Sequence parameter output_point is available with 

options: tip - Toolpath is output with respect to the tool 

center; on_profile - Toolpath is output with respect to the 

profile of the tool. 

yes, no no

prompt_on_erase_not_disp File Storage & 

Retrieval

Specifies whether or not to display a prompt allowing 

you to save your undisplayed objects. This option is 

used in conjunction with the Erase > Not Displayed 

command on the File menu. 

yes, no no

prompt_on_exit User Interface Determines if you are prompted to save objects when 

exiting a Pro/ENGINEER session. 

yes, no no

proncpost_dbf Manufacturing Enter directory path to NCPost database file.   

propagate_change_to_parents File Storage & 

Retrieval

When saving objects with option save_objects set to 

Changed or Changed_and_specified, Pro/ENGINEER 

verifies which models are. Yes - Any model that is a 

parent of a changed model is considered to be a 

changed model when determining what to save. 

yes, no no

propagate_inactive_annotation User Interface Yes - causes the propagation of inactive annotation. no, yes yes
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prorembatch_queue_manager Manufacturing Enables toolpath computation on a separate host 

machine. Required values are Processor name, Remote 

machine's hostname, Type of transport (always 0), RPC 

processor number (same as that of remote processor), 

Version of queue manager. 

  

protable_in_background System Yes - Starts Pro/TABLE editor in the background. 

Reduces time between pressing a menu button that 

uses Pro/TABLE and entering the data. 

no, yes yes

protkdat Application 

Programming 

Interfaces

Specify the Pro/TOOLKIT registry file.   

provide_pick_message_always User Interface No - A message describing the (pre)selected item is 

provided only while querying. Yes - A message 

describing the selected item is provided in all cases (i.e. 

even when Query is not used). 

yes, no no

ps_output_with_pagesize Printing & Plotting Specifies whether or not to include pagesize information 

when generating postscript files from Pro/ENGINEER. 

No - Pro/ENGINEER will omit Adobe level 2 pagesize 

information from the header of the postscript file. 

yes, no yes

ptc_manikin_library_path Without category Sets the default directory for the Pro/ENGINEER 

manikin library (or custom manikin libraries you built 

containing the proper index menu files). Use the full 

path name to avoid problems. 

 <proe_WF_5.0_loadpo

int>/manikin_lite/

ptc_manikin_posture_path Without category Sets the default directory for the Pro/ENGINEER 

manikin postures (or custom posture libraries you built). 

Use the full path name to avoid problems. 

  

ptncpost_dbf Manufacturing Enter directory path to NCPost database file.   

punch_axis_points Sheetmetal Yes - Enables the creation of punch axis points in 

Sheetmetal cuts and punches. 

yes, no no

punch_models_directory Sheetmetal Sets path to directory that contains the punch models.   

put_iges_drawing_entity Data Exchange Specifies whether or not to suppress the output of the 

IGES drawing entity, #404, to the IGES file. No - The 

drawing entity is not output. 

yes, no yes

qty_balloon_change_warning Without category Sets the warning style when quantity balloons have 

changed in a drawing.Dialog displays the warning in a 

dialog box, Message displays the warning in the 

message area only. 

dialog, message dialog
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quick_print_drawing_template Without category Specify the path and name of a drawing template to be 

used by the File > Quick Print command. 

  

quick_print_plotter_config_file Without category Specify the path and name of the default plotter config 

file to be used by the File > Quick Print command. 

  

radial_hole_linear_dim Without category YES - Option for creation of radial hole with a linear 

dimension will be available. 

yes, no no

raster_plot_dpi Printing & Plotting Determines the resolution for plotter outputs variables 

are in dots per inch. 

100, 200, 300, 400 100

ratio_grid_interval Features Modify grid space in percentage units for handle 

movement. 

 0.05

read_famtab_file_on_retrieve File Storage & 

Retrieval

No - Ignores filename.ptd. Yes - Creates and saves 

filename.ptd and uses that file when retrieving the 

generic. 

no, yes no

read_parameters_of_excluded Data Management Allow Pro/ENGINEER designated parameters on 

excluded objects in Simplified Representation to be 

visible in Model Tree columns. 

yes, no no

real_time_rendering_display Model Display Disable realtime rendering. disable, 

transparent_floor, 

room_display

disable

recompute_iges_dim_value Data Exchange Indicates whether to recompute associative dimensions 

upon import of an IGES file. 

yes, no no

ref_scope_copy_color Without category Set the color of backed up references according to RGB 

values. Enter RGB values between 0 and 100 separated 

by space. 

 55

ref_scope_copy_color_change Without category Enable changing colors of backuped references during 

selection. 

no, yes yes

ref_scope_no_pick_to_copy Without category Disable selecting references backuped by references 

control. 

no, yes no

ref_scope_no_pick_to_prohibit Without category Disable selecting references prohibited by references 

control. 

no, yes yes

ref_scope_prohibit_color Without category Set the color of prohibited references according to RGB 

values. Enter RGB values between 0 and 100 separated 

by space. 

 45

ref_scope_prohibit_color_chan

ge

Without category Enable changing colors of prohibited references during 

selection. 

no, yes yes
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regen_backup_directory Environment Specifies the directory in which the system stores 

regen_backup models. (See 

regen_backup_using_disk.) The primary default is the 

current directory, but if that directory is read-only, the 

secondary default is the /tmp directory. 

  

regen_backup_using_disk Environment Specifies whether or not the system backs up the 

current model to disk before each regeneration. 

yes, no no

regen_failure_handling Without category Specifies whether to enter resolve mode when 

regeneration failures occur.Resolve_mode - Enter 

resolve mode when regeneration failures occur. 

No_resolve_mode - Don't enter resolve mode when 

regeneration failures occur. 

resolve_mode, 

no_resolve_mode

no_resolve_mode

regen_int_mdls_on_retr Without category Yes to regen models intersected with assem feats 

during assembly retrieval. 

yes, no no

regen_layout_w_assem Assembly Specifies whether or not the layout will be automatically 

regenerated upon assembly regeneration. 

yes, no yes

regen_simp_retrieve File Storage & 

Retrieval

Regenerate the assembly when retrieving an assembly 

simplified representation. Yes - Regenerates the 

assembly on retreival.No - The assembly is not 

regenerated on retrieval. 

yes, no no

regenerate_read_only_objects Data Management Determines whether an object retrieved from PDM 

database with read only status can be regenerated in a 

Pro/ENGINEER session. 

yes, no yes

relation_file_editor User Interface Sets the editor used to edit relations. protab, editor editor

relation_text_trail_output Miscellaneous No - Disable trail output from Text layout in Relation 

Parameter UI if it hasn't been changed. 

yes, no yes

relation_tool_mapkey_behavior Miscellaneous Will control how mapkeys will be executed in relation 

tool / dialog.Incremental will add/remove text 

incrementally to the current set.Full_output will record 

the original set state and replace the current one with it. 

Note: this config is dependent on 

relation_text_trail_output. 

increment, 

full_output

increment

relations_num_const_units Without category Specifies whether diagnostic should be issued when an 

unitless numeric value causes relation expression 

evaluation trouble. 

yes, no no
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relations_units_sensitive Without category Set the default unit sensitivity (ignore or take into 

account parameter/dimensions units) in creation of new 

relation data (legacy relation data will not be unit 

sensitive until "converted" to one). 

yes, no yes

remember_last_attach_type Without category Yes - Sets the default of the ATTACH TYPE menu of 

the last options picked. 

yes, no yes

remember_last_get_point_opti

on

Drawing Yes - Sets the default of the GET POINT menu as the 

last option picked among Pick Pnt, Vertex and On 

Entity. 

yes, no no

remember_replaced_compone

nts

Without category Set to "Yes" this option will preserve a dependency to 

the replaced, outgoing, component. Set to "No" the 

dependency will, when possible, be removed. 

yes, no yes

rename_drawings_with_object File Storage & 

Retrieval

Controls whether the system copies associated 

drawings automatically with parts and assemblies. 

none, part, assem, 

both

none

replace_comp_name_method Assembly Sets the naming convention used when replacing 

components. 

transfer, remove, 

preserve

transfer

replace_comp_notes_method Without category Specify treatment of notes when components are 

replaced. Transfer - transfer to new component. 

Remove - remove the notes. Preserve - save notes in 

case component is restored. 

transfer, remove, 

preserve

transfer

replace_history_rule_order Assembly Set the default order of the history evaluation rule in the 

replace operation. Disable - the evaluation rule will be 

disabled by default. Number - set the order of the rule 

relative to other evaluation rules. 

disable, 1, 2, 3, 4, 5 3

replace_interface_rule_order Assembly Set the default order of the interface evaluation rule in 

the replace operation. Disable - the evaluation rule will 

be disabled by default. Number - set the order of the 

rule relative to other evaluation rules. 

disable, 1, 2, 3, 4, 5 1

replace_sameid_rule_order Assembly Set the default order of the same id evaluation rule in 

the replace operation. Disable - the evaluation rule will 

be disabled by default. Number - set the order of the 

rule relative to other evaluation rules. 

disable, 1, 2, 3, 4, 5 5

replace_samename_rule_order Assembly Set the default order of the same name evaluation rule 

in the replace operation. Disable - the evaluation rule will 

be disabled by default. Number - set the order of the 

rule relative to other evaluation rules. 

disable, 1, 2, 3, 4, 5 2
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replace_sameparam_rule_orde

r

Assembly Set the default order of the same parameters evaluation 

rule in the replace operation. Disable - the evaluation 

rule will be disabled by default. Number - set the order 

of the rule relative to other evaluation rules. 

disable, 1, 2, 3, 4, 5 4

replace_unrelated_automatic Assembly Availability of automatic reference pairing in unrelated 

replace. No - Automatic reference pairing is not 

available. Yes - Automatic reference pairing is available. 

yes, no no

report_end_splice Electromechanical Setup whether the terminal splices of cables are 

reported. 

yes, no no

reserved_menu_space User Interface Reserves space for extra menus to the right of the 

Pro/ENGINEER window (0.0-4.0). This option overrides 

windows_scale. 

 1

restricted_gtol_dialog Dimensions & 

Tolerances

Determines whether the Geometric Tolerance dialog 

restricts the user by graying out elements that are 

considered "illegal". 

yes, no yes

restricted_val_definition Without category Specify name and path of the file contained restricted 

values definition. 

  

retain_display_memory File Storage & 

Retrieval

Determines if the display of an object currently on the 

screen is kept in memory when you quit the window. 

Doing so (yes) makes the retrieval of objects in memory 

faster. 

yes, no yes

retrieve_data_sharing_ref_part

s

File Storage & 

Retrieval

Automatic reference parts retrieval for dependent data 

sharing features. 

yes, no, 

ignore_missing

no

retrieve_display Without category Controls whether or not graphics data is loaded in the 

background. 

background, 

foreground

background

retrieve_instance_dependencie

s

Assembly Determines whether to retrieve the dependencies of the 

generic when an instance is retrieved. 

instance_deps_only, 

instance_and_generi

c_deps, 

instance_req_generi

c

instance_req_generic

retrieve_merge_ref_parts Without category Automatic reference parts retrieval for dependent 

Merge. 

yes, no, 

ignore_missing

no

reverse_spiral_finish_type Without category If the option value is 1, the tool path is obtained from 

standard one by reversing it; if the option value is 2, the 

tool path starts from an inner circle. 
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ribbon_cable_flat_direction Electromechanical Flat ribbon cables in the y-axis of entry ports. y_axis, x_axis y_axis

right_mouse_button_popup User Interface Specify whether or not the right mouse button pop up 

menu is available or not. 

yes, no yes

room_rotation_lock Photorender Default room rotation setting at session start.studio - 

Lock room rotation to studio.model - Lock room rotation 

to model. 

studio, model studio

rotate_postscript_print Printing & Plotting Specifies rotation for printing. Yes - Rotates a PostScript 

plot 90 degrees counterclockwise. Use when you are 

plotting a landscape drawing on a portrait-type laser 

printer, or a portrait drawing on a landscape-type laser 

printer. 

yes, no  

round_displayed_dim_values Dimensions & 

Tolerances

No - newly created or first shown dimension is displayed 

with all its significant decimals."Rounded Dimension 

Value" Check Box will be unchecked while opening 

Dimension Properties Dialog. Yes - number of decimals 

is rounded according to default dec places 

option."Rounded Dimension Value" Check Box will be 

checked while openingDimension Properties 

Dialog.			) 

yes, no yes

rv_current_object Assembly Will control default option when setting a model or 

component as the current object. 

component, model, 

component + model

component

rv_search_scope Assembly Sets the search scope for children when entering the 

reference viewer. Session - Search all objects in 

session. Window - Search objects in the active window 

only. 

session, window session

save_bitmap Data Management When performing a save on a model, determines what 

level of the assembly will have bitmap images created of 

modified components. 

none, toplevelonly, 

alllevels

none

save_bitmap_type Data Management When performing a save on a model, determines the 

type of image file that is created for that model. Used 

with "save_bitmap" option. 

bmp, tiff, gif, cgm, 

jpeg

bmp

save_clipped_view File Storage & 

Retrieval

Yes - clipping status is saved with model. No - clipping 

status is not saved. 

yes, no no

save_dialog_for_existing_mod

els

File Storage & 

Retrieval

Controls whether the Save dialog is shown for models 

whose storage location is already known. 

yes, no yes
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save_display Drawing Yes - Stores view geometry and detail items such as 

solid dimensions. These items are displayed when 

retrieving the drawing in View-Only mode. 

no, yes no

save_display_status_in_submo

del

Layers If set to no, the top level assembly will store sub model 

layer display status, allowing lower level display status to 

be stored without having to save the sub models. 

yes, no yes

save_drawing_picture_file Drawing Embed - Embeds a picture file inside a drawing for 

preview purposes. Export - Saves a drawing file as a 

picture file in the working directory when saving a 

drawing. Both - Does both embed and export. 

no, export, embed, 

both

embed

save_hidden_items_w_status Without category The items on the "Hidden Items" temporary layer are 

stored permanently when layer display status is saved 

with Save Status command. 

yes, no yes

save_instance_accelerator File Storage & 

Retrieval

With family tables of solid parts, determines saving 

instance accelerators. None - Accelerator files not used. 

Explicit - Save when instance is explicitly saved. Saved 

objects - Save when objects were modified. Always - 

Always save. 

none, explicit, 

always, 

saved_objects

saved_objects

save_model_display File Storage & 

Retrieval

Sets amount of graphical data stored. Wireframe - 

Wireframe data. Shading_high - Most detail (shaded). 

Shading_low - Least detail (shaded). Shading_lod - 

Detail determined by ViewPerformance dialog (shaded). 

wireframe, 

shading_low, 

shading_high, 

shading_lod

shading_lod

save_modified_draw_models_

only

Drawing Determines whether the system saves the model after 

you have changed it. No - Saves the model every time 

that you store the drawing. 

no, yes yes

save_object_in_current File Storage & 

Retrieval

Use with the override_store_back option. Yes - Objects 

retrieved from a directory where you do not have write 

permission will be stored in the current directory. No - 

These objects are not saved at all. 

yes, no no

save_objects File Storage & 

Retrieval

Determines when an object and its dependent objects 

(such as a part used in an assembly) are stored. 

all, changed, 

changed_and_specif

ied, 

changed_and_updat

ed

changed_and_specifie

d
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save_scene_with_file Photorender Yes - Automatically update the model with current scene 

information when saving the model; No - Scene 

information embedded in model must be updated 

manually. 

yes, no no

save_texture_with_model Photorender Yes - Embed applied texture and tracesketch bitmap 

files into the model file. 

yes, no no

save_triangles_flag Model Display Spinning shaded images with software graphics 

only.Note: This option has no effect if your system uses 

hardware graphics. 

no, yes no

save_unchanged_pdm_object Data Management Determines how to save in the current working directory 

an object fetched from a Pro/PDM database into a 

Pro/ENGINEER session. 

as_ref, as_copy as_ref

saveunders_enabled System Yes - Enables Pro/ENGINEER popup helptext and 

menus to retain the portion of the window they obscure 

to be used to restore the window image when they are 

dismissed. 

yes, no yes

saving_model_thumbnails File Storage & 

Retrieval

Enables saving of model thumbnails. yes, no yes

scope_invalid_refs Without category Prohibit - System will abort all attempts to create 

external reference violating the scope. Backup - 

Warning appears. Abort reference creation or declare 

as out-of-scope reference. If you declare, backup copies 

to part/assembly and backup is referenced. 

copy, prohibit copy

search_not_retrieved_models Assembly Expands search to include models that have not been 

retrieved into session. If Yes, models will be brought into 

session possibly causing performance issues. 

yes, no yes

search_path File Storage & 

Retrieval

Specifies list of directories to search (in order) for 

object/file retrieval. These directories, the working 

directory, and directories in search.pro file (refer to 

search_path_file) are Pro/ENGINEER's search path. 

Use full path name to avoid problems. 

  

search_path_file File Storage & 

Retrieval

Specifies path to text file search.pro (a list of directory 

path names). The directories listed in search.pro, the 

working directory, and directories specified by 

search_path are Pro/ENGINEER's search path. Use full 

path name to avoid problems. 

  

Parametric Technology Corporation 74 Pro/ENGINEER Wildfire 5.0 Configuration Options



Name Category Description Values Default Value

section_color Sketcher Specifies the color of sketched sections. default, 

sketch_color, 

drawing_color

 

sel_insts_on_comp_retrieval Assembly Yes - If the components used in the assembly instances 

are themselves generics, the systems asks if you want 

to choose an instance as each component is retrieved. 

No - The generic model of the component is retrieved 

automatically. 

yes, no no

select_hidden_edges_in_dwg Drawing Controls selectability of hidden edges in no-hidden 

drawing views. 

yes, no yes

select_on_dtm_edges Environment All_modes - Select a datum plane by clicking on its 

visual boundary. Sketcher_only - Select a datum plane 

by clicking on its tag in modes other than Sketcher. If 

you use Query frequently, set this option to 

Sketcher_only. 

all_modes, 

sketcher_only

all_modes

selection_of_removed_entities Drawing Yes - Entities in front of cross-section (planar or offset) 

can be selected, clipped (using Z-clipping), or erased 

with EDGE DISP menu. No - Geometry, datum points or 

curves, cosmetic features, threads, grooves, or 

coordinate systems cannot be erased. 

yes, no no

set_menu_width User Interface Determines width of menu manager panels. Default 

value is equivalent to 8 character widths. Acceptable 

range is from 8 to 20. Values lower than 8 and higher 

than 20 are ignored. 

 -1

set_model_types_to_save File Storage & 

Retrieval

Determines which model types are used in the Save 

Changed command. The format is a list of extensions 

separated by spaces. 

 asm

set_trail_single_step System Yes - Enables a trail file to be single-stepped by entering 

. 

yes, no no

shade_mfg_ref_models Manufacturing No - Does not process reference parts when generating 

the shaded image (to save time). Yes - Shades 

reference parts when generating shaded images. 

no, yes yes

shade_moving_comp Model Display Yes - Shades assembly components while they are 

being moved. No - Displays components in wireframe 

while they are being moved. 

yes, no yes
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shade_quality Model Display Model shade quality is used to decide how much to 

subdivide surfaces forshading purposes. Higher shade 

quality is slower but produces better pictures. 

3, 1, 2, 4, 5, 6, 7, 8, 

9, 10

3

shade_surface_feat Model Display Controls the shading of surface features. yes, no yes

shade_windows Model Display Enables shading of objects in all windows. This option 

does not also enable color shading. 

all_windows, 

one_window

all_windows

shade_with Model Display Controls the display of datum curves on shaded objects. curves, no curves

shaded_postscript_background Printing & Plotting Specifies how background colors are handled in 

Postscript files of shaded objects. 

yes, no no

show_all_mold_layout_buttons Casting & Mold 

Design

Sets all mold layout buttons visible. yes, no no

show_annotations_dialog_limit Drawing Default value for Annotations dialog box.   

show_axes_for_extr_arcs Model Display Determines if axes are created for newly extruded arcs. yes, no no

show_cav_fit_loc_sys Miscellaneous Allows the printing of the transformation matrix of a 

Pro/Verify Fit into a file. 

yes, no no

show_description_view_mgr Without category Yes - show a column for Description field for all tabs in 

view manager. 

yes, no no

show_dim_sign Environment No - Dimension values always appear positive. Negative 

value creates geometry to opposite side. Yes - Entering 

negative value for dim displayed as negative creates 

geometry to same side. Dims for csys and datum point 

offsets always show neg/pos value. 

yes, no no

show_geom_checks_on_creati

on

Features Yes - The SHOW ERRORS menu appears at the end of 

feature creation when the feature being created has 

Geometry Checks. 

yes, no no

show_preview_default Drawing This option determines the default behavior for preview 

in Show/Erase. 

keep, remove remove

show_selected_item_id Environment Show id of Pro/E and Sketcher geometry in query 

selection bin, collector and tool tip. 

no, yes no

show_shaded_edges Model Display Controls the edge color when shading. Yes - Edges are 

displayed in darker color than the surfaces to which they 

belong. No - Edges are displayed in the same color as 

the surfaces to which they belong. 

no, yes no
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shrinkage_value_display Casting & Mold 

Design

Determines how dimensions are displayed when 

shrinkage is applied to a model with Pro/MOLDESIGN. 

Percent_shrink - Dimensions appear with the shrinkage 

percent. 

final_value, 

percent_shrink

percent_shrink

shrinkwrap_alert Assembly Displays the Shrinkwrap alert the first time the quality 

level is increased. 

yes, no yes

sim_additive_mass Mechanica Treats Mass Idealizations as additive if they are applied 

to the same entity and suppresses Mass precedence 

rules. 

yes, no no

sim_agem_edge_by_crv_defau

lt

Mechanica Sets the default value for the ratio of Edge Length / 

Radius of curvature. 

 2

sim_agem_edge_crv Mechanica Sets the value for the target ratio of Edge Length / 

Radius of curvaturefor automatic creation of a global 

AutoGEM Control. 

 0

sim_agem_model_thickness Mechanica Set the value to the part thickness. This causes 

AutoGEM to perform more boundary refinement, and 

can be very useful for thinner parts. 

 -1

sim_auto_map_max_angle Mechanica Sets the default maximum angle tolerance for auto-

mapping of pressure load. The valid range is from 0 to 

90 degrees. 

 10

sim_auto_map_max_dist Mechanica Sets the default maximum distance tolerance (relative to 

model size) for auto-mapping of pressure load. The 

default value is 0.0012. 

 0.0012

sim_auto_pairing_thickness Mechanica Set the value of characteristic thickness for auto-

detection of shell pairs. Using this as a threshold value, 

auto-detection will find surface pairs with thickness 

smaller than this value. 

 0

sim_auto_regen_enabled Mechanica Yes - Regenerate model on entrance to Mechanica. No - 

Don't regenerate the model. 

yes, no yes

sim_beamsection_path Mechanica Specifies the path where the Beam Sections will be 

stored. 

  

sim_calculate_node_reaction Mechanica Enables node reaction calculations for point constraints 

within links. The default value is NO. 

yes, no no
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sim_check_jacobian_corners Mechanica No - Suppress Jacobian checks at corner nodes. 

ANSYS and Nastran checks parabolic elements 

Jacobian at the integration points only and FEM will fix 

too curved elements for the same criterion. Yes - 

Jacobian is checked both at integration points and 

corner nodes. FEM mode will fix too curved elements 

accordingly. 

yes, no no

sim_display_agem_controls Mechanica Toggles display of AutoGEM Controls. yes, no  

sim_display_arrow_scale Mechanica Toggles automatic arrow scaling. yes, no  

sim_display_arrow_tail_touchin

g

Mechanica Toggles display of Load arrows to have tails or heads 

touching. 

yes, no  

sim_display_beam_releases Mechanica Toggles display of Beam Release icons. yes, no  

sim_display_beam_sections Mechanica Toggles display of beam section icons. yes, no  

sim_display_beams Mechanica Toggles display of beam icons. no, yes  

sim_display_contacts Mechanica Toggles display of contact icons. no, yes  

sim_display_current_csys_triad Without category Toggles display of the current coordinate system triad in 

the lower right corner of the window. 

yes, no  

sim_display_fasteners Mechanica Toggles display of Fastener icons. yes, no  

sim_display_highlight_refs Mechanica Yes -Geometrical references are highlighed when 

selecting a load/constraint. 

yes, no  

sim_display_in_spin Mechanica Toggles display of simulation objects in Dynamic Spin. yes, no  

sim_display_interfaces Without category Toggles display of structure connection icons. no, yes  

sim_display_internal_mesh_ed

ges

Mechanica Specifies whether internal edges of mesh elements 

should be displayed in the wireframe mode. The default 

is "No". 

yes, no no

sim_display_load_colors Mechanica Toggles display of Load colors. yes, no  

sim_display_load_distribution Mechanica Toggles display of distributed load vectors over entire 

entity. 

yes, no  

sim_display_load_icons Mechanica Toggles display of load icons. yes, no  

sim_display_load_name Mechanica Yes - The load/constraint name appears in the label. yes, no  

sim_display_load_value Mechanica Toggles display of Load values. yes, no  

sim_display_loads_from_comp

s

Mechanica Toggles display of loads and constraints defined on 

lower-level components of assembly. 

yes, no  

sim_display_masses Mechanica Toggles display of mass icons. no, yes  
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sim_display_matl_assignments Mechanica Toggles display of Material Assignment icons. yes, no  

sim_display_measures Mechanica Toggles display of Simulation Measure icons. yes, no  

sim_display_mesh_and_model Mechanica Toggles display of Mesh together with Model. yes, no  

sim_display_mesh_control_na

me

Mechanica Yes - The Mesh/AutoGEM control name appears in the 

label. 

yes, no  

sim_display_mesh_control_val

ue

Mechanica Yes - The Mesh/AutoGEM control value appears in the 

label. 

yes, no  

sim_display_mesh_controls Mechanica Toggles display of Mesh Controls. yes, no  

sim_display_mesh_entities Mechanica Toggles display of Mesh entities. yes, no  

sim_display_mesh_mode Mechanica Specifies the mode of mesh display in FEM 

preprocessor. Values: NO_MESH, WIREFRAME, 

HIDDEN, NOHIDDEN, SHADING. 

no_mesh, 

wireframe, hidden, 

nohidden, shading

 

sim_display_mesh_quality Mechanica Specifies the quality of mesh display in Mechanica. 

Values: FINE, MEDIUM, COARSE. 

fine, medium, 

coarse

 

sim_display_mesh_shells_thic

k

Mechanica Toggles the display of shell thickness in Mechanica 

mesh. YES - Display shells with real thickness. NO - 

Display shells with zero thickness. 

no, yes  

sim_display_mesh_shrink_ele

ms

Mechanica Controls display of Mesh through a specified percentage 

of shrinking of its elements. 

 -1

sim_display_model_type Mechanica Toggles the display of the Simulation model setup in the 

lower left corner of Pro/E screen. 

yes, no yes

sim_display_names Mechanica Toggles display of Simulation Object names. yes, no  

sim_display_rigid_dof Mechanica Toggles display of Rigid Link DOF icons. yes, no  

sim_display_rigid_links Mechanica Toggles display of Rigid Link icons. yes, no  

sim_display_shell_pairs Without category Toggles the display of shell pairs. no, yes  

sim_display_shells Mechanica Toggles display of shell icons. no, yes  

sim_display_springs Mechanica Toggles display of spring icons. no, yes  

sim_display_struct_constraints Mechanica Toggles display of structure constraint icons. yes, no  

sim_display_struct_loads Mechanica Toggles display of structure load icons. yes, no  

sim_display_therm_bcs Mechanica Toggles display of Thermal Boundary Condition icons. yes, no  

sim_display_therm_loads Mechanica Toggles display of thermal load icons. yes, no  

sim_display_weighted_dof Mechanica Toggles display of Weighted Link DOF icons. yes, no  

sim_display_weighted_links Mechanica Toggles display of Weighted Link icons. yes, no  
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sim_display_welds Mechanica Toggles display of Weld icons. yes, no  

sim_display_z_buffered Without category Toggles z-buffered display of Mechanica icons. yes, no  

sim_expanded_diagnostics Mechanica Yes - Mechanica will perform an expanded set of 

diagnostic checks during meshing a model or running 

an analysis. These include checks for interferences in 

an assembly and for singular geometry. No - Mechanica 

will not perform expanded checks. 

yes, no no

sim_ext_distribution_dir Without category Specifies the location of external distribution files for 

loads. 

  

sim_extend_surf_max_angle Mechanica Controls the maximum angle between a surface to be 

extended during shell compression and its adjacent 

surfaces. If the angle is higher than specified, the 

adjacent surfaces is extended. The default is 30 

degrees. The range is from 0 to 90 degrees. 

 30

sim_fatigue_biaxiality_correct Mechanica Controls the use of biaxiality correction. The default 

value is YES. 

yes, no yes

sim_fatigue_biaxiality_method Mechanica Controls which method is used to model biaxiality: Klann-

Tipton-Cordes, Hoffman-Seeger, or the most 

conservative (worst) of the two methods. The default 

value is WORST. 

worst, ktc, hs worst

sim_fatigue_confidence_level Mechanica Specifies the percentage confidence in the predicted life 

result value. The default value is 90, and range is from 

0.1 to 99.9 

 90

sim_fatigue_external_matdata Mechanica Controls the use of external material data. The default 

value is NO. 

no, yes no

sim_fatigue_hysteresis_gate Mechanica Specifies the gate applied to cycle counting as a 

percentage of peak load. The default value is 1 and 

range is from 0 to 50. 

 1

sim_fatigue_infinite_life_value Mechanica Specifies the value for the lives beyond cutoff. The 

default value is 1e20 and range is from 1e15 to 1e30. 

 1E+20

sim_fatigue_mean_stress Mechanica Controls the application of the mean stress correction. 

The default value is YES. 

yes, no yes

sim_fatigue_mean_stress_met

hod

Mechanica Controls which method is used to model mean stress: 

the Smith-Watson-Topper Approach, Morrow 

Correction, or the most conservative (worst) of the two 

methods. The default value is WORST. 

worst, swt, morrow worst

Parametric Technology Corporation 80 Pro/ENGINEER Wildfire 5.0 Configuration Options



Name Category Description Values Default Value

sim_fatigue_safety_margin Mechanica Specifies a factor used to determine the Life Confidence 

quantity. The default value is 3 and range is from 1.1 to 

100. 

 3

sim_fatigue_user_directory Mechanica Specifies the directory for user files (for example, 

external material files). The default value is the current 

directory. 

  

sim_fatigue_write_surf_stress Mechanica Controls writing of surface stresses to a neutral file. The 

default value is NO. 

no, yes no

sim_fem_nastran_use_pshell Mechanica Yes - use PSHELL cards, No - use PCOMP cards for 

laminate composite shells in NASTRAN output file. 

yes, no no

sim_html_report_prefs_file Mechanica Specifies the path to the Simulation post processor 

HTML report preferences file. 

  

sim_hyperelastic_material_fit Mechanica Sets the default method for calculating coefficients for 

hyperelastic materials. If set to "normalized", normalized 

stresses will be used. If set to "non-normalized", non-

normalized stresses will be used.) 

normalized, non-

normalized

normalized

sim_icon_distribution_density Mechanica Determines how many icons are drawn for a distribution. 

1 is fewer, 10 is the highest. 

 -1

sim_ignore_unpaired Mechanica Yes - Unpaired surfaces are ignored when meshing the 

model, placing you directly into the AFTER COMP menu 

(the CONT MESH menu is skipped). 

yes, no no

sim_invoke_diagnostics_on_ru

n

Mechanica Sets the default for the display of diagnostics during the 

run of an analysis in Mechanica Native mode. If set to 

prompt, the user is prompted to rundiagnostics every 

time he/she starts a run. 

yes, no, prompt prompt

sim_load_mech_mesh Mechanica No - The user is prompted to load the existing 

Mechanica mesh file from the current working directory. 

Yes - The mesh file, if exists, is loaded automatically 

and the mesh is displayed. 

no, yes no

sim_loadpreview Mechanica Sets the type of load preview: vectors, fringe or mesh. vectors, fringe, 

mesh

fringe

sim_mat_poissons_notation Mechanica Specifies the convention used for defining Poisson's 

ratio for anisotropic materials as being either Tsai 

(Column-normalized) or Jones (Row-normalized). This 

option affects only the labels for Poisson's ratio on the 

Material data form. 

tsai, jones tsai

sim_max_contact_iterations Mechanica Specify the maximum number of iterations for contact 

analysis. The default is 200. 

 200
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sim_max_memory_usage Mechanica Specifies the maximum amount of memory in 

megabytes to be allocated during FEM meshing. If this 

option is not set, or set to zero, the mesher can use all 

available memory. 

  

sim_nastran_use_coupmass Without category Add PARAM,COUPMASS,1 in the Nastran deck file to 

enforce consistent mass matrix generation. 

yes, no no

sim_output_ids_for_layers Mechanica Outputs FEM mesh element IDs on each layer into XML 

file. 

yes, no no

sim_output_obj_names Without category Output Beam Sections names, Analyses names, 

Coordinate Systems names as comments. 

yes, no no

sim_pp_background_color Mechanica Specifies the background color of the work area for the 

results display. The default value is PROE. 

proe, blue, black, 

white

proe

sim_pp_display_beam_thickne

ss

Mechanica Sets the thickness for beams and 2D-shells display in 

Post Processor. Numerical values specify the thickness 

in pixels. 

actual, 1, 2, 3, 4, 5 5

sim_pp_display_spin_center Mechanica Sets the default for the behavior of mouse spinning the 

model in results. 

yes, no yes

sim_pp_legacy_selection Mechanica Enable legacy selection of geometrical entities from 

Mechanica postprocessor on Mechanica geometry. 

no, yes no

sim_pp_legend_continuous Mechanica Determines if the legend will be continuous tone (YES) 

or discrete colors (NO). 

yes, no no

sim_pp_legend_levels Mechanica The default number of legend levels (from 1 to 16; the 

default is 9). 

 9

sim_pp_legend_show Mechanica If set to NO, the legend is not displayed in newly created 

results windows by default. 

yes, no yes

sim_pp_legend_show_min_ma

x

Mechanica If set to NO, the gray minimum and maximum values 

are not displayed by default in the legend. 

yes, no yes

sim_pp_legend_spectrum Mechanica This string sets the default color legend used in the 

definition of a results window. This file will be looked up 

in the sim_pp_template_dir location, or, if this is not 

specified, in the current working directory. 

  

sim_pp_path_absolute Mechanica Choose Absolute (Yes) or Relative (No) path to "rwd" 

file. 

yes, no no

sim_pp_query_location Mechanica Sets the default value for the display of the WCS 

location in dynamic query in results. 

yes, no no

sim_pp_show_cap_cut_outline Mechanica Enables to hide the model outline in capping/cutting 

surface display. 

yes, no yes

sim_pp_template_dir Mechanica Sets the default directory for results template files.   
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sim_pp_vector_plot_arrow_2d Mechanica To draw 2D arrows instead of 3D arrows while post-

processing vector results. It is useful when system 

memory is not sufficient to display3D vector arrows. 

yes, no no

sim_pp_vrml_export_format Mechanica Flags to denote VRML1.0 or VRML2.0 (default) output. vrml2.0, vrml1.0 vrml2.0

sim_pp_vrml_feature_edges Mechanica Flag to enable the inclusion of feature edges in the 

VRML file. The default value is NO. 

no, yes no

sim_reentrant_geom_angle Mechanica Sets the default value for reentrant geometry detection 

in both Isolation for Exclusion AutoGEM Control and 

expanded diagnostics checks. The valid range is from 0 

to 180 degrees. The default is 120 degrees. 

 120

sim_remove_unopposed Mechanica Yes - The system ignores unopposed surfaces when 

meshing the model; the system also deselects the 

UseUnopposed option. No - the system uses the 

unopposed surfaces in the shell model. 

yes, no no

sim_run_num_threads Without category Controls the number of CPUs that Mechanica Native 

mode will use for running the analysis. The possible 

values are: ALL (default), ALL_BUT_1, ALL_BUT_2, 2, 

1, HALF. 

all, all_but_1, 

all_but_2, 2, 1, half

all

sim_run_out_dir Mechanica Specifies the directory for Mechanica run output 

storage. By default, the current directory is used. 

  

sim_run_tmp_dir Mechanica Specifies the directory for Mechanica run temporary 

storage. By default, the current directory is used. 

  

sim_smooth_aspect_ratio Mechanica Sets the element aspect ratio criterion for the mesh 

smoothing process. 

 7

sim_smooth_edge_angle Mechanica Sets the element edge angle criterion (Quad elements 

only), measured in degrees, for the mesh smoothing 

process. 

 30

sim_smooth_skew Mechanica Sets the element skew angle criterion (Quad elements 

only), measured in degrees, for the mesh smoothing 

process. 

 45

sim_smooth_taper Mechanica Sets the element taper criterion (Quad elements only) 

for the mesh smoothing process. 

 0.5

sim_smooth_warp_angle Mechanica Sets the element warp angle criterion (Quad elements 

only), measured in degrees, for the mesh smoothing 

process. 

 10

Parametric Technology Corporation 83 Pro/ENGINEER Wildfire 5.0 Configuration Options



Name Category Description Values Default Value

sim_solver_memory_allocation Mechanica Specifies the amount of memory in megabytes reserved 

for solving equations and for storing element data 

created by the iterative solver. The default value is 128. 

 128

sim_spotweld_split_mesh Mechanica If set to YES (default), the elements that touch the end 

of the spot weld are created in a circle the same 

diameter as the weld (AutoGEM only). 

yes, no yes

sim_struct_interface_default Mechanica Sets the default for the interfaces created between the 

geometry in a structural model for meshing and running 

analysis. 

bonded, free, 

contact

 

sim_therm_interface_default Mechanica Sets the default for the interfaces created between the 

geometry in a thermal model for meshing and running 

analysis. 

bonded, adiabatic, 

resistance

 

sim_use_layers Mechanica Allows layers to become groups for Mechanica 

Independent mode. 

no, yes no

simprep_default_model_status Assembly Determines the default model status while defining a 

new simplified rep. 

exclude, master, 

graphics, geometry

exclude

simprep_ondemand_activation Without category Enables retrieving on-demand the Master rep ofan 

activated model. When an assembly is activatedthe 

Assembly only rep is retrieved. 

yes, no yes

simprep_ondemand_cleanup Without category Determines if a model retrieved on demandshould be 

removed or erased.Disabled - the model will not be 

removedand will remain in the assembly.Removed - the 

model will be removed. Remove_Erase - The model will 

be removedand erased from memory. 

disable, remove, 

remove_and_erase

remove

simprep_ondemand_editing Without category Enables on demand retrieval of an edited item and its 

parent references.Configuration tools (Family Tables, 

Relations, etc) will retrieverequired models 

accordingly.Automatic - Retrieves the minimum rep 

required to perform the operation. 

disable, master, 

automatic, 

master_with_ancest

ors

automatic

simprep_ondemand_regenerati

on

Without category Enables on demand retrieval of requiredmodels during 

regeneration.Can affect regeneration performance. 

automatic, master, 

disable

automatic

simprep_ondemand_selection Assembly Determines the rep to be retrieved when selecting a 

reference. AutomaticRetrieves the minimum rep 

required to perform the operation. 

automatic, master, 

disable

automatic
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simprep_ondemand_settings Assembly Determines on-demand retrieval behavior in simplified 

representation views. Prompt - Ask for confirmation 

before retrieving on-demand. Never_prompt - Retrieve 

models on-demand automatically with no confirmation. 

Disabled - on demand is disabled. 

prompt, 

never_prompt, 

disable

never_prompt

simulation_fem_mode Mechanica Yes - Activates FEM mode. No - Allows access to 

Mechanica only. Prompt (default) - Brings Mechanica 

Model Type Dialog. This option is used only if 

information about FEM mode is not yet stored with 

model. 

yes, no, prompt prompt

simulation_process_auto_adva

nce

Mechanica If set to yes the Process Guide will advance to the next 

set automatically upon completion of the current step. 

yes, no no

simulation_process_prompt Mechanica If set to yes, the Process Guide will be launched 

automatically upon entry into Mechanica, if template 

files are present. 

yes, no no

simulation_process_template_

dir

Mechanica Specifies the default location of the Process Guide 

template files. 

  

simulation_product Mechanica Set Mechanica product being selected 

(Structure/Thermal). Prompt (default) -Brings 

Mechanica Model Type Dialog. This option is used only 

if the information about Mechanica product is not yet 

stored with model. 

structure, thermal, 

prompt

prompt

skeleton_model_default_color Assembly Specifies the color Pro/ENGINEER uses to display new 

skeleton models. The three decimal values ranging from 

0 through 100 specify (in order) the percentages of red, 

green, and blue in the resulting color. For example, 0 0 

49 specifies medium blue. 

 0

sket_import_geometry_line_sty

le

Sketcher Determine if the original line style and color should be 

preserved on Copy/Paste, Sketcher Palette and Import 

from file. Yes - Preserve original line style and color. 

yes, no no

sketcher_animated_modify Sketcher No - The section is not animated as modifications are 

regenerated. 

yes, no yes
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sketcher_auto_create_refs Sketcher The option values are: 2: the system automatically 

creates 2 dimensioning references; 1: the system 

automatically adds the orientation reference as a 

dimensioning reference; 0: the system does not 

automatically create dimensioning references. 

1, 2 2

sketcher_blended_background Sketcher This option controls whether the blended background 

should be used in 3D Sketcher.The option has no effect 

if blended background is turned off generally. 

no, yes no

sketcher_collinear_constr Sketcher Yes - collinear constraints will be used by Intent 

Manager; No - collinear constraints will not be used by 

Intent Manager. 

no, yes yes

sketcher_default_font_kerning Sketcher Automatically set kerning for text entities in Sketcher. 

Yes - Kerning will be set for new text entities. No- 

Kerning will not be set automatically. 

yes, no no

sketcher_dim_of_revolve_axis Sketcher If this option is set all dimensions created by Intent 

Manager to Axis of Revolution will be diameter 

dimensions. 

no, yes yes

sketcher_dimension_autolock Sketcher Automatically lock strong sketcher dimensions. no, yes no

sketcher_disp_constraints Sketcher Shows the constraints when sketching in Sketcher 

Mode; for example, H for horizontal, V for vertical, and 

so on. 

yes, no yes

sketcher_disp_dimensions Sketcher No - Suppresses the display of all dimensions while in 

sketcher. 

yes, no yes

sketcher_disp_grid Sketcher Specify whether or not to display the sketcher grid. yes, no no

sketcher_disp_vertices Sketcher No - Suppresses the display of yellow points on all 

vertices while in sketcher. 

yes, no yes

sketcher_disp_weak_dimensio

ns

Sketcher Yes - weak dimensions will be displayed; No - weak 

dimensions will not be displayed. 

yes, no yes

sketcher_equal_length_constr Sketcher Yes - equal length constraints will be used by Intent 

Manager; No - equal length constraints will not be used 

by Intent Manager. 

no, yes yes

sketcher_equal_radii_constr Sketcher Yes - equal radii constraints will be used by Intent 

Manager; No - equal radii constraints will not be used by 

Intent Manager. 

no, yes yes

sketcher_grid_angle Sketcher Enter a grid angle value to override the default grid 

angle value. 

 0
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sketcher_import_exact_geom Sketcher During import in sketcher use exact geometry. yes, no yes

sketcher_lineup_hor_constr Sketcher Yes - line up horizontal constraints will be used by Intent 

Manager; No - line up horizontal constraints will not be 

used by Intent Manager. 

no, yes yes

sketcher_lineup_ver_constr Sketcher Yes - line up vertical constraints will be used by Intent 

Manager; No - line up vertical constraints will not be 

used by Intent Manager. 

no, yes yes

sketcher_lock_modified_dims Sketcher Yes - modified dimensions will be locked; No - modified 

dimensions will not be locked. 

yes, no no

sketcher_midpoint_constr Sketcher Yes - midpoint constraints will be used by Intent 

Manager; No - midpoint constraints will not be used by 

Intent Manager. 

no, yes yes

sketcher_palette_path Sketcher Sets the default directory for the user sketcher shape 

library. Use the full path name to avoid problems. 

  

sketcher_parallel_constr Sketcher Yes - parallel constraints will be used by Intent Manager; 

No - parallel constraints will not be used by Intent 

Manager. 

no, yes yes

sketcher_perpendicular_constr Sketcher Yes - perpendicular constraints will be used by Intent 

Manager; No - perpendicular constraints will not be used 

by Intent Manager. 

no, yes yes

sketcher_point_on_entity_cons

tr

Sketcher Yes - point on entity constraints will be used by Intent 

Manager; No - point on entity constraints will not be 

used by Intent Manager. 

no, yes yes

sketcher_refit_after_dim_modif

y

Sketcher Refits section after dimension modification in 2D section 

or when creating the first feature. 

yes, no yes

sketcher_rel_accuracy Sketcher Enter a sketcher relative accuracy.  -1

sketcher_same_point_constr Sketcher Yes - same points constraints will be used by Intent 

Manager; No - same points constraints will not be used 

by Intent Manager. 

no, yes yes

sketcher_save_preview_image Sketcher This option controls whether section files should be 

saved with embedded image information which can be 

used to preview sections in File/Open dialog. 

no, yes no

sketcher_set_grid_method Sketcher "Automatic" - grid spacing will be automatically set, 

"Manual" - grid spacing will be manually set. 

automatic, manual automatic

sketcher_set_grid_x_spacing Sketcher Enter an x-grid spacing value to override the default x-

grid spacing value. 

 1
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sketcher_set_grid_y_spacing Sketcher Enter a y-grid spacing value to override the default y-

grid spacing value. 

 1

sketcher_starts_in_2d Sketcher Defines initial model orientation in Sketcher mode. Yes - 

(2D orientation) Looking directly at section (sketching) 

plane. No - (Orientation unchanged) Sketch directly on 

the 3D part. 

yes, no yes

sketcher_strngthn_to_def_dec

_pl

Without category This option enable the user to keep a highly precise 

value during creation or convertion strong dimension. 

yes, no yes

sketcher_symmetric_constr Sketcher Yes - symmetric constraints will be used by Intent 

Manager; No - symmetric constraints will not be used by 

Intent Manager. 

no, yes yes

sketcher_tangent_constr Sketcher Yes - tangent constraints will be used by Intent 

Manager; No - tangent constraints will not be used by 

Intent Manager. 

no, yes yes

sketcher_undo_reorient_view Sketcher Controls the ability to Undo view reorientation while in 

Sketcher. Yes - it is possible to Undo view reorientation 

in Sketcher. 

no, yes no

sketcher_undo_stack_limit Sketcher Sketcher saves a copy of each function performed. The 

number of possible saved functions depend on the 

number specified in the option. The undo menu can be 

used to remove the stored functions. 

 200

skip_small_surfaces Model Display Gives the user the option not to display small shaded 

surfaces. Disabling this option will improve display 

quality at the expense of speed.It is most useful for 

creating screen snap shots. 

no, yes yes

smooth_lines Model Display Choose whether to smooth lines by default or not. no, yes no

smt_allow_flip_sketch Sheetmetal Yes - Allows flipping the sketch in Flat and Flange tools. 

No- Disables the ability to flip the sketch in Flat and 

Flange tools. 

yes, no no

smt_bend_notes_dflt_display Sheetmetal Define the default state of Bend Note display 

(sheetmetal Mode) 

yes, no yes

smt_bend_notes_direction_do

wn

Sheetmetal Define the Down Direction symbol for Bend Notes 

(sheetmetal Mode) 

 default

smt_bend_notes_direction_up Sheetmetal Define the Up Direction symbol for Bend Notes 

(sheetmetal Mode) 

 default

smt_bend_notes_order Sheetmetal Define the Fields Order for Bend Notes (sheetmetal 

Mode) 

 &type&direction&angle
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smt_bend_notes_type_formed Sheetmetal Define the Formed symbol for Bend Notes (sheetmetal 

Mode) 

 default

smt_bend_notes_type_rolled Sheetmetal Define the Rolled symbol for Bend Notes (sheetmetal 

Mode) 

 default

smt_crn_rel_display Sheetmetal Yes - Corner relief notes will be displayed. No - Corner 

relief notes will not be displayed. 

no, yes yes

smt_form_abort_on_fail_plc Sheetmetal Yes - will always fail the Sheetmetal Form feature if 

there is a problem with its placement . 

yes, no no

smt_mp_method Sheetmetal MASS - Suppressed Flat Pattern and Flatten Forms will 

be temporary resumed before mass properties 

calculation of sheetmetal part. CG - Mass Properties 

calculation will be performed on current state of 

sheetmetal part.BOTH - Both methods will be used one 

after the other. 

mass, cg, both cg

smt_outside_mold_lines Sheetmetal Yes - Outside Mold Lines will be created during Flat 

Pattern creation. 

yes, no no

snap_single_constraints Without category When dynamically dragging components during 

component placement, allow to snap to references one 

constraint at a time. 

yes, no yes

spherical_map_size Model Display Size of Spherical map texture image used for 

environment mapping. Bigger size will have better 

image quality but will be slow to regenerate. 

256x256, 512x512, 

1024x1024

256x256

spin_center_display Environment Determines whether or not the spin center symbol 

displays. 

yes, no yes

spin_rate_zoom_sensitive Model Display Allows slower spinning when zoomed in on a model. yes, no no

spin_with_notes Model Display Yes - 3D feature and model notes are displayed during 

dynamic spinning of a model. 

yes, no yes

spin_with_orientation_center Without category Display orientation center while reorienting. yes, no yes

spin_with_part_entities Model Display Yes - Datum features will be displayed during dynamic 

spinning of a model. 

yes, no no

spin_with_silhouettes Model Display Yes - Silhouette lines will be displayed during dynamic 

spinning of a model. 

no, yes no

start_appmgr Environment Determines whether or not the application manager 

starts when Pro/ENGINEER is started. 

yes, no yes

start_model_dir File Storage & 

Retrieval

Provides the complete path to the directory containing 

start parts and assemblies. 

  

Parametric Technology Corporation 89 Pro/ENGINEER Wildfire 5.0 Configuration Options



Name Category Description Values Default Value

startup_check_for_visualization Environment Determines whether or not the visualization components 

are checked for installation upon startup. 

yes, no yes

std_nastran_template Mechanica Sets the file path of a NASTRAN deck template. Use full 

path to avoid problems. 

  

step_appearance_layers_grou

ps

Data Exchange No - Output of Appearances, Layers, and Groups is 

enabled for STEP standard AP214. Yes - Output of 

Appearances, Layers, and Groups is enabled for STEP 

standard AP203. 

yes, no no

step_export_ap214_asm_def_

mode

Data Exchange Toggles the default setting of the File Structure field in 

the STEP Export dialog box for supported assembly 

STEP export files. 

single_file, 

separate_parts_only

, 

separate_all_objects

single_file

step_export_dwg_views Data Exchange AS_3D_VIEWS - Export 3-D model geometry with its 

associative views. AS_3D_VIEWS_ASSOC_DRAFT - 

Export 3-D model geometry with its associative views 

and view related annotations. NO - Export only 2-D 

representations of the 3-D models. This is the default. 

no, as_3d_views, 

as_3d_views_assoc

_draft

no

step_export_format Data Exchange Specifies output format when exporting to STEP. 

AP203_IS - Formats output to ISO 10303 AP203IS 

format. AP214_CD - Formats output with geometry that 

meets the specification for the long-term schema for 

AP214cc1. 

ap203_is, ap214_cd, 

ap202_is, 

203_is_ext,  

ap214_dis, 

ap209_dis, 

ap214_is, ap203_e2

ap203_is

store_tool_path_file Manufacturing Specifies how tool path information is computed. Yes - 

Tool path information stored in file filename.tph 

(filename is manufacturing model name). No - Tool path 

is computed each time manufacturing model is retrieved 

or parameters are changed. 

yes, no yes

style_auto_regen_curves Without category Yes - Enable autoregeneration of curves. yes, no yes

style_auto_regen_shaded_surf

ace

Without category Yes - Enable autoregeneration of shaded surfaces. yes, no yes

style_auto_regen_surface Without category Yes - Enable autoregeneration of surfaces. yes, no yes
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style_connection_arrow_scale Without category Set scale factor of surface connection arrow. Number 

should be greater then 0. 

 1

style_default_connections Without category Yes - Add connections to a newly created Style surface. yes, no yes

style_display_grid Without category Yes - Display grid for active datum plane. yes, no yes

style_grid_spacing Without category Set the number of lines to display on the grid. Number 

should be equal or greater than 2. 

 5

style_state_transparency Without category Set the value of transparency for components set to 

"Transparent" in style state.Value must be between 0 

and 100. 

 70

style_surface_mesh_display Without category On - Display surfaces mesh. Off - Do not display 

surfaces mesh. Off When Shaded - Display surfaces 

mesh except when shaded. 

off, on, off when 

shaded

off

style_surface_mesh_quality Without category Sets the quality of the surface mesh. Values range is 

between 0.1 to 10. 

 1

summary_help User Interface Refers to the one-line help Messages that are either 

displayed or not displayed. 

yes, no no

suppress_appearance_messa

ge

Colors Suppress the lightworks appearance conversion 

notification dialog. 

yes, no no

suppress_dlg_license_expired User Interface Suppresses "License expired: List of options and 

expiration days" dialog 

 7

suppress_license_loss_dialog User Interface Yes - Suppresses the 'Regained Floating License' dialog 

box. No - The 'Regained Floating License' dialog box 

will display. 

yes, no no

switch_dims_for_notes Drawing Yes - Dimensions will be displayed in their symbolic 

format during drawing note creation. No - Dimensions 

will be displayed in drawing notes as numerical values. 

yes, no yes

sym_leader_orient_move_text Drawing With Pro/DETAIL, automatically regroups weld symbol 

instances after you move the text. 

yes, no no

symbol_instance_palette_file Drawing Specifies the location of the symbol instance palette.   

symbol_palette_input Drawing Controls the display of the special symbol palette during 

note creation. 

yes, no yes
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system_background_color Colors Defines default graphics area background color. The 

three decimal values specify (in order) percentage of 

red, green and blue in the resulting color. For example, 

0 0 49 specifies a medium blue. Change in session 

using View>Display Settings>System Colors. 

 0

system_colors_file Colors Specifies the system color file. Use the full path name to 

avoid problems. 

  

system_curves_color Colors Defines default curve color. The three decimal values 

specify (in order) percentage of red, green and blue in 

the resulting color. For example, 0 0 49 specifies a 

medium blue. Change in session using View>Display 

Settings>System Colors. 

 0

system_dimmed_menu_color Colors Defines default secondary highlight color. The three 

decimal values specify (in order) percentage of red, 

green and blue in the resulting color. For example, 0 0 

49 specifies a medium blue. Change in session using 

View>Display Settings>System Colors. 

 0

system_edge_high_color Colors Defines default edge highlight color. The three decimal 

values specify (in order) percentage of red, green and 

blue in the resulting color. For example, 0 0 49 specifies 

a medium blue. Change in session using View>Display 

Settings>System Colors. 

 0

system_geometry_color Colors Defines default color of solid wireframe entities. The 

three decimal values specify (in order) percentage of 

red, green and blue in the resulting color. For example, 

0 0 49 specifies a medium blue. Change in session 

using View>Display Settings>System Colors. 

 0

system_hidden_color Colors Defines default color of hidden, wireframe entities. The 

three decimal values specify (in order) percentage of 

red, green and blue in the resulting color. For example, 

0 0 49 specifies a medium blue. Change in session 

using View>Display Settings>System Colors. 

 0
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system_highlight_color Colors Defines default primary highlight color. The three 

decimal values specify (in order) percentage of red, 

green and blue in the resulting color. For example, 0 0 

49 specifies a medium blue. Change in session using 

View>Display Settings>System Colors. 

 0

system_iges_header_file Data Exchange Inserts specified text file into the Start section of IGES 

files (refer to user_iges_header_file). When used with 

user_iges_header_file, the system text appears first. 

  

system_letter_color Colors Defines default color of datum tags. The three decimal 

values specify (in order) percentage of red, green and 

blue in the resulting color. For example, 0 0 49 specifies 

a medium blue. Change in session using View>Display 

Settings>System Colors. 

 0

system_section_color Colors Defines default section color. The three decimal values 

specify (in order) percentage of red, green and blue in 

the resulting color. For example, 0 0 49 specifies a 

medium blue. Change in session using View>Display 

Settings>System Colors. 

 0

system_sheetmetal_color Colors Defines default color of Sheetmetal parts. The three 

decimal values specify (in order) percentage of red, 

green and blue in the resulting color. For example, 0 0 

49 specifies a medium blue. Change in session using 

View>Display Settings>System Colors. 

 0

system_volume_color Colors Defines default color of Manufacturing volumes. The 

three decimal values specify (in order) percentage of 

red, green and blue in the resulting color. For example, 

0 0 49 specifies a medium blue. Change in session 

using View>Display Settings>System Colors. 

 0

tablet_device_name System Specifies the name of a digitizing tablet.   

tan_angle_for_disp Model Display For display purposes only. Sets the angle between two 

quilt surfaces below which the edge will be displayed as 

tangent. Enter an angle between 1.5 and 15 degrees. 

 0.02618

tangent_edge_display Model Display Determines how edges between tangent surfaces are 

displayed. 

no, solid, centerline, 

phantom, dimmed

solid
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tbl_driven_tol_val_edit Dimensions & 

Tolerances

Tbl_driven_tol_val_edit Y/N* - "Yes" allows users to 

directly edit the tolerance value of dimensions whose 

tolerance values are driven by tolerance tables. Editing 

the tolerance value of a dimension will make the 

dimension non-table-driven. "No" disallows direct editing 

of the tolerance values of table driven tolerances. 

yes, no no

template_designasm File Storage & 

Retrieval

Specifies the designated template assembly. Use full 

path to avoid problems. 

 inlbs_asm_design.asm

template_drawing File Storage & 

Retrieval

Specify the drawing used as the default drawing 

template. 

 c_drawing.drw

template_ecadasm File Storage & 

Retrieval

Specify the model used as the default ECAD assembly 

template. 

  

template_ecadpart File Storage & 

Retrieval

Specify the model used as the default ECAD part 

template. 

  

template_esrasm Without category Specifies the designated template ESR assembly. Use 

full path to avoid problems. 

 inlbs_asm_esr.asm

template_flat_harness Electromechanical Specify the model used as the default flattened Harness 

assembly template. 

  

template_harnesspart Electromechanical Specify the model used as the default Harness part 

template. 

  

template_mfgcast File Storage & 

Retrieval

Specify the model used as the default manufacturing 

cast template. 

 inlbs_mfg_cast.asm

template_mfgcmm File Storage & 

Retrieval

Specify the model used as the default manufacturing 

cmm template. 

 inlbs_mfg_cmm.asm

template_mfgemo File Storage & 

Retrieval

Specify the model used as the default manufacturing 

expert machinist template. 

 inlbs_mfg_emo.asm

template_mfgmold File Storage & 

Retrieval

Specify the model used as the default manufacturing 

mold template. 

 inlbs_mfg_mold.asm

template_mfgnc File Storage & 

Retrieval

Specify the model used as the default manufacturing 

assembly template. 

 inlbs_mfg_nc.asm

template_mold_layout File Storage & 

Retrieval

Specify the mold layout assembly used as a default 

template. 

 inlbs_mold_lay.asm

template_sheetmetalpart File Storage & 

Retrieval

Specify the model used as the default sheetmetal part 

template. 

 inlbs_part_sheetmetal.

prt

template_solidpart File Storage & 

Retrieval

Specify the model used as the default part template.  inlbs_part_solid.prt
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terminal_command User Interface Specifies the full path to the terminal emulator 

command (the command that starts shell windows). Use 

the command for your system. Enter the complete path 

name and the terminal command. 

  

terminator_table_out_unicode Electromechanical YES - Unicode strings are exported in terminator table 

files, NO - Unicode strings are converted to ASCII 

characters for terminator table export. 

yes, no yes

texture Model Display Yes - Applied textures will be displayed when the model 

is shaded. 

no, yes yes

texture_search_path Model Display Appends a directory to the search path for textures.   

thermo_position_hint User Interface Enables you to position the thermometer-type scales 

whenever they appear, so that they do not overlap the 

Pro/ENGINEER windows (if space permits, for example, 

if windows have been scaled). 

no_window_overlap, 

window_overlap

window_overlap

tiff_compression Data Exchange TIFF exports are done without compression. none, g4, packbits, 

deflate

none

tiff_type Data Exchange Determines the type of tiff items are exported to 

variables refer to color sets 

rgb, palette, 

grayscale, mono

rgb

todays_date_note_format Drawing Controls the initial format of the date displayed in a 

drawing. The format for the setting is a string consisting 

of three portions: the year, the month, and the date. You 

can enter the portions in any order. 

 %dd-%mmm-%yy

tol_display Dimensions & 

Tolerances

Displays dimensions with or without tolerances. yes, no no

tol_mode Dimensions & 

Tolerances

Sets the tolerance mode of newly created dimensions. nominal, limits, 

plusminus, 

plusminussym, 

plusminussym_supe

r

limits

tol_num_digits_default_driven Drawing Yes - The Default check boxes in the number of digits 

area of the Dimension Properties dialog will be checked 

when a dimension is created or first shown. No - The 

check boxes will be unchecked when a dimension is 

created or first shown. 

yes, no yes
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tolerance_class Dimensions & 

Tolerances

Sets the default tolerance class for ISO-standard 

models. The system uses the tolerance class in 

conjunction with the dimension value when retrieving 

tolerances for General or Broken Edge dimensions. 

fine, medium, 

coarse, very_coarse

 

tolerance_standard Dimensions & 

Tolerances

Sets the tolerance standard used when creating the 

model. 

ansi, iso ansi

tolerance_table_dir Dimensions & 

Tolerances

Sets the default directory for user-defined tolerance 

tables for ISO-standard models. All Holes and Shafts 

tables overwrite existing tables when loaded. 

  

toolkit_registry_file Application 

Programming 

Interfaces

Tells Pro/E the full path to which toolkit registry file to be 

used. This option replaces the R17 option prodevdat. 

  

tracesketch Without category Display tracesketches outside of Style feature no, yes yes

trail_delay System Sets a delay in seconds between trail file steps.   

trail_dir System Instructs Pro/ENGINEER to create its trail file in the 

specified directory rather than in the startup directory. 

  

train_file_path System Specifies the default directory for training files. The path 

name must start from the root of the directory, for 

example, /home/users/library/training. 

  

transparency Model Display Yes - Transparent colors will appear as such when the 

model is shaded. 

no, yes yes

travel_bounds_display Without category Enable travel bounds display. yes, no no

travel_bounds_transparency Without category Transparency value for machine bound display.  0.8

triangulate_filled_areas Drawing Subdivide filled areas into triangles (may affect memory 

usage and plot files). 

yes, no no

troubleshooter_show_info_gch

eck

Features When set to Yes this option will add a "Show info items" 

filter to the View panel in the Troubleshooter. 

no, yes no

ttf_handling_for_plot_files Printing & Plotting Defines how annotations using True Type Fonts are 

written to the plot file. Using True Type Fonts reduces 

the plot file size, but font substitution may occur due to 

device settings. Annotations that do not use True Type 

Fonts are unaffected by this option. 

stroke all fonts, use 

true type fonts

use

udf_af_name_postfix Features If set to yes, a sequential number will be appended to 

the name of annotation feature in group from Copy and 

UDF placement. 

yes, no yes
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ui_theme Without category Setup Pro/E Theme.Standard will result in the Wildfire 

Theme on UNIX and "following the Windows theme on 

Windows XP & Win2K. Wildfire - Will always use the 

Wildfire Theme regardless of the OS settings. 

wildfire_5, wildfire, 

standard

wildfire_5

units_system_dic_file Piping Specifies the file containing the mapping for MCAT 

filename and units. 

 <proe_WF_5.0_loadpo

int>/text/piping_data/m

aster_catalog/piping_u

nits_system_dic_file.pt

d

update_copy_geom_location Assembly Yes-Copy Geometry will try to update location of copied 

geometry based on changes to component placements 

even if some components are excluded or in graphics 

rep. 

yes, no yes

update_harness_mfg_line_colo

r

Electromechanical Update cable line color for harness-mfg part created in 

release 2000i or earlier. 

yes, no no

update_pre_130_harness Electromechanical Yes - When a cable is added between two previously 

laid out locations in a three-dimensional reference 

harness, display of the new cable will update 

automatically in pre-Release 13 flattened cable models. 

yes, no no

update_pre_16_cable_layers Electromechanical Yes - Harnesses containing cables routed prior to 

Release 16.0 will be automatically updated upon 

retrieval to comply with new display standards. 

yes, no no

update_rep_refs Assembly "Yes" updates top assembly simplified reps for 

replacements during regeneration and upon 

replacement. 

yes, no yes

use_8_plotter_pens Printing & Plotting Specifies whether to support up to 8 plotter pens. The 

initial default is 4 pens. 

no, yes no

use_export_2d_dialog Data Exchange Yes - Opens export options dialog when exporting Pro/E 

drawing. No - exports file without the options dialog. 

yes, no yes

use_iges_font_1003 Data Exchange Used to disable the use of IGES font 1003. yes, no yes

use_iges_kanji_font_2001 Data Exchange Specifies whether to convert Kanji notes in 

Pro/ENGINEER to IGES Kanji notes (font code) when 

exporting. Yes - Converts Kanji notes to IGES Kanji 

notes. No - Converts using Font 1. 

yes, no no
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use_major_units Dimensions & 

Tolerances

Determines if fractional dimensions are displayed in 

terms of feet-inches or meter-mm. Yes - The major 

units are used. For example, when the units are inches 

and 25.125 is converted to a fraction, the dimension 

becomes 2' 1-1/8". 

yes, no no

use_master_for_bad_disp_rep

s

Without category Yes to retrieve master rep when graphics rep has no 

display data. 

yes, no no

use_nom_dim_val_in_expr Dimensions & 

Tolerances

Yes - use dimensions' nominal values in expressions.No 

- use current values. 

yes, no no

use_part_color_for_hidden_lin

es

Colors Determines how to color the hidden lines of parts that 

have user defined colors. "YES" - Use the dimmed part 

color for hidden lines.SYSTEM_HIDDEN_COLOR is 

ignored if it has been specified. 

no, yes no

use_pre_wildfire_text_font Model Display Yes - Use the old stroke-based PTC font as the default 

font. No - Use a True Type font as the default font. 

no, yes no

use_software_linefonts Printing & Plotting Yes - The exact line style used in Pro/ENGINEER is 

plotted, stroked out dot by dot, dash by dash, and space 

by space. No - plots lines using the line font it supports 

which most closely resembles the font used in 

Pro/ENGINEER. 

yes, no no

use_strict_ui_trail Without category Perform extra validation of user interface actions when 

playing back trail files. 

yes, no yes

use_temp_dir_for_inst File Storage & 

Retrieval

Explicitly makes Pro/ENGINEER use the Temp directory 

for regenerating instances of models. 

no, yes no

use_web_page_font_in_report

s

Without category Controls whether HTML reports use the browser's 

standard fonts. 

yes, no no

user_defined_grid_interval Features Modify grid space in user defined length units for handle 

movement. 

 0.5

user_iges_header_file Data Exchange Filename - Insert specified text file into the Start section 

of IGES file. Valid parametric note symbols will be 

replaced during export. For example, &dwg_name in the 

text file is replaced by the drawing name when a 

drawing is exported. 

  

variable_plots_in_inches Printing & Plotting No - Variable plot sizes may be entered in millimeters. yes, no yes
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variant_drawing_item_sizes Drawing No - Drawing items moved/copied to a different sheet or 

located on a changed sheet keep same size and relative 

orientation on paper. Yes - Some items scale/reposition 

to be the same on paper, and others scale and/or 

reposition to be the same on screen. 

yes, no no

vda_header Data Exchange The complete filename of the text file containing VDA 

header information. If you intend to use the same 

header for all VDA files, specify the full pathname. 

  

verify_on_save_by_default File Storage & 

Retrieval

Yes - "Verify Now" action will be selected in the conflict 

dialog by default when an unverified family table 

instance is to be saved in PDM workspace.No - "Verify 

Now" action will not be selected by default. The user 

may explicitly specify the "Verify Now" action in the 

conflict dialog. 

yes, no no

versatec_cutter_installed Printing & Plotting Yes - Indicates that a cutter is installed on a Versatec 

plotter. 

no, yes  

visible_annotations_scope Assembly Specify whether sub-model annotations will be visible in 

assemblies.If set to "Active model only", only 

annotations of the active model will be visible.If set to 

"All", all annotations in sub-models will also be 

displayed. Annotation display in part mode is not 

affected. 

active model only, all active

visible_mapkeys User Interface No - Mapkeys will run without displaying picks being 

made in the Menu Manager menus. This does not affect 

the display of picks being made in menu bar menus or 

dialog boxes. 

no, yes no

visible_message_lines User Interface Sets the default number of visible message lines in the 

Pro/ENGINEER message area. 

 2

vrml_anchor_url Data Exchange Enables you to place an anchor on a specified VRML 

component during the export to VRML. The keywords 

are optional. 

  

vrml_background_color Data Exchange Yes - Exports a model to VRML with the 

Pro/ENGINEER background color. 

yes, no no

vrml_explode_lines Data Exchange Yes - Exports a model to VRML with explode lines for 

assembly or assembly process data. 

yes, no yes

vrml_export_resolution Data Exchange Specifies the number of levels of detail (LODs) in 

models exported in VRML format. 

high, medium, low medium
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vrml_export_version Data Exchange Allows the user to choose between exporting to the 

VRML 2.0 or 1.0 format. 

2.0, 1.0 2

vrml_file_duplicate_material Data Exchange Yes - Ensures that the model components retain their 

true color. No - In some viewers, component colors 

might not be consistent. 

yes, no no

vrml_multiple_views Data Exchange All - Exports top-level and lower-level assembly 

component views into VRML format. None - Does not 

export component views into VRML format. Top - 

Exports top-level object view only into VRML format. 

none, all, top all

vrml_parameters Data Exchange Controls the export of user parameters. Designated - 

Export only designated parameters. All - Export all 

parameters. None - Do not export parameters. 

designated, all, none designated

vrml_simprep_export Data Exchange Yes - Specifies direct and in memory export of top-level 

assembly simplified representation to Pro/FLY-

THROUGH package files. 

yes, no no

warn_if_iso_tol_missing Without category Yes - Returns the user to the dimension properties 

dialog to select a different table. No - Applies the 

tolerance according to existing functionality. 

yes, no no

wcell_fixt_info_setup_file Without category Specify name and path of the file containing workcell 

and fixture name info. 

  

web_browser_history_days System Enter number of days to store history records.  20

web_browser_homepage System Enter location of Pro/E browser home page.  <proe_WF_5.0_loadpo

int>/html/chinese_tw/pr

oe/helpsystop/resource

_center_index.htm

web_disable_js_command Application 

Programming 

Interfaces

Enter a specific javascript command to be disabled   

web_enable_javascript Without category Enables or disables Pro/Web.Link in the embedded 

browser. 

on, off off

web_enable_subscription Application 

Programming 

Interfaces

Enable the subscription mechanism for Connections no, yes yes

web_link_file_read Application 

Programming 

Interfaces

Sets Pro/Web.Link permission to read data from the 

local file system. 

yes, no no
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web_link_file_write Application 

Programming 

Interfaces

Sets Pro/Web.Link permission to write data to the local 

file system. 

yes, no no

web_link_proe_read Application 

Programming 

Interfaces

Sets Pro/Web.Link permission to read data from a 

Pro/ENGINEER session. 

yes, no no

web_link_proe_write Application 

Programming 

Interfaces

Sets Pro/Web.Link permission to modify data in a 

Pro/Engineer session. 

yes, no no

web_link_security_autoprompt Application 

Programming 

Interfaces

Yes - The Security dialog box is displayed when a 

Pro/Web.Link function requires security access beyond 

the current settings. 

yes, no yes

web_max_mail_size Without category Set the maximum email attachment size in kilobytes.  5000

weld_ask_xsec_refs Weld No - Do not ask for X-section references when creating 

weld features. Yes - Ask for X-section references when 

creating weld features. 

no, yes no

weld_color Weld Defines default weld color. The three decimal values 

specify (in order) percentage of red, green and blue in 

the resulting color. For example, 0 0 49 specifies a 

medium blue. Change in session using 

Tools>Colors>System. 

 0

weld_dec_places Weld Sets the default number of decimal places (0-10) to 

display in weld parameters. 

 3

weld_edge_prep_driven_by Weld Determines if the edge preparation feature is created in 

the part or theassembly level. 

part, assembly part

weld_edge_prep_groove_angle Weld Specifies an initial default value for the angle cut edge 

preparation. 

 45

weld_edge_prep_groove_dept

h

Weld Specifies an initial default value for the edge preparation 

depth. 

 0.25

weld_edge_prep_instance Weld Controls whether a family table instance is created for 

edge preparation. Yes - Instances of the components 

that receive edge preparation are created. 

yes, no  

weld_edge_prep_name_suffix Weld Specifies the suffix name for the instance that will be 

created during edge preparation. Part name plus 

extension makes the instance name. 

 _noep

weld_edge_prep_root_open Weld Specifies an initial default value for the root opening 

edge preparation. 

 0.25
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weld_edge_prep_visibility Weld Applies only if weld_edge_prep is set to Yes. Generic - 

Edge preparation features are resumed in the generic 

and suppressed in the instance. Instance - Edge 

preparation features are suppressed in the generic and 

resumed in the instance. 

generic, instance  

weld_fillet_preferences_file Without category Sets the path and name of the fillet weld preferences 

file. 

  

weld_general_preferences_file Without category Sets the path and name of the general weld preferences 

file. 

  

weld_geom_type_default Weld Sets the default weld geometry type. surface, light surface

weld_groove_preferences_file Without category Sets the path and name of the groove weld preferences 

file. 

  

weld_notch_corner_radius Weld Specifies an initial default value for the radius at weld 

notch corner. 

 0.1

weld_notch_height Weld Specifies an initial default value for the weld notch 

height. 

 0.4

weld_notch_radius Weld Specifies an initial default value for the weld notch 

radius. 

 0.5

weld_notch_width Weld Specifies an initial default value for the weld notch width.  0.5

weld_plug_slot_preferences_fil

e

Without category Sets the path and name of the plug/slot weld 

preferences file. 

  

weld_spot_preferences_file Without category Sets the path and name of the spot weld preferences 

file. 

  

weld_ui_standard Weld Specifies standard for welding user interface. ANSI - 

Use ANSI standards. ISO - Use ISO standards. 

iso, ansi ansi

window_gamma Photorender Gamma correction to apply to images created by 

renderer. Default value is 1.0. 

 1

windows_browser_type System Select the type of embedded browser to use. ie_in_process, 

ie_in_sep_process, 

mozilla_based_brow

ser

 

windows_scale User Interface Scales Pro/ENGINEER windows with a given 

coefficient. A value of 0.85 is usually adequate to allow 

dynamic menus to display to the right of the 

Pro/ENGINEER window. 

 1
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workpiece_instances Without category Instances are created in Workpiece for each steps. steps, 

operations_and_ste

ps, none, operations

none

www_add_aux_frame Data Exchange Creates additional frame for each process step or for 

assembly publication. Yes - Auxiliary files aux.html are 

created for each step in assembly process (in each 

step00 directory) to be replaced by your .html file. No - 

Auxiliary files are not created. 

no, yes no

www_export_geometry_as Data Exchange Specifies the output format by to one of the values vrml, cgm, jpg, 

cgm_vrml, jpg_vrml, 

cgm_jpg, all

jpg_vrml

www_multiple_views Data Exchange All - Writes all views in any component to the 

appropriate VRML files. Top - Writes only named views 

that reside in the assembly or process assembly to top-

level VRML files. None - Does not write named views to 

VRML files. 

none, all, top top

www_tree_location Data Exchange Specifies the location of the model tree in the browser 

window. Out - Opens model tree in a separate window. 

In - Includes model tree in the Web page and removes 

the Tree checkbox from the control panel. 

out, in out

x_angle Model Display Sets the default view orientation for models (appears in 

the Orientation dialog box). The default orientation is the 

last option, x_angle, y_angle, or orientation, in the 

configuration file. 

 0

y_angle Model Display Sets the default view orientation for models (appears in 

the Orientation dialog box). The default orientation is the 

last option, x_angle, y_angle, or orientation, in the 

configuration file. 

 0
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acad_brk_tbls_w_blank_line

s

DELETED Data Exchange Yes - drawing tables having blanked lines are exported 

to DXF/DWG as separate entities, No - the tables are 

exported as DXF/DWG tables but the lines are not 

blanked. 

yes, no no

accessory_window_display NEW Without 

category

Docked - Displays the accessory window embedded in 

the active window. Undocked - Displays the accessory 

window as a standalone window. 

undocked, docked docked

advanced_style_surface_edi

t

CHANGED Features 

Without 

category

Use advanced options by default for Surface Edit in 

Style. 

yes, no no

allow_save_failed_model NEW Assembly Yes - Failed models can be saved. No - Failed models 

cannot be saved. Prompt - Let the user decide whether 

failed models can be saved. 

yes, no, prompt prompt

allow_update_part_simp_rep

_data

CHANGED Assembly Allow updating part Simplified Rep data in session 

automatically when switching from one Simp Rep to 

another.Yes - Allow updating part simplified rep data. 

No - Do not update part simplified rep data. Prompt - 

Prompt the user if the current simplified rep should be 

updated. 

yes, no, prompt yes

analysis_force_wireframe_m

ode

DELETED Model Display Force part to be displayed in wireframe mode if it has 

visible saved shaded analyses. 

yes, no no

animate_explode_states NEW Model Display Animate the transition between explode states and 

mold opening steps. 

yes, no yes

auto_backup_new_placemnt

_refs

NEW Assembly Yes - Create Component Reference Backup, No - Do 

not Create Component Reference Backup. 

yes, no no

auto_evaluate_simprep_rule

s

NEW Assembly If the option is "yes" newly created rep would be 

updated each time on retrieve/regeneration. 

no, yes no

auto_place_max_number NEW Assembly Set the default value for the maximum number of 

matches allowed. 

5

autohide_external_sketch NEW Features If set to yes, a Sketch feature is automatically hidden 

after being used as external sketch for a sketch based 

feature. 

yes, no yes

boeing_extract_bundle CHANGED Without 

category

Setup whether the new extract bundle algorithm should 

be used.Yes - Uses the extract bundle algorithm. No - 

Does not use the extract bundle algorithm. 

yes, no no

                                            Pro/ENGINEER Wildfire 4.0 to 5.0 Configuration Options Changes
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cadam_line_weights DELETED Data Exchange Define the line width of entities within Pro/ENGINEER to 

plot drawings with correct line weights that are 

consistent with a standard. The default Pro/ENGINEER 

values for these weights are: 2 (light), 3 (medium), 5 

(heavy). 

0

cdt_transfer_details DELETED Data Exchange No - Details (dittos) associated with the imported 

CADAM drawing are placed on the current 

Pro/ENGINEER drawing sheet. Yes - Each detail (ditto) 

associated with the imported CADAM drawing converts 

to a separate additional sheet. 

yes, no yes

check_interface_criteria NEW Assembly Check for interfaces when placing a component. yes, no no

cmm_custom_tool_param_fil

e

NEW Manufacturing Defines the file that contains the user-defined tool 

parameters' list. 

combined_views_customizat

ion

NEW Without 

category

Enable / Disable combined views customization. yes, no yes

comp_placement_assumptio

ns

NEW Assembly Use placement assumptions when placing components. yes, no yes

compress_output_files CHANGED File Storage & 

Retrieval

You can compress object files to store them. 

Compressed files are generally somewhat smaller than 

non-compressed files (but may be larger in some 

cases). Compressed files are slower to read and write. 

Yes - Stores object files in compressed format.Yes - 

Stores object files in a compressed format.Note: 

Compressed files are usually smaller, buy may be 

larger,than uncompressed files. Compressed files are 

slower to read and to write to. 

yes, no no

contact_surfaces_gap NEW Without 

category

Sets the maximum allowable gap between weld contact 

surfaces. 

0

datum_point_symbol CHANGED Model Display Specifies the shape of datum point symbols displayed in 

Part or Assembly mode. 

dot, cross, circle, 

triangle, square

cross

default_ang_dec_places CHANGED Drawing Specifies the number of decimal places shown in 

angular dimensions in a drawing.Sets the default 

number of decimal places (0-13) to which to round 

newly created angular dimensions. Unrounded angular 

dimensions automatically determine the number of 

decimal places required to display their stored value. 

1
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default_ang_units NEW Dimensions & 

Tolerances

Sets the display of newly created angular dimensions 

both in the model and in the drawing. There is no 

impact on dimensions previously created. ang_deg - 

Decimal degrees.ang_min - Degrees and decimal 

minutes ang_sec - Degrees, minutes, and decimal 

seconds 

ang_deg, ang_min, 

ang_sec

ang_deg

default_dec_places CHANGED Dimensions & 

Tolerances

Sets the default number of decimal places (0-14) to 

display in all model modes for non-angular dimensions. 

It does not affect the display of dimensions modified 

using Num Digits. In Sketcher, sketcher_dec_places 

controls the number of decimal places.Sets the default 

number of decimal places (0-13) to which to round 

newly created dimensions. Unrounded dimensions 

automatically determine the number of decimal places 

required to display their stored value. 

2

default_scene_filename CHANGED Photorender Complete path to the scene file to be used as default 

scene file. 

<proe_WF_5.0_lo

adpoint>/graphic-

library/scenes//def

ault-enhanced-

realism.scn

display_mfg_icon_for_mfg_a

ssy

NEW Manufacturing Yes- Display manufacturing icon for manufacturing 

assembly files in Open/Save dialogs.No- the 

manufacturing assembly files have assembly icons. 

yes, no no

display_pdm_server_quick_v

iew

NEW Without 

category

Yes - display summary view of PDM information for 

items in session. It applies to ProductPoint only. 

yes, no yes

display_popup_viewer NEW Without 

category

No- disable popup viewer, File_Open_Only: display 

popup viewer only in the file open dialog, Yes: display 

popup viewer in file open dialog, model tree and in 

Server Quick View dialog 

yes, no, 

file_open_only

file_open_only

display_route_cable_preview NEW Electromechani

cal

If no then Route Cables tool does not display preview of 

cables as they are routed.Otherwise Route Cables tool 

will show a preview of the path routed cables will follow. 

yes, no yes

display_z_extension_lines CHANGED Model Display Controls the display of dimension z-extension lines. Yes 

- z-extension lines will be displayed; No - z-extension 

lines will not be displayed. 

yes, no yes

dm_nc_references NEW Without 

category

Sets whether reference relationships will be created in 

Windchill between the manufacturing model and its 

deliverables(CL file, tape file and DMIS file). 

yes, no yes
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dm_user_presence NEW Data 

Management

Enable user presence indicator and actions.This 

capability requires a connection with a PDM server and 

requires an installed and running Microsoft 

communicator client. 

yes, no yes

drawing_setup_file CHANGED Drawing Sets the default drawing setup file option values for your 

Pro/ENGINEER session, otherwise, the system uses 

the default drawing setup file option values. Certain 

parameters in the file are valid only if you have a license 

for Pro/DETAIL. 

<proe_WF_5.0_lo

adpoint>/text/prod

etail.dtl

dwg_unicode_conversion_la

nguage

CHANGED Drawing Defines the language used during Unicode conversion 

of pre-Wildfire 4.0 drawings. This option does not affect 

the conversion of models. File uses the language stored 

in the drawing header file; Session uses the language of 

the current Pro/E session.Defines the language used 

during Unicode conversion of pre-Wildfire 4.0 drawings. 

This option does not affect the conversion of models. 

File - Uses the language stored in the drawing header 

file; Session - Uses the language of the current 

Pro/ENGINEER session. 

file, session, 

usascii, english, 

japanese, french, 

german, russian, 

italian, spanish, 

korean, 

chinese_tw, 

chinese_cn, 

hebrew, greek, 

turkish, czech, 

polish, hungarian, 

file

dxf_export_mapping_file DELETED Data Exchange Specifies the DXF export mapping file. Absolute or 

relative path to the file can be used. 

dxf_out_stroke_text DELETED Data Exchange Strokes == text is converted to lines and dots. "NONE"- 

Does not stroke out the text for export to DXF or DWG. 

"ALL" - Strokes out all the text. "SPECIAL" - Strokes out 

only special characters. 

none, special, all none

dxfio_in_sjis CHANGED Data Exchange Determines if the SJIS is supported when 

importing/exporting DXF files in Japanese 

yes, no yes

dynamic_edit_show_dims NEW Without 

category

Controls the display of dimensions during dynamic edit. yes, no yes

dynamic_edit_show_sketch_

dims

NEW Without 

category

Controls the display of sketch dimensions during 

dynamic edit. 

yes, no yes

ecad_comp_xsec_def_name CHANGED Without 

category Data 

Exchange

Will allow pre-setting default X-section to be used for 

component outline output to *.eda format. 
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ecad_mtg_hole_import NEW Data Exchange Setup the default for the import of ECAD Holes type 

MTG (IDF 3.0 or IDX ONLY) 

yes, no, as 

lightweight

yes

ecad_pin_hole_import CHANGED Data Exchange Setup the default for the import of ECAD Holes from 

type PIN (IDF 3.0 ONLY)Set up the default for the 

import of ECAD Holes from type PIN (IDF 3.0 or IDX 

ONLY) 

yes, no, as 

lightweight

no

ecad_tool_hole_import NEW Data Exchange Setup the default for the import of ECAD Holes type 

TOOL (IDF 3.0 or IDX ONLY) 

yes, no, as 

lightweight

yes

ecad_via_hole_import CHANGED Data Exchange Setup the default for the import of ECAD Holes from 

type VIA (IDF 3.0 ONLY)Set up the default for the 

import of ECAD Holes from type VIA (IDF 3.0 or IDX 

ONLY) 

yes, no, as 

lightweight

yes

efx_enabled NEW Data Exchange Loads EFX application. yes, no no

enable_3dmodelspace_brow

ser_tab

NEW Without 

category

Yes - Display 3D ModelSpace tab in the browser when 

Pro/ENGINEER starts.No - Display 3D ModelSpace tab 

only when you click a 3D ModelSpace link in the 

navigator. 

yes, no yes

explode_animation_max_tim

e

NEW Model Display Sets the maximum amount of time for an animation 

between explode states. 

1

extended_esr_capabilities NEW Assembly Extends external simplified representation capabilities. yes, no yes

fem_shell_elem_type NEW Mechanica Sets the default shell element type in FEM mode. tri, quad quad

file_open_default_view CHANGED Without 

category File 

Storage & 

Retrieval

Specify the initial Views setting as List or Details in the 

File dialog boxes. 

list, details  list

flange_shape_sketches_dire

ctory

NEW Sheetmetal Sets path to directory that contains the Flange shapes. 

flat_shape_sketches_directo

ry

NEW Sheetmetal Sets path to directory that contains the Flat shapes. 
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frt_enabled NEW Data Exchange Loads feature recognition application. yes, no no

geometry_analysis_color_sc

heme

NEW File Storage & 

Retrieval

Specifies the location of the geometry analysis color 

scheme file. 

graphics CHANGED System Sets the optional graphics environment used by certain 

platforms for running Pro/ENGINEER. Refer to the 

Installation Guide for a list of defaults and optional 

graphics. 

opengl, x_windows,

win32_gdi, d3d

opengl

help_center_path NEW User Interface URL of an active Pro/ENGINEER Help Center, if the 

Help Center is not installed at the default path (along 

with Pro/E product), of nature 

http://localhost:/index.jspx. Or, URL of the 

Pro/ENGINEER Help Center, that is deployed on a web 

server. 

hlr_for_xhatches CHANGED Electromechani

cal

Controls whether HLR to be enabled for crosshatches 

in drawing mode. 

no, yes yes

idd_repair_tangency NEW Without 

category

Sets the default state of the "Repair Tangency" 

checkbox in the Repair and Match tools 

yes, no no

interface_criteria_mismatch CHANGED Without 

category

FAIL_PLACEMENT - Fail regeneration upon 

component interface criteria 

mismatch.WARNING_ONLY - A warning message is 

given during regeneration for the criteria mismatch only 

without failure.IGNORE - Interface criteria mismatch 

ignored during regeneration.FAIL_PLACEMENT - Fail 

regeneration upon component interface criteria 

mismatch. WARNING_ONLY - A warning message is 

given during regeneration for the criteria mismatch only 

without failure. IGNORE - Interface criteria mismatch 

ignored during regeneration. 

warning_only, 

fail_placement, 

ignore

warning_only

intf2d_in_dxf_mapping_file NEW Data Exchange Specifies the mapping file for DXF and DWG import. 

Absolute or relative path to the file can be used. 

intf2d_in_iges_symbols NEW Data Exchange Controls whether to import IGES symbols as symbols or 

as entities by default. Yes - Import IGES symbols as 

symbols by default. No - Import IGES symbols as 

entities by default. 

yes, no yes

Parametric Technology Corporation 109 Pro/ENGINEER Wildfire 4.0 to 5.0 Configuration Options Changes



Name Status Category Description Values Default Value

intf2d_in_open_log_window NEW Data Exchange Yes - Opens Import Log File in a separate window. No - 

The Log File does not appear in the window. 

yes, no no

intf2d_out_acad_brk_tbl_w_

bl_ln

DELETED Data Exchange Yes - drawing tables having blanked lines are exported 

to DXF/DWG as separate entities, No - the tables are 

exported as DXF/DWG tables but the lines are not 

blanked. 

yes, no no

intf2d_out_acad_unicode NEW Data Exchange Yes - Non-ASCII characters are written in UNICODE 

encoding. 

yes, no no

intf2d_out_dxf_mapping_file NEW Data Exchange Specifies the mapping file for DXF and DWG export. 

Absolute or relative path to the file can be used. 

intf2d_out_stroke_text CHANGED Without 

category Data 

Exchange

make stroke text as default for PDF exportStrokes == 

text is converted to lines and dots. "NONE"- Does not 

stroke out the text for export. "ALL" - Strokes out all the 

text. "SPECIAL" - Strokes out only special characters. 

none, special, all none

intf3d_out_annotations NEW Data Exchange Export annotations with models. yes, no, default yes

intf3d_out_export_as_facets DELETED Data Exchange Export as faceted data for formats that support both 

facet and Brep representations. 

facets_only, 

brep_and_facets, 

default

default

intf3d_out_jt_auto_lods NEW Data Exchange Generate three default ProE LODs. no, yes no

intf3d_out_jt_brep NEW Data Exchange Export as faceted data for formats that support both 

facet and Brep representations. 

no, jt_brep, xt_brep no

intf3d_out_jt_config_name NEW Without 

category

Name of JT configuration file. 

intf3d_out_jt_config_path NEW Without 

category

Path to JT configuration file. 

intf3d_out_parameters CHANGED Without 

category Data 

Exchange

Exports parameters with models. all, none, 

designated

 all
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intf3d_out_prop_chord_heig

hts

CHANGED Data Exchange 

Without 

category

Use maximum chord heights proportional to component 

sizes. 

yes, no no

intf3d_out_prop_step_sizes CHANGED Data Exchange 

Without 

category

Use maximum step sizes proportional to component 

sizes. 

yes, no no

intf3d_out_use_step_size CHANGED Data Exchange 

Without 

category

Use maximum step size(s). yes, no no

intf_generate_log_file NEW Data Exchange Specifies not to generate or generate short or long log 

files for data exchange import operations. 

no, short, long short

intf_in_profile_default NEW Data Exchange Specifies the name of the existing import profile to use 

by default. 

intf_profile_dir NEW Data Exchange Specifies the directory where import and export profiles 

are stored. Use the full path to avoid problems. 

intf_ug_version CHANGED Data Exchange Sets the version of Unigraphics interface. nx3, nx4, nx5 nx4 

isogen_attribute_map_file CHANGED Piping Specifies the mapping between isogen parameter and 

attribute name. 

<proe_WF_5.0_lo

adpoint>/text/pipin

g_data/isodata/iso

gen_attribute_ma

p.ptd

isogen_endtype_map_file CHANGED Piping Specify name of file mapping Pro/Piping endtypes with 

ISOGEN endtypes 

<proe_WF_5.0_lo

adpoint>/text/pipin

g_data/isodata/iso

gen_endtype_ma

p.ptd

isogen_nominal_size_map_fi

le

CHANGED Piping Specify name of file mapping Pro/Piping Size with 

Nominal Sizes in MM and Inches 

<proe_WF_5.0_lo

adpoint>/text/pipin

g_data/isodata/iso

gen_nominal_size

_map.ptd
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isogen_symbol_map_file CHANGED Piping Specify name of file for mapping Pro/Piping selection 

names with ISOGEN symbol keys (SKEY)s 

<proe_WF_5.0_lo

adpoint>/text/pipin

g_data/isodata/iso

gen_symbol_map

.ptd

keep_model_in_open_windo

w

NEW Without 

category

Controls whether a model is displayed in its window 

whenthe accessory window is open. 

no, yes no

keep_style_items_hidden_o

n_exit

CHANGED Features 

Without 

category

Keep style entities hidden after exiting of the Style 

feature definition. 

yes, no no

last_session_directory_path NEW Without 

category

Sets the directory that holds the temp files for the 

session recording mechanism. 

/work_dir/.wf/.setti

ngs

last_session_retrieval NEW Without 

category

Yes - Activates recording mechanism that enables the 

session to be retrieved during the next session. No - 

The recording mechanism is not available and the 

session can not be retrieved. 

yes, no yes

make_aux_view_notes CHANGED Drawing Automatically adds view names to auxiliary views using 

AUX VIEW* viewname-viewname. You can modify the 

view name after adding the view to the drawing. 

yes, no no

manikin_flexibility CHANGED Without 

category

Sets the level of flexibility that is allowed when dragging 

a manikin. FULL - All Manikin segments are 

articulated.NONE - Manikin is calculated as a single 

body. DEFAULT - Manikin finger segments are locked 

to a single body. 

full, none, default default

mdo_density DELETED Mechanism Mass density for dynamics. 0

mdx_belt_icon_width NEW Mechanism Width of belt transmission icons. 5

menu_manager_position NEW User Interface Controls the position of the Menu Manager.outside - 

Top left corner of Menu Manager is aligned to top right 

corner of window, inside - Top right corner of Menu 

Manager is aligned to top right corner of graphics 

area,adaptive - Menu Manager is positioned outside if 

there is enough room, otherwise it is positioned inside. 

outside, inside, 

adaptive

adaptive

merge_type NEW Features Sets the default merge type surface merge operations. join, intersect intersect

modeltree_show_gen_of_ins

tance

NEW User Interface Determines whether the generic name is displayed as 

an extension of the instance name in the model tree 

and other model name lists. 

yes, no yes
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move_mechanism_in_nonge

om_reps

NEW Mechanism Allow mechanism operations in non geometrical 

representations. 

no, yes yes

multipoint_location_count DELETED Electromechani

cal

Specifies the maximum number of cable locations to 

allow in one feature. To create locations as features, set 

to 1.To limit the number of locations in one feature, set 

to a number between 2 and 100. 

1

nc_autodoc_param_dir NEW Manufacturing Location of the setup file that describes which process 

parameters are included in the parameter table. 

nc_autodoc_report_dir NEW Manufacturing Location for storing the report and images generated by 

the shop floor documentation tool. 

nc_autodoc_setup_dir NEW Manufacturing Location for documentation setup files that describe 

which process parameters are included in the 

parameter table. 

nc_autodoc_template_dir NEW Manufacturing Location of the style sheet and default images used for 

shop floor documentation. 

ncmdl_bar_stock_part_path CHANGED Manufacturing Sets path for storage and retrieval of stock instances for 

creating workpiece in NC Model. Specify full path, 

including part name, to avoid problems. 

<proe_WF_5.0_lo

adpoint>/text/ncm

dl_data/ncmdl_ba

r.prt

ncmdl_billet_stock_part_pat

h

CHANGED Manufacturing Sets path for storage and retrieval of stock instances for 

creating workpiece in NC Model. Specify full path, 

including part name, to avoid problems. 

<proe_WF_5.0_lo

adpoint>/text/ncm

dl_data/ncmdl_bill

et.prt

new_wf5_simp_rep_ui NEW Without 

category

Yes - Use Component Chooser base Simp Rep UI, No - 

Use old Simp Rep definition UI. 

yes, no yes

pdm_server_quickview_rows

_num

NEW Without 

category

Sets the default number of rows for the pdm quick view 

list. 

7

pipeline_assembly_library_di

r

CHANGED Piping Sets the default pipeline assembly library directory. <proe_WF_5.0_lo

adpoint>/text/pipin

g_data/pipelinelib/

piping_appearance_map_file CHANGED Piping Sets the default piping appearance map filename. <proe_WF_5.0_lo

adpoint>/text/pipin

g_data/master_ca

talog/piping_appe

arance.map
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piping_bolt_nut_select_file CHANGED Piping Piping bolts and nuts selection file. <proe_WF_5.0_lo

adpoint>/text/pipin

g_data/master_ca

talog/piping_bolt_

nut_select.ptd

piping_end_compatibility_file CHANGED Piping Sets the default piping end compatibility filename. <proe_WF_5.0_lo

adpoint>/text/pipin

g_data/master_ca

talog/piping_end_

compatibility.ptd

piping_extend_dim_scheme CHANGED Piping Specify a dimension scheme for piping extend 

segment. 

cartesian, 

cylindrical, 

cartesian

piping_extend_show_csys NEW Piping Control whether small preview CSYS is shown at end of 

pipe when defining extend features in cartesian / 

spherical / cylindrical schemes. 

yes, no no

piping_fitt_category_map_fil

e

CHANGED Piping Sets the default piping fitting category map filename. <proe_WF_5.0_lo

adpoint>/text/pipin

g_data/sample_pr

oject/piping_fitt_c

ategory_map.ptd

piping_fitt_library_dir CHANGED Piping Sets the default piping fitting library directory. <proe_WF_5.0_lo

adpoint>/text/pipin

g_data/fittinglib/

piping_insulation_dir_file CHANGED Piping Sets the default piping insulation directory filename. <proe_WF_5.0_lo

adpoint>/text/pipin

g_data/sample_pr

oject/piping_insul

ation_dir.ptd

piping_manufacture_dir_file CHANGED Piping Sets the default piping manufacture directory filename. <proe_WF_5.0_lo

adpoint>/text/pipin

g_data/master_ca

talog/piping_man

ufacture_dir.ptd

piping_material_file CHANGED Piping Sets the default piping material filename. <proe_WF_5.0_lo

adpoint>/text/pipin

g_data/master_ca

talog/piping_mate

rial.ptd
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piping_mcat_dir CHANGED Piping Sets the default piping master catalog directory. <proe_WF_4.0_lo

adpoint>/text/pipin

g_data/master_ca

talog/<proe_WF_

5.0_loadpoint>/te

xt/piping_data/ma

ster_catalog/

piping_mcat_dir_file CHANGED Piping Sets the default piping master catalog directory 

filename. 

<proe_WF_5.0_lo

adpoint>/text/pipin

g_data/master_ca

talog/piping_mcat

_dir.ptd

piping_project_data_dir CHANGED Piping Sets the default Project data directory. /<proe_WF_5.0_l

oadpoint>/text/pipi

ng_data/sample_

project/

piping_spec_dir_file CHANGED Piping Sets the default piping specification directory filename. <proe_WF_5.0_lo

adpoint>/text/pipin

g_data/sample_pr

oject/piping_spec

_dir.ptd

preferred_publish_deliverabl

e

NEW Drawing Set the default preferred deliverable for the Publish 

Context in Drawings. 

print, iges, set, dxf, 

step, cgm, pdf, 

dwg, tiff, medusa, 

print

pro_font_dir CHANGED File Storage & 

Retrieval

Sets the default font directory (Pro/ENGINEER will load 

all fonts in this directory into the drawing regardless of 

the contents of the system and working directories). 

<proe_WF_5.0_lo

adpoint>/text/font

s/

pro_gplug_dir CHANGED Data Exchange Specifies the directory in which Granite application plug-

ins are located. Use the full pathname to avoid 

problems. 

<proe_WF_5.0_lo

adpoint>/sun_sola

ris_x64/gplugs/

pro_lwa_library_path DELETED Without 

category

Allows the user to specify the path to LWA library. <proe_WF_4.0_lo

adpoint>/graphic-

library/smdata/arc

hives/

pro_lwa_license_path DELETED Photorender Allows the user to specify the path to LWA license file. 

pro_mf_tape_dir NEW Manufacturing Sets the default directory for the manufacturing TAPE 

data files.Use the full pathname to avoid problems. 
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pro_palette_dir CHANGED Drawing Sets the default directory for drawing symbol palette 

files. 

<proe_WF_5.0_lo

adpoint>/symbols/

palette/

pro_surface_finish_dir CHANGED File Storage & 

Retrieval

Sets the default directory for your user-defined surface 

finish symbols. Use the full pathname to avoid 

problems. 

<proe_WF_5.0_lo

adpoint>/symbols/

surffins/

ptc_manikin_library_path CHANGED Without 

category

Sets the default directory for the Pro/ENGINEER 

manikin library (or custom manikin libraries you built 

containing the proper index menu files). Use the full 

path name to avoid problems. 

<proe_WF_5.0_lo

adpoint>/manikin

_lite/

punch_models_directory NEW Sheetmetal Sets path to directory that contains the punch models. 

read_parameters_of_exclud

ed

CHANGED Data 

Management

Allow Pro/ENGINEER designated parameters on 

excluded objects in Simplified Representation to be 

visible in Model Tree columns. 

yes, no no

real_time_rendering_display NEW Model Display Disable realtime rendering. disable, 

transparent_floor, 

room_display

disable

regen_failure_handling NEW Without 

category

Specifies whether to enter resolve mode when 

regeneration failures occur.Resolve_mode - Enter 

resolve mode when regeneration failures occur. 

No_resolve_mode - Don't enter resolve mode when 

regeneration failures occur. 

resolve_mode, 

no_resolve_mode

no_resolve_mode

regen_simp_retrieve CHANGED File Storage & 

Retrieval

Regenerate the assembly when retrieving an assembly 

simplified representation. Yes - Regenerates the 

assembly on retreival.No - The assembly is not 

regenerated on retrieval. 

yes, no yes no

regen_solid_before_save DELETED Without 

category

Yes - means to regenerate top Window object before 

Save. 

yes, no no

replace_history_rule_order CHANGED Assembly Set the default order of the history evaluation rule in the 

replace operation. Disable - the evaluation rule will be 

disabled by default. Number - set the order of the rule 

relative to other evaluation rules. 

disable, 1, 2, 3, 4, 5 3

replace_interface_rule_order CHANGED Assembly Set the default order of the interface evaluation rule in 

the replace operation. Disable - the evaluation rule will 

be disabled by default. Number - set the order of the 

rule relative to other evaluation rules. 

disable, 1, 2, 3, 4, 5 1
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replace_sameid_rule_order CHANGED Assembly Set the default order of the same id evaluation rule in 

the replace operation. Disable - the evaluation rule will 

be disabled by default. Number - set the order of the 

rule relative to other evaluation rules. 

disable, 1, 2, 3, 4, 5 5

replace_samename_rule_or

der

CHANGED Assembly Set the default order of the same name evaluation rule 

in the replace operation. Disable - the evaluation rule 

will be disabled by default. Number - set the order of the 

rule relative to other evaluation rules. 

disable, 1, 2, 3, 4, 5 2

replace_sameparam_rule_or

der

CHANGED Assembly Set the default order of the same parameters evaluation 

rule in the replace operation. Disable - the evaluation 

rule will be disabled by default. Number - set the order 

of the rule relative to other evaluation rules. 

disable, 1, 2, 3, 4, 5 4

replace_unrelated_automatic CHANGED Assembly Availability of automatic reference pairing in unrelated 

replace. No - Automatic reference pairing is not 

available. Yes - Automatic reference pairing is available. 

yes, no no

reserved_menu_space CHANGED User Interface Reserves space for extra menus to the right of the 

Pro/ENGINEER window (1.0-4.0). This option overrides 

windows_scale.Reserves space for extra menus to the 

right of the Pro/ENGINEER window (0.0-4.0). This 

option overrides windows_scale. 

1

round_displayed_dim_values NEW Dimensions & 

Tolerances

No - newly created or first shown dimension is 

displayed with all its significant decimals."Rounded 

Dimension Value" Check Box will be unchecked while 

opening Dimension Properties Dialog. Yes - number of 

decimals is rounded according to default dec places 

option."Rounded Dimension Value" Check Box will be 

checked while openingDimension Properties 

Dialog.			) 

yes, no yes

save_drawing_picture_file CHANGED Drawing Embed - Embeds a picture file inside a drawing for 

preview purposes. Export - Saves a drawing file as a 

picture file in the working directory when saving a 

drawing. Both - Does both embed and export. 

no, export, embed, 

both

embed

saving_model_thumbnails NEW File Storage & 

Retrieval

Enables saving of model thumbnails. yes, no yes
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shade_quality NEW Model Display Model shade quality is used to decide how much to 

subdivide surfaces forshading purposes. Higher shade 

quality is slower but produces better pictures. 

3, 1, 2, 4, 5, 6, 7, 8, 

9, 10

3

show_annotations_dialog_li

mit

NEW Drawing Default value for Annotations dialog box. 

show_description_view_mgr NEW Without 

category

Yes - show a column for Description field for all tabs in 

view manager. 

yes, no no

sim_auto_map_max_dist CHANGED Mechanica Sets the default maximum distance tolerance for auto-

mapping of pressure load.Sets the default maximum 

distance tolerance (relative to model size) for auto-

mapping of pressure load. The default value is 0.0012. 

0.0012

sim_auto_pairing_thickness NEW Mechanica Set the value of characteristic thickness for auto-

detection of shell pairs. Using this as a threshold value, 

auto-detection will find surface pairs with thickness 

smaller than this value. 

0

sim_check_jacobian_corner

s

NEW Mechanica No - Suppress Jacobian checks at corner nodes. 

ANSYS and Nastran checks parabolic elements 

Jacobian at the integration points only and FEM will fix 

too curved elements for the same criterion. Yes - 

Jacobian is checked both at integration points and 

corner nodes. FEM mode will fix too curved elements 

accordingly. 

yes, no no

sim_display_current_csys_tri

ad

NEW Without 

category

Toggles display of the current coordinate system triad in 

the lower right corner of the window. 

yes, no

sim_display_highlight_refs NEW Mechanica Yes -Geometrical references are highlighed when 

selecting a load/constraint. 

yes, no

sim_display_load_name NEW Mechanica Yes - The load/constraint name appears in the label. yes, no

sim_display_mesh_control_n

ame

NEW Mechanica Yes - The Mesh/AutoGEM control name appears in the 

label. 

yes, no

sim_display_mesh_control_v

alue

NEW Mechanica Yes - The Mesh/AutoGEM control value appears in the 

label. 

yes, no

sim_display_shell_pairs NEW Without 

category

Toggles the display of shell pairs. no, yes

sim_display_z_buffered NEW Without 

category

Toggles z-buffered display of Mechanica icons. yes, no

sim_ext_distribution_dir NEW Without 

category

Specifies the location of external distribution files for 

loads. 
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sim_extend_surf_max_angle NEW Mechanica Controls the maximum angle between a surface to be 

extended during shell compression and its adjacent 

surfaces. If the angle is higher than specified, the 

adjacent surfaces is extended. The default is 30 

degrees. The range is from 0 to 90 degrees. 

30

sim_icon_distribution_densit

y

NEW Mechanica Determines how many icons are drawn for a 

distribution. 1 is fewer, 10 is the highest. 

-1

sim_ignore_unpaired NEW Mechanica Yes - Unpaired surfaces are ignored when meshing the 

model, placing you directly into the AFTER COMP 

menu (the CONT MESH menu is skipped). 

yes, no no

sim_pp_display_beam_thick

ness

NEW Mechanica Sets the thickness for beams and 2D-shells display in 

Post Processor. Numerical values specify the thickness 

in pixels. 

actual, 1, 2, 3, 4, 5 5

sim_pp_path_absolute CHANGED Mechanica Choose Absolute (Yes) or Relative (No) path to "rwd" 

file. 

yes, no no

sim_pp_show_cap_cut_outli

ne

NEW Mechanica Enables to hide the model outline in capping/cutting 

surface display. 

yes, no yes

sim_remove_unopposed NEW Mechanica Yes - The system ignores unopposed surfaces when 

meshing the model; the system also deselects the 

UseUnopposed option. No - the system uses the 

unopposed surfaces in the shell model. 

yes, no no

sim_run_copy_fem_neutral_

file

DELETED Mechanica Controls whether the FEM neutral file (with extension 

.fnf) is copied into the study directory. The default value 

is YES. 

yes, no yes

simprep_default_model_stat

us

NEW Assembly Determines the default model status while defining a 

new simplified rep. 

exclude, master, 

graphics, geometry

exclude

simulation_product CHANGED Mechanica Set Mechanica product being selected 

(Structure/Thermal). Prompt (default) -Brings 

Mechanica Model Type Dialog. This option is used only 

if the information about Mechanica product is not yet 

stored with model. 

structure, thermal, 

prompt 

prompt

sketcher_dec_places DELETED Sketcher Sets the default number of decimal places displayed for 

dimensions in Sketcher. The extrusion depth or any 

other dimension you enter to create 3D geometry is 

controlled by the default_dec_places option. 

2

sketcher_dim_of_revolve_ax

is

CHANGED Sketcher If this option is set all dimensions created by Intent 

Manager to Axis of Revolution will be diameter 

dimensions. 

no, yes yes
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sketcher_intent_manager DELETED Sketcher Specifies which sketcher to use. Yes - Intent Manager 

is the default. No - Old sketcher is the default. 

yes, no yes

sketcher_strngthn_to_def_d

ec_pl

NEW Without 

category

This option enable the user to keep a highly precise 

value during creation or convertion strong dimension. 

yes, no yes

smaller_bundle_min_bend_r

ad

DELETED Without 

category

Setup whether to consider the thickness of the bundle 

when set up the minimum bend radius. 

yes, no no

snap_single_constraints NEW Without 

category

When dynamically dragging components during 

component placement, allow to snap to references one 

constraint at a time. 

yes, no yes

startup_check_for_visualizati

on

NEW Environment Determines whether or not the visualization 

components are checked for installation upon startup. 

yes, no yes

step_export_format CHANGED Data Exchange Specifies output format when exporting to STEP. 

AP203_IS - Formats output to ISO 10303 AP203IS 

format. AP214_CD - Formats output with geometry that 

meets the specification for the long-term schema for 

AP214cc1. 

ap203_is, 

ap214_cd, 

ap202_is, 

203_is_ext, 

ap214_dis, 

ap203_is

style_auto_regen_curves NEW Without 

category

Yes - Enable autoregeneration of curves. yes, no yes

style_auto_regen_shaded_s

urface

NEW Without 

category

Yes - Enable autoregeneration of shaded surfaces. yes, no yes

style_auto_regen_surface NEW Without 

category

Yes - Enable autoregeneration of surfaces. yes, no yes

style_connection_arrow_scal

e

NEW Without 

category

Set scale factor of surface connection arrow. Number 

should be greater then 0. 

1

style_display_grid NEW Without 

category

Yes - Display grid for active datum plane. yes, no yes

style_grid_spacing NEW Without 

category

Set the number of lines to display on the grid. Number 

should be equal or greater than 2. 

5

style_surface_mesh_display NEW Without 

category

On - Display surfaces mesh. Off - Do not display 

surfaces mesh. Off When Shaded - Display surfaces 

mesh except when shaded. 

off, on, off when 

shaded

off

style_surface_mesh_quality NEW Without 

category

Sets the quality of the surface mesh. Values range is 

between 0.1 to 10. 

1

summary_help CHANGED User Interface Refers to the one-line help Messages that are either 

displayed or not displayed. 

yes, no no

suppress_appearance_mess

age

NEW Colors Suppress the lightworks appearance conversion 

notification dialog. 

yes, no no
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template_mfgcast CHANGED File Storage & 

Retrieval

Specify the model used as the default manufacturing 

cast template. 

inlbs_mfg_cast.as

m

template_mfgcmm CHANGED File Storage & 

Retrieval

Specify the model used as the default manufacturing 

cmm template. 

inlbs_mfg_cmm.a

sm

template_mfgemo CHANGED File Storage & 

Retrieval

Specify the model used as the default manufacturing 

expert machinist template. 

inlbs_mfg_emo.a

sm

template_mfgmold CHANGED File Storage & 

Retrieval

Specify the model used as the default manufacturing 

mold template. 

inlbs_mfg_mold.a

sm

template_mfgnc CHANGED File Storage & 

Retrieval

Specify the model used as the default manufacturing 

assembly template. 

inlbs_mfg_nc.asm

tol_num_digits_default_drive

n

CHANGED Drawing Yes - The Default check boxes in the number of digits 

area of the Dimension Properties dialog will be checked 

when a dimension is created or first shown. No - The 

check boxes will be unchecked when a dimension is 

created or first shown. 

yes, no yes

ttf_handling_for_plot_files NEW Printing & 

Plotting

Defines how annotations using True Type Fonts are 

written to the plot file. Using True Type Fonts reduces 

the plot file size, but font substitution may occur due to 

device settings. Annotations that do not use True Type 

Fonts are unaffected by this option. 

stroke all fonts, use 

true type fonts

use

ui_theme CHANGED Without 

category

Setup Pro/E Theme.Standard will result in the Wildfire 

Theme on UNIX and "following the Windows theme on 

Windows XP & Win2K. Wildfire - Will always use the 

Wildfire Theme regardless of the OS settings. 

wildfire_5, wildfire, 

standard

wildfire_5
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units_system_dic_file CHANGED Piping Specifies the file containing the mapping for MCAT 

filename and units. 

<proe_WF_5.0_lo

adpoint>/text/pipin

g_data/master_ca

talog/piping_units

_system_dic_file.

ptd

update_copy_geom_location NEW Assembly Yes-Copy Geometry will try to update location of copied 

geometry based on changes to component placements 

even if some components are excluded or in graphics 

rep. 

yes, no yes

use_cadam_plot_data DELETED Data Exchange Determines whether the information in the Plot Axis 

System element should be taken into account when 

importing a CADAM drawing. 

yes, no no

use_outdated_accel_in_geo

m_rep

DELETED File Storage & 

Retrieval

This option controls the usage of outdated accelerator 

files during retrieval of instances in geometry 

representation. Yes - Provides the fastest retrieval. No - 

Ensures accurate Retrieval. 

no, yes no

web_browser_homepage CHANGED System Enter location of Pro/E browser home page. <proe_WF_5.0_lo

adpoint>/html/chin

ese_tw/proe/helps

ystop/resource_c

enter_index.htm

web_enable_subscription CHANGED Application 

Programming 

Interfaces

Enable the subscription mechanism for Connections no, yes yes

weld_fillet_preferences_file NEW Without 

category

Sets the path and name of the fillet weld preferences 

file. 

weld_general_preferences_fi

le

NEW Without 

category

Sets the path and name of the general weld 

preferences file. 

weld_geom_type_default CHANGED Weld Sets the default weld geometry type. surface, light surface

weld_groove_preferences_fil

e

NEW Without 

category

Sets the path and name of the groove weld preferences 

file. 

weld_plug_slot_preferences

_file

NEW Without 

category

Sets the path and name of the plug/slot weld 

preferences file. 

weld_spot_preferences_file NEW Without 

category

Sets the path and name of the spot weld preferences 

file. 
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windows_browser_type NEW System Select the type of embedded browser to use. ie_in_process, 

ie_in_sep_process, 

mozilla_based_bro

wser

workpiece_instances CHANGED Without 

category

Cut out are created in Workpiece but not the family 

table instances.Instances are created in Workpiece for 

each steps. 

steps, 

operations_and_st

eps, none, 

none
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